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PREFACE
Every effort has been made to ensure that the information in this document is complete, accurate, and 
up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its control. The 
manufacturer also cannot guarantee that changes in software and equipment made by other 
manufacturers and referred to in this manual will not affect the applicability of the information in it. 
Mention of software products manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as possible, 
we make no warranty of any kind, expressed or implied, as to the accuracy or completeness of the 
information contained herein.

The most up-to-date drivers and manuals are available from:

http://www.Okiprintingsolutions.com

All rights are reserved by Oki Data Corporation. You must not carry out unauthorized copying, 
transferring, translating, or related actions. You must obtain written permission from Oki Data 
Corporation before doing any of the above.
© 2010 Oki Data Corporation

OKI is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft 
Corporation.

Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

As an Energy Star Program Participant, the manufacturer has determined that this product 
meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/108/EC (EMC) and 
2006/95/EC (LVD) and 1999/5/ EC (R&TTE), as amended where applicable on the 
approximation of the laws of the member states relating to electromagnetic compatibility, low 
voltage and radio & telecommunications terminal equipment.


The following cables were used to evaluate this product to achieve EMC directive 
2004/108/EC compliance and configurations other than this may affect that compliance.

CABLE TYPE LENGTH 
(METRE)

CORE SHIELD

Power 1.8 ✘ ✘

USB 5.0 ✘ ✔

LAN 15.0 ✘ ✘
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EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO NOT 
attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes 
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of staining 
skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION

http://www.okiprintingsolutions.com
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 For Your Safety
Read the User's Manual (this manual) for your safety before using the product.

Cautions related to safety

General cautions

Indicates additional information which, if ignored or failed to follow the guidelines, may result in 
personal fatal injury or death.

Indicates additional information which, if ignored, may result in personal injury.

WARNING
Do not touch the safety 
switch inside the machine. 
Doing so may cause electric 
shock when high voltage 
occurs. In addition, the gear 
can rotate, which may result 
in personal injury.

Do not use an inflammable 
spray near the machine. 
Doing so may cause fire since 
there is an area heating up 
within the machine.

Pull the power plug out of the 
socket and contact with a 
customer's service centre 
when the cover is unusually 
hot, smoking, giving off 
questionable odour, or 
making a strange noise. 
Doing so may cause fire.

Pull the power plug out of the 
socket and contact with a 
customer's service centre 
when a liquid such as water 
enters in the internal parts of 
the machine. 
Doing so may cause fire.

Pull the power plug out of the 
socket and remove foreign 
materials such as clips when 
they fall inside the machine. 
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not operate and/or 
disassemble the machine 
other than that directed in 
User's Manual. 
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Unplug the power cord and 
contact with a customer's 
service center if the machine 
is dropped or the cover is 
damaged.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Unplug the power cord 
periodically to clean plug 
blades and root section 
between the blades.
If the power plug remains 
inserted for a long time, the 
root section will get dusty, 
and the plug may be shorted 
out, which may cause fire.

Do not clean spilled toner 
with a vacuum cleaner.
If cleaning spilled toner with a 
vacuum cleaner, it may catch 
fire due to the sparks from 
electric contact.
Toner spilled on the floor 
should be wiped off with wet 
cloth.

Do not insert materials in a 
vent hole.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not put a cup with liquids 
such as water on the 
machine.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not touch the fuser and 
other parts when opening the 
cover of the machine.
Doing so may cause burns.

Do not throw toner cartridges 
and image drum cartridges 
into fire. Doing so may cause 
dust explosion leading to 
burns.

Do not use a power code, a 
cable, or a ground wire other 
than those that are indicated 
in User's Manual.
Doing so may cause fire.

The operation of using UPS 
(uninterruptible power 
source) or inverters is not 
guaranteed. Do not use 
uninterruptible power source 
or inverters.
Doing so may cause fire.

CAUTION
Do not come closer to the paper's exit area when 
the power is turned on, and while in printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush 
with large amount of water. Follow the direction 
from a doctor if necessary.

WARNING

CAUTION
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Manual Composition
The following manual is attached to this product.

 User's Manual Basic ---- This document 
In order to understand this machine, the basic operation is described. The initial setup description, 
handling method for trouble and maintenance procedures are also described.

About This Manual

Terms in this document
The following terms are used in this manual:

Note

 Indicates important information on operations. Make sure to read them.

Memo

 Indicates important information on operations. Make sure to read them.

Reference

 Indicates where to look when you want to know more detailed or related information.

Symbols in this document
The following symbols are used in this manual:

WARNING
 Indicates additional information which, if ignored or failed to follow the guidelines, may result in personal fatal 

injury or death.

CAUTION
 Indicates additional information which, if ignored, may result in personal injury.

Symbols Description

[  ]  Indicates menu names on the display screen.
 Indicates menu, window, dialog names on the computer.

"  "  Indicates messages and enter text on the display screen.
 Indicates file names on the computer.
 Indicates reference titles.

<  > key Indicates a hardware key on the operator panel or a key on 
the keyboard of the computer.

> Indicates how to get to the menu you want on the menu of 
the machine or the computer.
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Legends used in this manual
In this document, it may have written as follows.

 PostScript3 Emulation PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION

 Microsoft® Windows® 7 64-bit Edition operating system Windows 7 (64bit version) ٛ※

 Microsoft® Windows Vista® 64-bit Edition operating system Windows Vista (64bit version) ※

 Microsoft® Windows Server® 2008 R2 64-bit Edition operating system Windows Server 2008 ※

 Microsoft® Windows Server® 2008 64-bit Edition operating system Windows Server 2008(64bit version) ※

 Microsoft® Windows® XP x64 Edition operating system  Windows XP (x64 version) ※

 Microsoft® Windows Server® 2003 x64 Edition operating system Windows Server 2003 (x64 version) ※

 Microsoft® Windows® 7 operating system Windows 7 ※

 Microsoft® Windows Vista® operating system Windows Vista ※

 Microsoft® Windows Server® 2008 operating system Windows Server 2008 ※

 Microsoft® Windows® XP operating system Windows XP ※

 Microsoft® Windows Server® 2003 operating system Windows Server 2003 ※

 Microsoft® Windows® 2000 operating system Windows 2000

 Generic name for Windows 7, Windows Vista, Windows Server 2008, Windows XP, Windows Server 2003, and 
Windows 2000 Windows

※ If there is no special description, 64bit version is included in Windows 7, Windows Vista, Windows 
Server 2008, Windows XP, and Windows Server 2003. (64bit version and Windows Server 2008 R2 is 
included in Windows Server 2008.)

If there is no special description, Windows 7 is used as Windows, Mac OS X 10.6 is used as Mac OS X, 
and MC561dn is used as the machine for examples in this document.

Depending on your OS or model, the description on this document may be different.
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1. Setup
In this chapter, the basic operations of this machine and the setup are described before using each 
function.

Overview of Machine
This section describes the overview of the machine.

Contents of the Package
Check that you have everything shown below.

Reference

 For details on how to open the package, refer to 
"Unpacking Your Machine" P. 16.

 Machine

 Image drum unit

 Starter toner cartridge

Four cartridges are supplied with your machine, 
one each for cyan, magenta, yellow, and black.

Note

 The starter toner cartridges are installed in the image 
drum unit which is installed in the machine before 
shipment.

 Software CD-ROM

 Application CD-ROM

 AC cord

 Telephone connector cover 
The Telephone Connector Cover is installed to the 
Telephone Connector of the main unit.

Note

 An Ethernet cable, USB cable and Telephone cable are not 
supplied with your machine. Procure them separately.

 Packaging and cushioning material is required at the time 
of shipping the machine. Do not throw it away, and please 
keep it.

CAUTION It may cause injury!

At least two people are needed to lift the machine 
safely because it weighs about 29 Kg.



Overview of Machine

- 13 -

S
etu

p

1
Available Options

The following options are available for your 
machine:

 Second tray unit (tray 2)

 Additional RAM (256 MB or 512 MB)

 16 GB SD memory card (MC561 only)

Memo

 There is a 4 GB SD memory card inside the MC561dn. If 
you expand the memory capacity, please replace with an 
optional 16 GB SD memory card.

Reference

 For details on how to install the options, refer to "Installing 
Options" P. 21.

 An SD memory card is used as a storage for spooling when 
copying sectors, saving secure print/encrypted print data, 
as a storage destination for form data, and for saving auto 
delivery and transmission data. For information on secure 
print, encrypted secure print, form data, and auto 
delivery/transmission data storage functions, please refer 
to User's Manual Advanced.

Installation Requirements

Installation Environment

Your machine must be installed in the following 
environment:

Note

 Be careful of condensation. It may cause a malfunction.

 If installing your machine where the humidity of the 
surrounding air is less than 30% RH, use a humidifier or 
antistatic mat.

Temperature: 10°C~32°C

Humidity: 20%~80% RH(relative 
humidity)

Maximum wet 
bulb temperature:


25°C

 Do not install near high temperature or the fire.
 Please do not install in a place from which a 

chemical reaction is started (laboratory etc.).
 Do not install near the inflammable solution, such 

as alcohol and thinner.
 Do not install in the place which the small child's 

hand reaches.
 Do not install in an unstable place (the shaky 

stand, leaning place, etc.).
 Do not install in a place many humidity, dusty and 

the place where direct rays hit.
 Do not install in the environment of briny air and 

corrosive gas.
 Do not install in a place with much vibration.
 Do not install in a place where the ventilation hole 

of the machine is closed.

 Do not place directly on a rug or carpet with long 
strands.

 Do not install in a closed room with poor 
ventilation and circulation.

 If you use the machine in a small room for a long 
time, please make sure that you ventilate the 
room.

 Install away from strong magnetic fields and 
sources of noise.

 Install away from monitors or TVs.

 When moving the machine, hold it on both sides, 
and move it by slightly letting the back of it fall.

WARNING

CAUTION
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Installation Space

Install your machine on a flat surface that is wide 
enough to locate the machine.

Allow for enough room around your machine 
according to the images below.

 Top view

 Side view

 Side view (tray 2 installed)

Names of Components

20 cm

60 cm

20 cm

100 cm

60 cm

60 cm

No. Name

1 Top cover

2 Multipurpose (MP) tray

3 Tray 1

4 Top cover open button

5 Air vents

6 Scanner unit

7 Auto document feeder (ADF) cover

8 Document tray

9 Document glass cover

10 Operator panel

11 USB port

No. Name

12 Document glass

1

2

3

4

5

6

7

11

10

9
8

12
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 Internal part of the connector cover

No. Name

13 Fuser unit

14 Toner cartridge (Y: yellow)

15 Toner cartridge (M: magenta)

16 Toner cartridge (C: cyan)

17 Toner cartridge (K: black)

18 Image drum unit

19 LED head (four heads)

No. Name

20 Faceup stacker

21 AC power socket

22 Air vents

23 Connector cover

24 Power switch

25 LINE connection

26 TEL connection

19

13

14

15

16

17
18

24

23

22
21

20

25 26

No. Name

27 Bracket

28 Expansion memory slot

29 USB interface connection

30 SD memory card slot (for MC561dn only)

31 Network interface connection

27
30

29
28

31
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 Installing Your Machine
This section explains how to unpack your machine and how to turn it on and off.

Unpacking Your Machine

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 
1500lux). Even under the normal interior light, do not 
leave it for more than 5 minutes.

 Packaging and cushioning material is required at the time 
of shipping the machine. Do not throw it away, and please 
keep it.

1 Remove your machine from the box and 
remove cushioning materials and a 
plastic bag from your machine.
The accessories are packed within the cushioning 
material (1).

2 Lift your machine and place it where it is 
to be installed.

3 Remove the protection tapes (2) at the 
tome and sides of your machine to take 
out cushioning materials (3).

4 Remove the protection tapes (4) to open 
the MP tray.

5 Remove the protection tape (5) to pull 
the paper up.

6 Close the MP tray.

It may cause injury!

At least two people are needed to lift the machine 
safely because it weighs about 29 Kg.

CAUTION

1

2

2

3

4

5
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7 Open the document glass cover.

8 Remove the protection tapes (6).

9 Close the document glass cover.

10  Open the scanner unit.

11 Remove the protection tapes (7), and 
remove desiccants and films.

12 Press the top cover open button (8) and 
open the top cover.

13  Remove the protective sheets (9).

14 Remove the orange stopper (11) while 
pressing the blue lever of the fuser unit 
(10) in the direction of the arrow.

Note

 Keep the orange stopper, it is necessary to transport 
the machine.

6

7

8

9

10

11
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15 While pushing the right side of the toner 
cartridge, quickly slide the blue lock (12) 
to the left side to lock it.
Slide the locks on all 4 toner cartridges.

16 Close the top cover.

17 Close the scanner unit.
Reference

 Please refer to "Loading Paper" P. 66 for information on 
how to load paper into the machine.

Turning On and Off Your Machine

Power Supply Conditions

The power supply must meet the following 
conditions:

Note

 If the power supply is unstable, use a voltage regulator.

 The maximum power consumption of this machine is 
1170W. Ensure that the power supply is sufficient to 
operate this machine.

 We do not guarantee the operation where an uninterruptible 
power system (UPS) or inverter is used. Do not use an 
uninterruptible power system (UPS) or inverter.

Current: 220VAC - 240VAC 

Frequency: 50/60 Hz ± 2%

12

There is a risk of getting 
an electric shock and/or 

causing fire.

After attachment of a power cord and an earth 
wire and removal turn OFF a power supply switch, 
be sure to perform them.

Be sure to connect an earth wire to the grounding 
terminal of exclusive use. If you can not find the 
earth wire, contact the distributor where you have 
purchased.

 Please do not connect with the ground of a water 
pipe, a gas pipe, and a telephone wire, and a light-
ning rod by any means.

Make sure to connect with the ground terminal 
before connecting the power cord to the power 
supply plug. Additionally, if the earth wire is 
detached, please make sure that you remove the 
power cord from the electrical socket.

Be sure to perform extraction and insertion of a 
power cord with a power supply plug.

 Insert a power supply plug to the back of a wall 
socket certainly.

Do not take out and insert a power supply plug by 
the wet hand.

 Install a power cord in the place which is not 
stepped on, and do not place a thing on a power 
cord.

Do not use the codes tied in a bundle.
 Please do not use the damaged power cord.
Do not carry out star-burst connection.
Do not connect this machine and other electric 

products to the same wall socket. If it connects 
simultaneously with an air-conditioning machine, a 
copying machine, shredder, etc. especially, a 
machine may incorrect-operate by the electric 
noise. When you connect with the same wall 
socket unavoidably, please use a commercial noise 
filter or a commercial noise cut transformer. 

Use the attached power cord and insert it directory 
with the ground terminal. Do not use the power 
cord for other product for the machine.

Do not use an extended code. When you use it 
unavoidably, use the thing more than rated 15A.

Use of an extended code may not operate a 
machine normally by AC voltage descent.

During printing, do not shut off a power supply or 
do not pull out a power supply plug.

When you use it neither for consecutive holidays 
nor a travel for a long time, pull out a power cord.

Do not user attached power cord to the other 
products.

WARNING
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Turning On Your Machine

1 Check that the power switch is off <O>.
It is the status where the power is turned off.

2 Plug the AC cable into the AC power 
socket of your machine.

3 Plug the AC cable into the electric socket.

4 Check that no documents are on the 
document glass or ADF, and the ADF 
cover is closed.

5 Press the <|> (on) side of the power 
switch.

Note

 Turn the power off, and when turning the power back on 
again, push the power switch to the <|> side after waiting 
for a few seconds.

Turning Off Your Machine

Be sure to follow the procedure below every time 
you turn off the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Shutdown]and 

press .

3 On the confirmation message, press the 
 or  to select [Yes] and then 

press .

OK

OK
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4 When the screen prompting you to turn 
off the power switch appears, press the 
<O> (off) side of the power switch to 
turn off the power switch.

Note

 Turn the power off, and when turning the power back on 
again, push the power switch to the <|> side after waiting 
for a few seconds.

When the machine is not used for 
long time

When the machine is not used for long time due 
to holidays or trips, pull the power cord from the 
socket. In addition, install the stopper release in 
the fuser unit.

Memo

 The machine does not have functional failures if removing 
the power plug for long time (more than 4 weeks).

Power Save Mode and Sleep Mode

The two-phase power saving mode enables you 
to save the power consumption of the machine.

Power Save Mode
When your machine is not used for a certain 
period of time, it automatically enters a power 
saving mode to reduce the power consumption.

You can enter the power saving mode manually 
by pressing the <POWER SAVE> key on the 
operator panel.

The <POWER SAVE> key lights up while in the 
mode.

Memo

 By factory default, the time interval to enter the power 
saving mode is set to 30 minutes. You can change the time 
interval by pressing the <SETTING> key on the operator 
panel and selecting [Admin Setup] > [Management] > 
[Power Save] > [Power Save Time].

Sleep Mode
Your machine goes from the power saving mode 
into the sleep mode after a set period of time. In 
the sleep mode, the status of your machine is 
almost the same as when it is turned off. 

The <POWER SAVE> key blinks while in the 
sleep mode.

Note

 The machine does not enter the sleep mode if an error 
occurs.

 If time-set transmission is scheduled, the machine will not 
go into sleep mode.

 If the fax transmission is waiting for a redial, the machine 
cannot enter sleep mode.

Memo

 By factory default, the time interval to enter the sleep 
mode is set to 10 minutes. You can change the time 
interval by pressing the <SETTING> key on the operator 
panel and then selecting [Admin Setup] > 
[Management] > [Power Save] > [Sleep Time].

Reference

 For more detailed information on sleep mode, please refer 
to User's Manual Advanced.

Returning to the Standby Mode
To return the machine to the standby mode from 
the power saving or sleep modes, press the 
<POWER SAVE> key on the operator panel.

Memo

 When your machine receives a print job from a computer 
or other devices, it automatically returns to the standby 
mode.
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 Installing Options
This section explains how to install options on your machine. The following options are available:

 Second tray unit

 Additional RAM (256 MB or 512 MB)

 16 GB SD memory card (MC561dn only)

Note

 Be sure to turn off your machine and unplug the AC cable and Ethernet or USB cable before installing options. Installing options 
while your machine is turned on may damage your machine and options.

Reference

 For details on the location of each component of the machine, refer to "Names of Components" P. 14.

Installing a Second Tray Unit
Install an optional second tray unit (tray 2) when 
you want to increase the paper capacity of your 
machine. After installation, you need to configure 
the printer driver settings.

Reference

 For the specification of the second tray unit (Tray2), refer 
to "Loading Paper" P. 66.

Installation

1 Turn off your machine, and then unplug 
the AC cable and the Ethernet or USB 
cable.

Reference

 "Turning Off Your Machine" P. 19

2 Lift your machine and align the three 
pins of the second tray unit with the 
holes at the bottom of your machine.

3 Place your machine on the second tray 
unit gently.

4 Attach the lock parts.

5 Plug the AC cable and Ethernet or USB 
cable into your machine, and then turn 
on the power switch.

It may cause injury!

At least two people are needed to lift the machine 
safely because it weighs about 29 Kg.

Model Number : N34311A

CAUTION



Installing Options

- 22 -

Printer Driver Configuration

Note

 You must be logged in as an administrator to complete this 
procedure.

 If the following conditions are met for Mac OS X, it is not 
necessary to configure the printer driver, as the configured 
option information is automatically taken from the 
machine.

- USB connection

- When options have been configured on the machine 
prior to installing the driver, where there is a connection 
to a network using EtherTalk

 Windows PCL XPS printer driver is not available for 
Windows Server 2003, Windows XP, and Windows 2000.

Reference

 The printer driver needs to be installed on the computer 
before doing this procedure. For details on how to install the 
printer driver, refer to "Connecting to a Computer" P. 30.

For Windows PCL/PCL XPS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the OKI MC561 icon and 
select [Printer properties]. (If you 
have installed multiple printer drivers, 
select [Printer properties] >[OKI 
MC561(PCL)] or [OKI MC561(PCL 
XPS)]).

3 Select the [Device Option] tab.

4 For the network connection, select [Get 
Printer Settings]. 
For the USB connection, enter "2" (the total 
number of trays installed on your machine).

5 Click [OK].

 For Windows PS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI MC561(PS)] icon 
and then select [Printer properties]. 
(If you have installed multiple printer 
drivers, select [Printer properties] >
[OKI MC561(PS)].)

3 Select the [Device Settings] tab.

4 For the network connection, select [Get 
Installable options automatically] 
under [Installable Options], and then 
click [Setup].
For the USB connection, select [2 (Add Second 
Tray)] for [Available Tray] under [Installable 
Options].

5 Click [OK].

 For Mac OS X PS Driver
(Mac OS X 10.5 and 10.6)

1 Select [System Preferences] from the 
Apple menu.

2 Click [Print & Fax].

3 Select the name of your machine and 
then click [Options & Supplies].

4 Select the [Driver] tab.
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5 Select [2(1 Optional Tray)] for the 

total number of trays installed on your 
machine, and then click [OK].

For Mac OS X PS Driver
(Mac OS X 10.3.9 to 10.4.11)
Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

1 From [Go], select [Utilities] and then 
double-click [Printer Setup Utility].

2 Select the name of your machine and 
then click [Show Info].

3 Select [Installable Options].

4 Select [2 (1 Optional Tray)] for the 
total number of trays installed on your 
machine, and then click [Apply 
Changes].

5 Close [Printer Info].

Installing Additional RAM
Install additional RAM to increase the memory 
capacity of your machine, such as if the memory 
overflow occurs. Your machine supports 256 MB 
and 512 MB RAM.

Note

 Use only genuine Oki Data products. The performance 
cannot be guaranteed when using other products.

Memo

 For long paper printing, additional memory of 256 MB or 
more is recommended.

1 Turn off your machine, and then unplug 
the AC cable.

Reference

 "Turning Off Your Machine" P. 19

2 Remove the connector cover while 
pressing the lock button (1) on the right 
side of the machine.

3 Unplug the Ethernet cable and USB cable 
from the machine.

4 Touching the metallic parts of the 
machine will result in an electric shock.

5 Loosen the screw (2) in the light 
direction and then remove the 
bracket (3).

1

23
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6 Insert the additional RAM into the slot 
and push it toward the machine.

7 Attach the bracket and then tighten the 
screw in the right direction.

8 Plug the Ethernet cable and USB cable 
into the machine.

9 Attach the connector cover.

10 Plug the AC cable into your machine, and 
then turn on the power switch.

11 Press the <SETTING> key on the 
operator panel.

12 Press the  to select [View 

Information] and press .

13 Check that [System Information] is 
selected and press . 

14 Check that the value of [Total Memory] 
has increased.

- Press  to scroll along the screen.

- For memory expanded to 256 MB it is [512 MB], 
for memory expanded to 512 MB it is [768 MB].

Note

 If the value of [Total Memory] has not increased, turn off 
your machine and unplug the AC cable and Ethernet or 
USB cable, and then reinstall the additional RAM.

Installing the 16-GB SD Memory Card 
(for MC561dn Only)

When increasing the capacity of the SD memory 
card, replace the SD memory card (4 GB) with 
16 GB SD memory card. 

Note

 Use only genuine Oki Data products. The performance 
cannot be guaranteed when using other products.

 You can not use the SD memory cards with the protection 
switch for wrong overwriting with locked. Make sure to 
release the lock.

1 Turn off your machine, and then unplug 
the AC cable and Ethernet or USB cable.

Reference

 "Turning Off Your Machine" P. 19

2 Remove the connector cover while 
pressing the lock button (1) on the right 
side of the machine.

3 Unplug the Ethernet cable or USB cable 
form the machine.

4 Touching the metallic parts of the 
machine will result in an electric shock.

5 Loosen the screw (2) in the light 
direction and then remove the 
bracket (3).

OK

OK

1

23
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6 Push the internal SD memory card and 

remove it from the SD memory card slot.

7 Insert the 16 GB SD memory card into 
the SD memory card slot.

8 Attach the bracket and then tighten the 
screw in the right direction.

9 Plug the Ethernet cable and USB cable 
into the machine.

10 Attach the connector cover.

11 Plug the AC cable into your machine, and 
then turn on the power switch.

12 Press the <SETTING> key on the 
operator panel.

13 Press the  to select [View 

Information]and then press .

14 Press to select [System Information] 

and press .

15 Check that the value of [SD Memory 
Card] is [15 GB].
Press  to scroll along the screen.

Note

 The memory capacity displayed in [SD Memory Card] 
(15 GB) is lower than the actual capacity (16 GB), however 
this is not an error.

 If the value of [SD Memory Card] has not increased, turn 
off your machine and unplug the AC cable and Ethernet or 
USB cable, and then reinstall the SD memory card.

OK

OK
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Operator Panel
This section explains the names and functions of components on the operator panel and how to enter 
text.

No. Name Function

1 Display screen Displays operating instructions and the status of the machine.

2 Main function keys Switches functions. The selected key lights up in blue.

<COPY> key Switches to the copy start screen.

<SCAN> key Switches to the scanner menu screen.

<PRINT> key Switches to the print menu screen.

<FAX> key Switches to the fax/internet fax menu screen.

3 <START (MONO)> key Starts copying, scanning, faxing, or printing from USB memory in 
black and white.

4 <START (COLOR)> key Starts copying, scanning, faxing, or printing from USB memory in 
color.

5 <STOP> key Cancels the current job immediately.

6 <STATUS> key Displays the status menu screen. 
Flashes/turns on if there is a status item to be displayed.

7 <SETTING> key Displays the equipment setting menu screen.

8 <?HELP> key Displays the help screen. When closing, press the <? Help> 
button, <Return> button, or <RESET/LOG OUT> button.

9 <RESET/LOG OUT> key  In the top screen of each function, logs out.
 In the start screen of each function, returns to the top screen.

*In the copy function, the top screen is the same as the start 
screen.

 In the setting screen, resets a setting value and returns to the 
start screen.

10 Ten-key pad  Enters numbers.
 Enters alphabetical characters and symbols.

11 <UP> key Shifts the highlighted selection up while an item is selected or 
characters are entered.

12 <DOWN> key Shifts the highlighted selection down while an item is selected or 
characters are entered.

13 <LEFT> key Returns to the previous screen.
Shifts the highlighted selection to the left while an item is 

selected or characters are entered.

2

19

1

22

20

185431712 1413

1116

15

6 7 89 10 21
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Default Screen
Turn the power on, and when the machine is in 
the state in which it can be used, the Copy Start 
screen will be displayed as the default mode.

You can switch to other functions by using the 
main function keys.

Reference

 You can change the default screen by pressing the 
<SETTING> key on the operator panel and then selecting 
[Admin Setup] > [Management] > [Default Mode].
For details, refer to the User's Manual Advanced.

Entering Text Using the 
Operator Panel

When you need to enter text while setting an 
item, the entry screen shown below appears.

You can enter upper and lower case letters, 
numbers and symbols with the screen keyboard.

Memo

 When you need to enter only numbers, the screen 
keyboard may not appear. In this case, enter numbers 
using the ten-key pad.

14 <RIGHT> key  Proceeds to the next screen.
Shifts the highlighted selection to the right while an item is 

selected or characters are entered.

15 <OK> key Confirms the highlighted item.
Selects an item to be checked.

16 <BACK> key Returns to the previous screen.

17 <CLEAR> key Executes the following actions according to the entered
Minimizes a setting value.
 Enters zero for a setting value.
Clears what is entered.
Cancels a selected item.

18 <POWER SAVE> key  Enters or exits the power saving mode.
 Exits the sleep mode.
Lights up in green while in the modes.

19 <DATA IN MEMORY> indicator Lights up when data is in memory.
* Sleep mode does not light up even if data in memory.

20 One touch key pad Accesses a registered e-mail address or fax number.
8 keys x 2 groups which is 16 entries in total (Press the <SHIFT> 
key to switch the groups)

21 <JOB MACRO> key 
(for MC561dn only)

Switches to the job macro screen.

22 Qwerty keyboard 
(for MC561dn only)

Enters text.
It is under the one touch key pad.

No. Name Function
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Entering Text

1 Press , , ,  to select the character 

you want, and then press .

The selected character is entered in the text field.

2 Repeat step 1 until all the characters 
required are entered.

3 Press the  and  to select [Enter] and 
press  to complete the entry process.

Using the Ten-key Pad
You can also use the ten-key pad to enter 
alphanumeric characters and symbols in the 
entry screen.

You can enter the numbers labeled on each key, 
as well as the other characters by pressing the 
keys repeatedly.

1 Press a key on the ten-key pad until the 
character you want appears in the text 
filed.

2 Repeat step 1 until all the characters 
required are entered.
If you continuously press the same key, you can 

press the  button to move the cursor.

3 Check that [Enter] is selected and press 

 to complete the entry process.
Memo

 You can enter the following characters by pressing the 
keys on the ten-key pad.

OK

OK

Ten-key Characters

1 1

2 abc2ABC

3 def3DEF

4 ghi4GHI

5 jkl5JKL

6 mno6MNO

7 pqrs7PQRS

8 tuv8TUV

9 wxyz9WXYZ

0 (Space) 0

* @*

# ._-(Space)+!"$%&'(),/
:;<=>?[\]^#

OK
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Using QWERTY Keyboard

(MC561dn only)
You can also use the QWERTY keyboard to enter 
alphanumeric characters and symbols in the 
entry screen.

The keyboard enables you to switch the entry 
mode to the standard mode, CAPS mode, or 
CTRL mode. The changed mode is reflected to 
the screen keyboard display.

 Standard mode

It enables you to enter small alphabetical letters.

The following screen keyboard is displayed.

 CAPS mode

Pressing the <CAPS> key enables you to enter 
capital alphabetical letters.

The following screen keyboard is displayed.

 CTRL mode

Pressing the <CTRL> key enables you to enter 
symbols.

The following screen keyboard is displayed.

Note

 When the QWERTY keyboard cover is open, the numerical 
keypad can only be used for entering numbers.

Deleting the Entered Text

You can delete text in the text field in the 
following ways.

Pressing the <CLEAR> key
Press the <CLEAR> key to delete the last 
character entered.

Hold the <CLEAR> key to delete all the 
characters you have entered.

Selecting [BS] on the Screen Key-
board

Press the  and  and to highlight [BS] and 

then press  to delete the last character 
entered.

Pressing the Backspace Key on the 
Qwerty Keyboard (for MC561dn 
Only)

Press the backspace key to delete the last 
character entered.

OK
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Connecting to a Computer
This section explains how to connect your machine to a computer and install a printer and fax driver. 

Connecting method
You can select either of the following connection methods:

 "Network Connection" P. 31

 "USB Connection" P. 40

Product Requirements
Your machine supports the following operating systems:

 Windows 7/Windows 7 (64bit Version)

 Windows Vista/Windows Vista (64bit Version)

 Windows Server 2008 R2

 Windows Server 2008/Windows Server 2008 (x64 Version)

 Windows XP/Windows XP (x64 Version)

 Windows Server 2003/Windows Server 2003 (x64 Version)

 Windows 2000

 Mac OS X 10.3.9 to 10.6

Note

 For Mac OS X 10.6 users, install Rosetta before printer driver installation.

Types of Drivers
The types of the drivers that can be installed are as follows.

 For Windows

 For Mac OS X

Note

 Depending on a version of a printer driver, Windows or Mac OS X, the description may be different.

Type Description

PCL The PCL printer driver is suitable for printing of business documents.

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS 
data.

PCL XPS The PCL XPS printer driver is suitable for printing from an application for XPS.

* It does not support Windows XP/ Windows Server 2003 or Windows 2000.

FAX It is installed when directly sending faxes to destinations from the computer via the machine.

Type Description

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS 
data.
It can be also used for normal printing.
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Network Connection

Do the following procedure to connect your 
machine to a computer via network.

Connecting an Ethernet Cable

Be sure to connect your machine to a network 
with an Ethernet cable before driver installation.

1 Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted 
pair, straight) and a hub separately.

2 Turn off your machine and a computer.

Reference

 "Turning Off Your Machine" P. 19

3 Remove the side cover on the right side 
of the machine while pressing the lock 
button (1).

4 Plug one end of the Ethernet cable into 
the network interface connection (2) on 
the back of the machine.

5 Hook the Ethernet cable on the hook (3) 
of the machine.

6 Attach the side cover.

7 Plug the other end of the Ethernet cable 
into the hub.

1

2

3
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Install a printer and fax driver
(for Windows)

To complete the network connection with a 
Windows computer, first set IP addresses for the 
machine, and then install a printer and fax driver 
on the computer.

If there is no DHCP server or BOOTP server on 
the network, you need to manually configure the 
IP address on the computer or machine.

Your network administrator or internet service 
provider specifies an unique IP address for the 
computer and your machine, set the IP 
addresses manually.

Note

 You need to complete the network setting of the computer 
before this procedure.

 To complete this procedure, you must be logged in as an 
administrator.

 When setting an IP address manually, ask the network 
administrator or your internet service provider which IP 
address to use. If the IP address is set wrong, the network 
may go down or Internet access may be disabled.

Memo

 If configuring a small network consisting of only your 
machine and a computer, set IP addresses as shown below 
(according to RFC1918).

 To set [Network Scale], press the <SETTING> key and 
then select [Admin Setup] > [Network Menu] > 
[Network Setup] > [Network Scale].

 First, Set the IP address of the machine.

1 Turn on the machine.

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Easy Setup], and 

press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  and [Network Setting], 
and then press the .

7 If setting the IP address manually, check 

that [Manual] is selected, and press .

If obtaining the IP address automatically, press 

the  and select [Auto], and press . Proceed 
to the step 12.

8 Enter the IP address and press .
To move to the next box, press the .

9 Enter the subnet mask and press .
To move to the next box, press the .

10 Enter the default gateway address and 

press .
To move to the next box, press the .

11 Enter the DNS server and WINS server if 
needed.
If it is not necessary to connect the DNS server or 

WINS server to the network, press  until the 
pop-up message of showing the setting 
completion is displayed.

12 When the setup menu screen is 

displayed, press  to complete the 
setup.

For the computer

IP address : 192.168.0.1~254

Subnet mask : 255.255.255.0

Default gateway : not used

DNS server : not used

For the machine

IP address Set : Manual

IP address: 192.168.0.1~254 (select a dif-
ferent value from the com-
puter)

Subnet Mask : 255.255.255.0

Default Gateway : 0.0.0.0

Network Scale : Small

OK

OK

OK

OK

OK

OK

OK

OK

OK
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 Next, install the printer and fax driver into the 

computer.

1 Ensure that your machine and the 
computer are turned on and connected, 
and then insert the "Software CD-ROM" 
into the computer.

Reference

 "Connecting an Ethernet Cable" P. 31

2 Click [Run setup.exe] after [Auto 
Play] is displayed.
If the [User Account Control] dialog box 
appears, click [Yes].

3 Select the model of your machine, and 
then click [Next].

4 Read the license agreement and then 
click [I Agree].

5 Select [Easy Installation (Network)] 
under [Driver Installation].

Memo

 In [Easy Installation (Network)], PCL, PS, FAX 
drivers for your OS are installed. If you want to select 
a driver to install manually, install a shared printer, or 
use LPR Utility as a print method, select [Custom 
Installation (Printer)] and then follow the 
instruction displayed on the screen.

6 Click [Next].

The device search starts.

- If the machine is detected, it is automatically 
installed. Proceed to the step 8.

- If the machine is not detected, the [Check for 
the installed devices] screen is displayed. 
Proceed to the step 7.

Memo

 Besides the printer and fax driver, you can install the 
scanner driver, Network Extension, and the Color 
Swatch Utility at the same time.

7 click [Restart search] to restart the 
device search.

After the machine is displayed, select the machine 
and click [Next].

Memo

 If the machine is not displayed by clicking [Restart 
search], select [IP address] and enter the IP 
address assigned to your machine, and then click 
[Next].

8 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].
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9 Click [Finish] to complete the 
installation.

- To set a default printer, select the check box of the 
driver you want.

- If the optional second unit is installed in the 
machine prior to driver installation, click on 
[Driver properties] and change the set tray.

Note

 If the dialog box prompting to restart the computer 
appears, click [Yes]. The computer automatically 
restarts.

Reference

 For how to configure the tray settings by the driver, 
refer to "Printer Driver Configuration" P. 22.

10 Click [Start] > [Devices and Printers].

11 Check that the OKI MC561 icon is 
displayed.
Right-click the OKI MC561 icon and select one of 
the menu item, and then check that all the printer 
drivers installed are displayed in the submenu.

12 Remove the "Software CD-ROM" from 
the computer.
The installation is complete.

Installing a Printer Driver
(For Mac OS X)

To complete the network connection with a Mac 
operating system, install a printer driver on the 
computer and set your machine as a network 
printer.

Select the protocol for your network connection 
from the following:

 EtherTalk

 Bonjour (Rendezvous for Mac OS X 10.3)

Note

 EtherTalk is not supported in Mac OS X 10.6.

 Disable the anti-virus software before starting this 
procedure.

Using EtherTalk (For Mac OS X 
10.5)

When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk and disable 
the sleep mode in the machine. Then, install the 
driver in the computer.

 First, enable EtherTalk in the machine.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 31

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Admin Setup], 
and press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  to select [Network Menu], 
and press .

7 Press the  to select [Network Setup], 
and press .

8 Press the  to select [EtherTalk], and 
press .

9 Press the  to select [Enable], and 
press .

10 Press the  until the top screen is 
displayed.

 Next, disable the sleep mode in the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Complete], and press .

OK

OK

OK

OK

OK

OK

OK

OK
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5 Press the  to select [User Install], 

and press .

6 Press the  to select [Power Save], 
and press .

7 Press the  to select [Sleep], and 
press .

8 Press the  to select [OFF], and 
press .

9 Press the  until the top screen is 
displayed.

 Then, install the driver in the computer.

1 Insert the "Software CD-ROM" into the 
computer.

2 Double-click the [OKI] icon on the 
desktop.

3 Double-click [Driver] > [Printer] > 
[Installer for MacOSX].

4 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

5 From the Apple menu, select [System 
Preferences].

6 Click [Print & Fax].

7 Click [+].

8 Click [AppleTalk].

9 Select the name of your machine and 
then check that [OKI MC561(PS)] is 
displayed in [Print Using].

10 Click [Add].

11 Check that your machine is displayed in 
[Printers] and [OKI MC561(PS)] is 
displayed in [Kind].

Note

 If [OKI MC561(PS)] is not correctly displayed in 
[Kind], click [-] to remove your machine from [Print 
& Fax] and then redo the procedure from steps 7 to 
10.

12 Close [Print & Fax].

13 Remove "Software CD-ROM" from the 
computer.
The installation is complete.

OK

OK

OK

OK
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Using EtherTalk
(For Mac OS X 10.3.9 to 10.4.11)

When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk in the 
machine, and disable the sleep mode. Then, 
install the driver in the computer.

Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

 First, enable EtherTalk in the machine.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 31

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Admin Setup], 
and press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  to select [Network Menu], 
and press .

7 Press the  to select [Network Setup], 
and press .

8 Press the  to select [EtherTalk], and 
press .

9 Press the  to select [Enable], and 
press .

10 Press the  until the top screen is 
displayed.

 Next, disable the sleep mode in the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Complete], and press .

5 Press the  to select [User Install], 
and press .

6 Press the  to select [Power Save], 
and press .

7 Press the  to select [Sleep], and 
press .

8 Press the  to select [OFF], and 
press .

9 Press the  until the top screen is 
displayed.

 Then, install the driver in the computer.

1 From the Apple menu, select [System 
Preferences].

2 Select [Network].

3 Select [Network Port Configurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

4 Select [Built-in Ethernet] from [Show] 
and select the [AppleTalk] tab, and 
then check that [Make AppleTalk 
Active] is selected.

5 Close [Network].

6 Insert "Software CD-ROM" in the 
computer.

7 Double-click the [OKI] icon on the 
desktop.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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8 Double-click [Driver] folder > [Printer] 

folder > [Installer for Mac OSX].

9 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].

Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

12 Select the name of your machine whose 
[Connection] is [AppleTalk], and then 
check that [OKI MC561(PS)] is 
displayed in [Print Using].

For Mac OS X 10.3.9, set as follows.

a) Select [AppleTalk] from the pop-up 
menu.

b) Select the machine from the list.

c) Select [Oki] from [Printer Model] and 
then select [OKI MC561(PS)] from the 
driver list.

13 Click [Add].

14 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

15 From the [Go] menu, select 
[Applications] and then double-click 
[TextEdit].

16 Select the [File] menu > [Page Setup].

17 Select the name of your machine from 
[Format for].

18 Check that the [OKI MC561(PS)] is 
displayed correctly under [Format for].

19 Click [OK].

20 Remove "Software CD-ROM" from the 
computer.
The installation is complete.

Using Bonjour
(For Mac OS X 10.5 and 10.6)

When connecting to the network with Bonjour, it 
is necessary to disable the sleep mode in the 
machine. Then, install the driver in the computer 
and set the machine as a network printer.

Next, disable the sleep mode in the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 

and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Complete], and press .

5 Press the  to select [User Install], 
and press .

6 Press the  to select [Power Save], 

and press .

OK

OK

OK

OK
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7 Press the  to select [Sleep], and 
press .

8 Press the  to select [OFF], and 
press .

9 Press the  until the top screen is 
displayed.

Then, install the driver in the computer.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 31

2 Insert "Software CD-ROM" into the 
computer.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [Printer] 
folder > [Installer for MacOSX].

5 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Fax].

8 Click [+].

9 Click [Default].

10 Select the name of your machine whose 
[Kind] is [AppleTalk], and then check 
that [OKI MC561(PS)] is displayed in 
[Print Using].
The name of your machine is displayed with the 
format of "OKI-MC561- (the last six digits of the 
MAC address)".

11 Click [Add].

12 If the [Installable Options] window is 
displayed, click [Continue].
If you have installed the optional second tray unit 
before the driver installation, configure each item 
and then click [Continue].

13 Check that your machine is displayed in 
[Printers] and [OKI MC561(PS)] is 
displayed in [Kind].

Note

 If [OKI MC561(PS)] is not correctly displayed in 
[Kind], click [-] to remove your machine from [Print 
& Fax] and then Redo the procedure from step 8 
to 12.

OK

OK
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14 Close [Print & Fax].

15 Remove "Software CD-ROM" from the 
computer.
The installation is complete.

Using Bonjour (Rendezvous)
(for Mac OS X 10.3.9 to 10.4.11)

When connecting to the network with Bonjour, it 
is necessary to disable the sleep mode in the 
machine. Then, install the driver in the computer 
and set the machine as a network printer.

Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

Next, disable the sleep mode in the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Complete], and press .

5 Press the  to select [User Install], 
and press .

6 Press the  to select [Power Save], 
and press .

7 Press the  to select [Sleep], and 
press .

8 Press the  to select [OFF], and 
press .

9 Press the  until the top screen is 
displayed.

Then, install the driver in the computer.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 31

2 From the Apple menu, select [System 
Preferences].

3 Select [Network].

4 Select [Network Port Configurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

5 Close [Network].

6 Insert "Software CD-ROM" into the 
computer.

7 Double-click the [OKI] icon on the 
desktop.

8 Double-click [Driver] folder > [Printer] 
folder [Installer for Mac OSX].

9 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].

Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

OK

OK

OK

OK

OK

OK
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12 Select the name of your machine whose 
[Connection] is [Bonjour], and then 
check that [OKI MC561(PS)] is 
displayed in [Print Using].
The name of your machine is displayed with the 
format of "OKI-MC561- (the last six digits of the 
MAC address)".

For Mac OS X 10.3.9, set as follows.

a) Select [Rendezvous] from the pop-up 
menu.

b) Select the machine from the list.

c) Select [Oki] from [Printer Model] and 
then select [OKI MC561(PS)] from the 
driver list.

13 Click [Add].

14 If the [Installable Options] window is 
displayed, click [Continue].
If you have installed the optional second tray unit 
before the driver installation, configure each item 
and then click [Continue].

15 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

16 From the [Go] menu, select 
[Applications] > [TextEdit].

17 Select the [File] menu > [Page setup].

18 Select the name of your machine from 
[Format for].

19 Check that [OKI MC561(PS)] is 
displayed correctly under [Format for].

20 Click [OK].

21 Remove "Software CD-ROM" from the 
computer.
The installation is complete.

USB Connection
Perform the following procedure to connect your 
machine to a computer via USB.

Connecting a USB Cable

1 Prepare a USB cable.
A USB cable is not supplied with your machine. 
Prepare an USB 2.0 cable separately.

Memo

 Use a USB 2.0 Hi-Speed cable for a USB 2.0 Hi-Speed 
connection.

2 Turn off your machine and the computer.
Reference

 "Turning Off Your Machine" P. 19

3 Remove the connector cover on the right 
side of the machine while pressing the 
lock button (1).

1
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4 Plug one end of the USB able into the 

USB interface connector (2) on the back 
of the machine.

5 Hook the USB cable on the hook (3) of 
the machine.

6 Attach the connector cover to the 
machine.

7 Plug the other end of the USB cable into 
the computer's USB interface connector.

Note

 For Windows OSs, do not plug the other end of the 
USB cable into the computer until prompted while 
driver installation.

Note

 Do not plug the USB cable into the network interface 
connection. Doing so may cause a malfunction.

Installing a Printer Driver (For 
Windows)

Note

 You must be logged in as an administrator to complete this 
procedure.

1 Ensure that your machine is turned off 
and the USB cable is unplugged from the 
computer.

2 Turn on the computer.

3 Insert "Software CD-ROM" into the 
computer.

4 Click [Run setup.exe] after [Auto 
Play] is displayed.
If the [User Account Control] dialog box 
appears, click [Yes]. 

5 Select the model of your machine, and 
then click [Next].

6 Read the license agreement and then 
click [I Agree].

7 Select [Easy Installation (Local)] 
under [Driver Installation].

Memo

 In [Easy Installation (Local)], PCL, PS, FAX drivers 
for your OS are installed. If you want to select a driver 
to install manually, select [Custom Installation 
(Printer)] and then follow the instruction displayed 
on the screen.

2

3
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8 Click [Next].

Installation starts.

Memo

 Besides the printer and fax driver, you can install the 
scanner driver and the Color Swatch Utility at the 
same time.

9 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

10 When connecting the machine to the 
computer, and the instruction prompting 
to turn on the machine appears, plug the 
USB cable into the computer and turn on 
your machine.

Follow the instructions displayed on the screen to 
complete the installation.

Reference

 "Connecting a USB Cable" P. 40

11 When the [Installation complete] 
screen appears, click [Finish].

12 Click [Start] > [Devices and Printers].

13 Check that the OKI MC561 icon is 
displayed.
Right-click the OKI MC561 icon and select one of 
the menu item, and then check that all the printer 
drivers installed are displayed in the submenu.

14 Remove "Software CD-ROM" from the 
computer.
The installation is complete.

Installing a Printer Driver
(For Mac OS X)

Note

 Disable the anti-virus software before starting this 
procedure.

 For Mac OS X 10.5 and 10.6

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting a USB Cable" P. 40

2 Insert "Software CD-ROM" into the 
computer.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [Printer] 
folder [Installer for MacOSX].

5 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Fax].
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8 Click [+].

Note

 If the machine is already shown in [Printers], select 
your machine, and click on [-] to delete. After this, 
click [+].

9 Select the name of your machine whose 
[Connection] is [USB], and then check 
that [OKI MC561(PS)] is displayed in 
[Print Using].

10 Click [Add].

11 Check that the name of your machine is 
displayed in [Printers] and [OKI 
MC561(PS)] is displayed.

Note

 If [OKI MC561(PS)] is not correctly displayed, click 
[-] to remove your machine from [Printers] and then 
redo the procedure from steps 8 to 10.

12 close [Print & Fax].

13 Remove "Software CD-ROM" from the 
computer.
The installation is complete. 

 For Mac OS X 10.3.9 to 10.4.11
Memo

 The procedure below uses Mac OS X 10.4.11 as an 
example. Depending on your OS, the description may be 
different.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting a USB Cable" P. 40

2 Insert "Software CD-ROM".

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [Printer] 
folder > [Installer for Mac OS X].

5 Enter the administrator's password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the [Go] menu, select [Utilities], 
and then double-click [Printer Setup 
Utility].

Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

7 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

Note

 If the name of your machine whose [connection] is 
[USB] is already displayed, select it and click 
[Delete], and then click [Add].
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8 Select the name of your machine whose 
[Connection] is [USB], and then check 
that [OKI MC561(PS)] is displayed in 
[Print Using].

For Mac OS X 10.3.9, set as follows.

a) Select [USB] from the pop-up menu.

b) Select the machine from the list.

c) Select [OKi] from [Printer Model] and 
then select [OKI MC561(PS)] from the 
driver list.

9 Click [Add].

10 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

11 Remove "Software CD-ROM" from the 
computer.
The installation is complete.
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Configuring the Network Settings
This section describes the setup required for using Scan To E-mail, ScanTo Network PC, Internet Fax functions.
The above functions enable you to send scanned data to a computer via the network connection. To use 
them, you need to set up your machine and the computer to which you want to send scanned data.
First check the settings of the computer and fill in the information in the [User Value] column of the Setup 
Information Form below. Then, configure your machine and the computer using the information in [User Value].

Reference

 Be sure to configure the network connection before doing the procedures below. For the network connection, refer to "Network 
Connection" P. 31.

Setup Information Form

No. Item Outline Introduction Example

User Value
*You can look at the following 

page and later and write 
memos here on the details you 
have checked or the settings 
you have configured.

Common Setup Information
A-1 Administrator pass-

word for your machine
The password you use to change the 
machine's system settings

aaaaaa

A-2 IP address of your 
machine

The IP address allocated to your machine 192.168.0.2

A-3 DNS server address DNS server address 192.168.0.1

Setup Information Required for Scan To E-mail and Internet Fax
B-1 E-mail address for 

your machine
The e-mail address used when sending e-
mails from the machine

mc561@test.
co.jp

(Up to 80 characters)

B-2 SMTP server address The address of the server used when 
sending e-mails 

smtp.test.co.jp

B-3 POP3 server address The address of the server used when 
receiving e-mails

pop3.test.co.jp

B-4 Authentication 
method

Sending mail server authentication SMTP

B-5 SMTP user ID Sending mail server account name OKIMC561

B-6 SMTP password Sending mail server password okimc561

B-7 POP user ID Receiving mail server account name user

B-8 POP password Receiving mail server password okimc561

B-9 Name of the e-mail 
destination

The name of the recipient to whom you 
are sending a scan-to-mail/ internet fax 
from the machine

User

B-10 E-mail address of the 
e-mail destination

The e-mail addres of the recipient to 
whom you are sending a scan-to-mail/ 
internet fax from the machine

user@test.com

Setup Information Required for Scan To Network PC
C-1 Name of the destina-

tion computer
The name of the computer to which you 
are forwarding scanned data

PC1

C-2 User name to log into 
the destination com-
puter

User name to log in to the computer to 
which you are forwarding scanned data

mc561 (Up to 32 characters)

C-3 Password to log into 
the destination com-
puter

Password to log in to the computer to 
which you are forwarding scanned data

mc561 (Up to 32 characters)

C-4 Profile name to regis-
ter the settings

Name when registering the machine 
settings

Sales (Up to 16 characters)

C-5 Shared folder name 
on the destination 
computer

Folder name of the computer to which 
you are forwarding scanned data

SalesDev (Up to 64 characters)

C-6 File name of the 
scanned data

Scanned data folder name ScanData (Up to 64 characters)
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Checking the Common Setup 
Information

Check the common setup information for Scan To 
E-mail, Scan To Network PC and Internet Fax, 
and fill in the corresponding columns of the 
Setup Information Form.

Administrator Password for Your 
Machine

Enter the administrator password of your 
machine in A-1 of the Setup Information Form.
If you are not the administrator of the machine, 
ask the administrator the password.

Memo

 Passwords are case-sensitive.

 The administrator password is set to "aaaaaa" as the 
factory default setting.

Gateway address/DNS server

1 Press the <SETTING> key on the 
operator panel.

2 Check that [Reports] is selected and 

press .

3 Check that [Configuration] is selected 
and press .

4 On the confirmation screen press  or , 

select [Yes], and press .

5 Enter the address written on the gateway 
address line at the bottom right of page 
3 of the printed configuration into A-2 on 
the setting information sheet, and enter 
the address written on the DNS server 
(primary) line on the bottom right of the 
same page into A-3.

Note

 It is necessary that the gateway address be configured 
beforehand. Also, if using an internet service provider, it is 
necessary that the DNS server be configured. If it has not 
been configured (0.0.0.0), follow the 34 page procedure to 
configure it.

Setting Up Scan To E-mail and 
Internet Fax

The Scan To E-mail and Internet Fax functions 
enable you to send scanned images as an 
attached file of an e-mail to the specified e-mail 
address on the network.To use these functions, 
set up the e-mail setting for your machine.
When using Auto Deliver or Transmission Data 
Save function (MC561dn only), the following 
setup is required.

Checking the E-mail Settings of the 
Computer

Note

 If a network administrator specifies the values such as a 
mail server account, password and e-mail address for your 
machine, enter them in the Setup Information Form.

Memo

 The procedure below uses Windows Live Mail on Windows 
7. If you are using different mail software, refer to the 
manual for the e-mail software.

1 Click [Start] and select [Windows Live 
Mail].

2 Select the [Tools] menu > [Accounts].
If the menu bar is not displayed, click the 
[Menus] icon and then select [Show menu bar].

3 Select the mail account and then click 
[Properties].

OK

OK

OK
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4 On the [General] tab, enter the contents 

of [Name] and [E-mail address] in B-9 
and B-10 of the Setup Information Form.

5 Click the [Servers] tab, and then note 
each setting in the corresponding 
columns of the Setup Information Form.

- If there is a check in the [My server requires 
authentication] checkbox, enter "SMTP" into B-4 
and follow procedure 6.

- If there is no check in the [My server requires 
authentication] checkbox, enter [POP or not 
yet authenticated] in B-4. At this point the 
confirmation of e-mail settings is complete.

Note

 If using an internet service provider, enter [POP].

6 Click [Settings].

7 Check the login information on the 
[Outgoing Mail Server] dialog.

- If [Use same settings as my incoming mail 
server] is selected, enter the same values as B-7 
and B-8 on B-5 and B-6.

- If [Log on using] is selected, note the content of 
[Accountname] and [Password] in B-5 and B- 
6, respectively.

Setting the E-mail Address for Your 
Machine

When sending data scanned from the machine by 
an e-mail, the e-mail address for the machine is 
necessary.According to the following procedure, 
set the e-mail address of the machine and enter 
an e-mail address to be used by your machine in 
B-1 of the Setup Information Form.
 If the e-mail address for your machine is specified 

by the network administrator, enter the e-mail 
address in B-1.

 If you are using an internet service provider, obtain 
an e-mail address for your machine from the 
provider and then enter the e-mail address in B-1.

 If the e-mail address for your machine is neither 
specified nor obtained, determine the e-mail 
address according to the value you entered in B-4 
(authentication method):

- If B-4 is "SMTP", determine an e-mail address and 
enter it in B-1.

- B-4 is "POP", enter the same e-mail address as B-
10 in B-1.

Note

 If you want your machine to receive e-mail, you must 
obtain an e-mail address for your machine from a network 
administrator or your internet service provider.

Configuring Your Machine for Scan 
To E-mail and Internet Fax

Set up your machine for Scan To E-mail and 
Internet Fax using the information in the Setup 
Information Form.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Easy Setup] and 
press .

3 Enter the administrator password (A-1).

4 Select [Enter] and then press .

5 Press the  to select [E-mail Setting] 
and then press the .

6 Press the  and then enter the 
information in B-2.

B-9

B-10

B-3
B-2

B-7
B-8

OK

OK
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7 Select [Enter] and then press .

8 Press the  and then enter the 
information in B-1.

9 Select [Enter] and then press .

10 Press the  and then select an 
authentication method based on the 
information in B-4. Then, press .

- If B-4 is "Do not authenticate", select [Do not 
authenticate]. Proceed to the step 21.

- If B-4 is "SMTP", select [SMTP Auth]. Proceed to 
the step 11.

- If B-4 is "POP", select [POP Before SMTP]. 
Proceed to the step 15.

11 Press the  and then enter the 
information in B-5. 

12 Select [Enter] and then press .

13 Press the  and then enter the 
information in B-6.

14 Select [Enter] and then press .
Proceed to the step 21.

15 Press the  and then enter the 
information in B-3.

16 Select [Enter] and then press .

17 Press the  and then enter the 
information in B-7.

18 Select [Enter] and then press .

19 Press the  and then enter the 
information in B-8.

20 Select [Enter] and then press .

21 When the setup menu screen is 
displayed, press .

The setup for Scan To E-mail and Internet Fax is 
complete.

Reference

 For details on how to use Scan To E-mail, refer to "Scan to 
E-mail" P. 98.

 For details on how to use Internet Fax, refer to "Basic 
Procedure for Internet Faxing" P. 91.

Setting Up Scan To Network 
PC

The Scan To Network PC function enables you to 
send and save scanned images to the "shared 
folder" of a computer on the network. To use this 
function, register your machine on the computer 
as a user and create a shared folder, and then 
create a profile on your machine to register the 
settings for the computer.

Note

 Before starting the setup, get permission from the network 
administrator to create a shared folder on the computer by 
following the procedure below.

Memo

 The CIFS protocol is used in this procedure.

Checking the Name of the Computer

Check the name of the computer following the 
procedure below, and fill in C-1 of the Setup 
Information Form.

 For Windows 7, Windows Server 
2008 R2, Windows Server 2008 
and Vista

1 Click [Start] and select [Control 
Panel].

2 Select [System and Security].
For Windows Server 2008 and Windows Vista, 
select [System and Maintenance].

3 Select [See the name of this 
computer] under [System].

4 Enter the name in [Computer name] in 
C-1 of the Setup Information Form.

5 Close the window.

 For Windows Server 2003 and 
Windows XP

1 click [start] > [Control Panel] >
[Performance and Maintenance] >
[System].
For Windows Server 2003, click [Start] > 
[Operator panel] > [System].

OK

OK

OK

OK

OK

OK

OK

OK

OK

C-1
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2 Select the [Computer Name] tab and 

then click [Change].

3 Enter the name in [Computer Name] in 
C-1 of the Setup Information Form.

4 Click [Cancel] to close the window.

For Windows 2000

1 Click [Start] > [Settings] > [Control 
Panel].

2 Double-click [System].

3 Select the [Network Identification] 
tab and then click [Properties].

4 Enter the name in [Computer Name] in 
C-1 of the Setup Information Form.

5 Click [Cancel] to close the window.

For Mac OS X

1 From the Apple menu, select [System 
Preferences].

2 Click [Share].

3 Enter the name in [Computer Name] in 
C-1 of the Setup Information Form.

Memo

 If the computer name is over 16 characters, for Mac OS X 
10.4.11 enter the first 15 characters in C-1. For Mac OS X 
10.5-10.6, select the network service you are using from 
[System Environment Settings] > [Network], and 
enter the NetBios field name into C-1 within WINS in 
Detailed Settings.

4 Close [Share].

Determining the Names of the Items 
Required for Scan To Network PC

Determine the names of the following items and 
fill in C-2 to C-6 on the Setup Information Form.

 User name to log into the destination computer (C-2)

Note

 If the username is managed on the domain, enter 
"Username@Domainname" in C-2. To check the 
domain name, click on [Change] within the 
[Computer Name] tab in the [System Properties] 
dialogue box.

 Password to log into the destination computer (C-3)

 Profile name to register the settings on your 
machine (C-4)

 Shared folder name on the destination computer 
(C-5)

 File name of the scanned data (C-6)

Configuring the Computer for Scan 
To Network PC

With the setup information form, create an 
account and shared folder for the machine in the 
computer.

Memo

 If the computer is in a domain, the procedure of adding a 
user account may be different to the procedure below. 
Refer to the Microsoft Windows manual.

 For Windows 7, Windows Server 
2008 R2, Windows 2008 and Win-
dows Vista

1 Click [Start] > [Control Panel].

2 Select [Add or remove user 
accounts].

3 Select [Create a new account].

4 Enter the information in C-2 in the text 
box.

C-1
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5 Ensure that [Standard user] is 
selected, and then click [Create 
Account].

6 Click the icon of the user account created 
in step 5.

7 Select [Create a password].

8 Enter the information in C-3 in [New 
password] and [Confirm new 
password], and then click [Create 
password].

9 Close the operator panel.

10 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

11 Right-click the folder created in step 10 
and select [Properties].

12 Select the [Sharing] tab and then click 
[Share].

13 Select the user account created in step 5 
from the drop down box, and then click 
[Add].

14 Check that the user added in step 13 is 
displayed and then click [Share].

After the [Network discovery and file sharing] 
dialog box is displayed, click [No, make the 
network that I am connected to a private 
network].

15 Click [Done].

16 Click [Advanced Sharing] on the 
[Sharing] tab.

17 Click [Permissions].

For Windows Vista/Windows Server 2008, proceed 
to the step 20.

18 Click [Add].
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19 Enter the value in C-2 in the entry field 

and then click [OK].

20 Select the user added in step 13 and 
select the [Allow] check box for [Full 
Control], and then click [OK].

21 click [OK].

22 Click [Close].
Proceed to "Creating a Profile for Scan To Network 
PC" P. 56.

For Windows XP

1 Click [start] > [Control Panel].

2 Double-click [User Accounts].

3 Select [Create a new account].

4 Enter the value of C-2 in the text box and 
click [Next].

5 Select [Limited] and click [Create 
Account].

6 Click the icon of the user account created 
in step 5.

7 Select [Create a password].

8 Enter the value of C-3 in [Type a new 
password] and [Type the new 
password again to confirm], and then 
click [Create Password].

9 Close the operator panel.

10 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

11 Right-click the folder created in step 10, 
and then select [Sharing and 
Security].
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12 Click [If you understand the security 
risks but want to share files without 
running the wizard, click here.].

If the screen below appears, select [Share this 
folder] and click [Permissions]. Proceed to step 
15.

13 Select [Just enable file sharing] in 
Windows Firewall, and then click [OK].

14 Select the [Share this folder on the 
network] and [Allow network users 
to change my files] check box, and 
then click [OK].

Proceed to "Creating a Profile for Scan To Network 
PC" P. 56

15 Click [Add].

16 Enter the value in C-2 in the entry field 
and click [OK].

17 Select the [Allow] check box for [Full 
Control], and then click [OK].

Proceed to "Creating a Profile for Scan To Network 
PC" P. 56
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For Windows Server 2003/ Win-

dows 2000
Memo

 The items here may differ depending on the edition you 
are using.

1 Click [Start] > [Administrative Tools] > 
[Computer Management].
For Windows 2000, right-click the [My 
Computer] on the desktop, and select 
[Manage].

2 In the right window, double-click 
[System Tools] > [Local Users and 
Groups], and then Right-click [Users] 
and select [New User].

3 Enter the value of C-2 in [User name] 
and the value of C-3 in [Password] and 
[Confirm password].

4 Select [User can not change 
password] and [Password never 
expires], and then click [Create].

Memo

 If [User must change password at next logon] is 
selected, clear it so that you can select [User can not 
change password] and [Password never expires].

5 Click [Close].

6 Double-click [User] and check that the 
user created in step 4 is displayed.

7 Close the window.

8 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

9 Right-click the folder created in step 8 
and then select [Sharing].

10 Select [Share this folder] and then 
click [Permissions].

11 Click [Add].

For Windows 2000, proceed to the step 13.

12 Enter the value in C-2 in the entry field 
and click [OK]. 

Proceed to the step 15.
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13 For Windows 2000, select the user 
account created in step 4 and then click 
[Add].

14 Check that the user account added in the 
step 13 is displayed in the following list, 
and then click [OK].
The user account is displayed with the format of 
"C-1\C-2".

15 Select the [Allow] check box for [Full 
Control], and then click [OK].

16 Ensure that the icon of the shared folder 
created in the step 8 changes into the 
icon with a hand, and then close the 
window.
"Creating a Profile for Scan To Network PC" P. 56

For Mac OS X 10.5 to 10.6

1 From the Apple menu, select [System 
Preferences].

2 Click [Accounts].

3 Click [Click the key to change] at the 
bottom left of the screen and enter the 
administrator's password. Then, click 
[OK].

4 Click [+].

5 Select [Standard] from [New 
Account].

6 Enter the value of C-2 in [Name].
For Mac OS X 10.5, enter the value of C-2 in 
[Name].

7 Enter the value in C-3 in both 
[Password] and [Verify].

8 Click [Create Account].
Memo

 After the dialog box for auto login, disable the auto 
login.

9 Check that an account is added to 
[Other Accounts] with the name of C-2, 
and close [Accounts].

10 Create a new folder on the computer 
with the name entered in C-5.
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11 From the Apple menu, select [System 

Preferences].

12 Click [Share].

13 Check the check box of [File Sharing].

14 Click [+] under [Shared Folder].

15 Select the folder created in the step 10 
and click [Add].

16 Select the folder added in the step 15 
and click [+] under [Users].

17 Select the account created in the step 8 
and click [Select].

18 Click the triangle button at the right side 
of the user added in the step 17 and 
select [Read & Write].

19 Click [Options].

20 Check the checkbox of [Share files and 
folders using SMB (Windows)].
For Mac OS X 10.5, check the checkbox of [Share 
files and folders using SMB].

21 Check the checkbox of the account 
added in the step 16.

22 Enter the value of C-3 in [Password] 
and click [OK].

23 Click [Done].

24 Close [Share].
Proceed to "Creating a Profile for Scan To Network 
PC" P. 56

 For Mac OS X 10.3.9 to 10.4.11
Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

1 From the Apple menu, select [System 
Preferences].



Configuring the Network Settings

- 56 -

2 Click [Accounts].

3 Click [Click the key to change] at the 
bottom left of the screen and enter the 
administrator's password. Then, click 
[OK].

4 Click [+].

5 enter the value of C-2 in [Name].

6 Enter the value in C-3 in both 
[Password] and [Verify].
For Mac OS X 10.3.9, proceed to the step 8.

7 Click [Create Account].
Memo

 After the dialog box for auto login, disable the auto 
login.

8 Check that an account is added to 
[Other Accounts] with the name of C-2, 
and close [Accounts].

9 Create a new folder on the computer 
with the name entered in C-5.

10 From the Apple menu, select [System 
Preferences].

11 Click [Share].

12 Check the checkbox of [Windows 
Sharing].

For Mac OS X 10.3.9, proceed to the step 17.

13 Click [Enable Accounts...].

14 Check the checkbox of the account 
created in the step 7.

15 Enter the value in C-3 in [Password] 
and click [OK].

16 Click [Done].

17 Close [Share].
Proceed to "Creating a Profile for Scan To Network 
PC".

Creating a Profile for Scan To 
Network PC

Register the information on the Information form 
on the computer as a profile. It is necessary to 
specify the profile to send data when you 
perform Scan To Network PC with the computer.

1 Press the  the <SETTING> key on the 
operator panel.
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2 Press the  to select [Profile] and then 

press .

3 Press the  to select the profile number 
you want to register and then press .

4 Press the  to select [Register] and 
then press .

5 Press to select [Profile Name] and then 
press the .

6 Enter the information in C-4.

7 Select [Enter] and then press .

8 Press the  to select [Target URL] and 
then press .

9 Enter the value of C-1 and C-5 as "\\C- 
1\C-5".

Note

 If there is no DNS server on the network, you cannot 
specify the computer by using the computer name 
(C-1). In such a case, you can configure the settings 
by using the computer's IP address.

Memo

 In order to enter the "\" sign while using a QWERTY 
keyboard, press <\> while holding down <CTRL>.

10 Select [Enter] and then press .

11 Press the  to select [User Name] and 
then press .

12 Enter the information in C-2.

Note

 If domain management is done, enter "C-2@domain 
name".

 When carrying out domain management, if you cannot 
connect even after entering "C-2@Domainname", 
delete "@Domainname". 
Access the machine's website again, and set the 
NetBIOS domain name in [Workgroup name] within 
[Admin Setup] > [Network Menu] > [NBT/
NetBEUI].
*For the domain name, please check with the network 
manager.

13 Select [Enter] and then press .

14 Press the  to select [Password] and 
then press .

15 Enter the value of C-3.

16 Select [Enter] and then press .

17 Press the  to select [File Name] and 
then press .

18 Enter the information in C-6.
- By adding "#n" to the end of the file name, a 

serial number is automatically assigned to the end 
of the name of sent files.

- By adding "#d" to the end of the file name, a date 
is automatically assigned to the end of the name 
of sent files.

19 Select [Enter] and then press .

20 Configure other items if necessary.

21 Press  to register the settings.

The setup for Scan To Network PC is complete.

Reference

 For details how to use Scan To Network PC, refer to "Scan 
to Network PC" P. 100.

Managing Profiles
To perform the Scan To Network PC, Auto Deliver 
or Transmission Data Save function (for 
MC561dn Only), a profile for each destination 
must be created. You can register up to 50 
profiles.

Reference

 Refer to "Creating a Profile for Scan To Network PC" P. 56

Modifying a Profile

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Profile] and then 
press .

3 Press the  to select the profile you 
want to modify and then press .

4 Press the  to select [Edit] and then 
press .

Example: \\PC1\SalesDev

Example: \\192.168.0.3\SalesDev

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK



Configuring the Network Settings

- 58 -

5 Press the  to select the item you want 

to modify and then press .

6 Modify the item.

7 Select [Enter] and then press .

8 If you want to modify more than one 
item, repeat steps 5 and 7.

9 Press  to register the settings.

Deleting a Profile

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Profile] and then 
press .

3 Press the  to select the profile you 

want to delete and then press .

4 Press the  to select [Delete] and then 

press .

5 Press the  or  to select [Yes] on the 
confirmation message and then press .

OK

OK

OK

OK

OK

OK

OK
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Basic Settings for Faxing
This section explains basic settings for faxing. Be sure to configure the following settings before you 
transmit faxes.

Connecting a Telephone Line 
Depending on your environment, a method to 
connect a telephone line is different. Based on 
the following figures, connect the line for your 
environment.

Note

 You can not connect to the ISDN line directly. To connect to 
it, use the terminal adopter (TA) and connect to the LINE 
connection of the machine.

Connecting to the public line
(Connecting for Fax Only)

1 Plug one end of the supplied telephone 
cable (1) into the LINE connection (2) of 
your machine and the other end into a 
public line (analog).

Connecting to the public line
(Connecting for Fax and Telephone)

1 Plug one end of the supplied telephone 
cable (1) into the LINE connection (2) of 
your machine and the other end into a 
public line (analog).

2 Remove the telephone connector cover.

3 Plug the external telephone's cable into 
the TEL connection (3) of your machine.

2

1

Public Line 

(Analog)

2

1

Public Line 

(Analog)

3
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Other cases

Connecting to the ADSL environ-
ment

Plug the supplied telephone cable (1) connected 
to the ADSL modem into the LINE connection (2) 
of your machine.

Remove the telephone connector cover.

Plug the external telephone's cable into the TEL 
connection (3) of your machine.

Connecting to IP telephone
Plug the supplied telephone cable (1) connected 
to the IP telephone into the LINE connection (2) 
of your machine.

Remove the telephone connector cover.

Plug the external telephone's cable into the TEL 
connection (3) of your machine.

Connecting CS tuner or Digital 
television

Plug the supplied telephone cable (1) connected 
to the public line (analog) into the LINE 
connection (2) of your machine.

Remove the telephone connector cover.

Plug the telephone cable connected to the CS 
tuner or digital television into the TEL connection 
(3) of your machine.

Connecting PBX, home telephone 
or business phone

Plug the supplied telephone cable (1) connected 
to the public line (analog) into the LINE 
connection (2) of your machine.

Remove the telephone connector cover.

Plug the telephone cable connected to a control 
device including PBX, etc. into the TEL 
connection (3) of your machine.

ADSL modem

Splitter

2
3

1

Public Line 

(Analog)

2
3

Optical IP telephone 
Corresponding telephone

1

*Insert into the telephone 
  cable jack.

LAN 
cable Optical cable

Optical Network 
Unit (ONU)

1

2 3

Public Line 

(Analog)

CS tuner or digital 

television

2 3

1

Control device 
including PBX, 
etc.

Public Line 
(Analog)
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Connecting as a internal telephone
Plug the telephone cable (1) connected to a 
control device including PBX, etc. into the LINE 
connection (2) of your machine.

Setup of Date/Time
Setup of Date/Time of your region.

Reference

 You can set up date and time automatically using 
Webpage. For details, refer to the User's Manual 
Advanced.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  select [Easy Setup] and 
then press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [Date/Time 
Setting] and then press the .

6 Press the  to select the appropriate 

time zone and then press .

7 Press the  to select [Manual] and then 
press .

8 Press the  or  to select the current 

date and then press .
To move to the next box, press the .

9 Press the  or  to select the current 
time and then press .
To move to the next box, press the .

10 When the setup menu screen is 

displayed, press  to complete the 
setup.

Specifying Sender Information
Specify the fax number and sender name for 
your machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Easy Setup] and 

press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [Fax Setting] and 
then press the .

Public Line 
(Analog)

1

2
4

3
Control device 
including PBX, 
etc.

OK

OK

OK

OK

OK

OK

OK

OK

OK
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6 Press  to select the [Fax Number] 
entry box.

7 Enter the fax number of your machine 
with the numerical keypad.

8 Select [Enter] and then press .

9 Press  to select the [Sender ID] entry 
box.

10 Enter arbitrary sender information.
Up to 22 characters can be entered.

Memo

 When a receiver prints faxes, sender information 
entered here is printed on the top of the faxes.

11 Select [Enter] and then press .

12 When the setup menu screen is 

displayed, press  to complete the 
setup.

Settings for each dialing type
The factory default [Dial Type] is set to [Push].

 For push-button phones, if you hear a "Beep, boop, 
beep" sound, leave [Dial Type] as [Push].

 For push-button type phones, if you do not hear a 
"Beep, boop, beep" sound, or if you are using a 
rotating-dial type phone, set [Dial Type] to [Dial 
20].If the telephone does not ring, change [Dial 
Type] to [Dial 10].

How to Configure Settings

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 

and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [User Install], 
and press .

6 Press , select [MF (Tone)/DP 

(Pulse)], and then press .

7 Press , select Dial Type, and then 
press .

8 Press the  until the top screen is 
displayed.

OK

OK

OK

OK

OK

OK

OK

OK
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 Loading Paper and Documents
This section explains the specifications for paper and document, and how to load them.

Paper

Supported Paper Types

For high-quality printing and to avoid printing problems, be sure to use the supported paper types. 
Please use digital photo print paper.

Please check the print quality and the movement of the paper sufficiently beforehand to make sure that 
there are no problems. Your machine supports the following types of paper.

Paper Type Paper Size mm (inch) Paper Weight

Standard paper A4 210 x 297 64 to 220 g/m2

For duplex print, 64 to 176 g/m2

Note

 If the paper size is set at A6, A5, or with a 
paper width narrower than 148 mm (A5 
width), the printing will be slower.

A5 148 x 210

A6 105 x 148

B5 182 x 257

Letter 215.9 x 279.4
(8.5 x 11)

Legal (13 inch) 215.9 x 330.2
(8.5 x 13)

Legal (13.5 inch) 215.9 x 342.9
(8.5 x 13.5)

Legal (14 inch) 215.9 x 355.6
(8.5 x 14)

Executive 184.2 x 266.7
(7.25 x 10.5)

16K
(184 x 260 mm)

184 x 260

16K
(195 x 270 mm)

195 x 270

16K
(197 x 273 mm)

197 x 273

Custom Width:
64~216
Length:
148~1321

64 to 220 g/m2
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Envelope Monarch 98.4 x 190.5
(3.875 x 7.5)

Envelopes should be 24lb paper, and flap 
parts of envelopes should be folded

Com-9 98.4 x 225.4
(3.875 x 8.875)

Com-10 104.8 x 241.3
(4.125 x 9.5)

DL 110 x 220
(4.33 x 8.66)

C5 162 x 229
(6.4 x 9)

Index card Index card 76.2 x 127.0
(3 x 5)

Label A4 210 x 297 0.1~0.2 mm

Letter 215.9 x 279.4
(8.5 x 11)

Partly-printing 
paper

Subject to the standard paper 64 to 220 g/m2

Color paper Subject to the standard paper 64 to 220 g/m2

Paper Type Paper Size mm (inch) Paper Weight
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Unsupported Paper Types

Avoid using the following types of paper. Using 
these types of paper may cause paper jams or 
malfunctions.

 Paper with a rough surface, such as pulp paper or 
fibrous paper or paper with too smooth a surface

 Paper that is too thick or thin

 Paper with a lot of paper particles

 Horizontal fiber orientation paper (paper which has 
vertical fiber orientation to the long edge of the 
paper)

 Damp or wet paper

 Paper with static electricity

 Mat, embossed, or coated paper

 Chemically treated or adhesive paper

 Paper that has no heat resistance (230°C)

 Paper with perforations, holes for a binder or incised 
paper

 Paper having asperity, squish and burr on the cut 
edge

 Paper which is not a square shape or a right angle of 
the cutting angle

 Paper with shortcomings such as creasing, warping, 
folds of the corner, waving, folds and tears

 Paper sticking accessories such as staples, clips, 
ribbons, tapes and catches

 Specially-treated papers such as carbon paper, non-
carbon paper, thermal paper and impact paper

 Paper for thermoelectric printer or ink jet, wet PPC 
paper, copy paper and Japanese paper.

 Items with stamps affixed. 

 Envelopes that are too thick, made of plastic, 
doubled or water-repellent

 Envelopes with a button, snap, or window

 Envelopes with an adhesive flap

Storing Paper

Store paper in the following conditions to 
maintain quality:

 Inside a cabinet or other dry and dark place

 On a flat surface

 Temperature: 20°C

 Humidity: 50% RH (relative humidity)

Avoid placing:

 Directly on the floor

 In the direct sunlight

 Near the inside of an exterior wall

 On an uneven surface

 Where static electricity may be generated

 Where temperature rapidly changes

 Near a printer, air conditioner, heater, or duct

Note

 Do not unwrap the paper until you use it.

 Do not leave paper unwrapped for a long time. Doing so 
may lower the print quality.
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Loading Paper

Your machine has two built-in trays (tray 1 and the MP tray) and an optional tray (tray 2).Refer to the 
list below to check the supported paper and capacities of each tray.

Note

 Duplex printing can not be performed on paper indicated by an "*".

Tray Supported paper 
size Paper capacity Paper weight

Tray1 A4
A5
B5
A6*
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom

250 sheets
(when paper weight is 80 
g/m2)

 Light
(64 to 74 g/m2)

Medium Light
(75 to 82 g/m2)

Medium
(83 to 104 g/m2)

Heavy
(105 to 120 g/m2)

Ultra Heavy1
(121 to 176 g/m2)

Tray2 
(optional)

A4
A5
B5
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom

530 sheets
(when paper weight is 80 
g/m2)

 Light
(64 to 74 g/m2)

Medium Light
(75 to 82 g/m2)

Medium
(83 to 104 g/m2)

Heavy
(105 to 120 g/m2)

Ultra Heavy1
(121 to 176 g/m2)
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 Loading Paper in Tray 1 and Tray 2
The following procedure explains how to load 
paper in tray 1 or tray 2 (optional).

Memo

 The following procedure uses tray 1 as an example but the 
same is applied to tray 2.

1 Pull out the paper tray.

2 Slide the paper guide (1) to the width of 
paper to be loaded.

3 Slide the paper stopper (2) to the length 
of paper to be loaded.

MP Tray A4
A5
B5
A6*
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom
Com-9 Envelope*
Com-10 Envelope*
Monarch Envelope*
DL Envelope*
C5 Envelope*
 Envelope 4 (A4)*
 Index Card*

 100 sheets
(when paper weight is 80 
g/m2)

 10 envelopes

 Light
(64 to 74 g/m2)

Medium Light
(75 to 82 g/m2)

Medium
(83 to 104 g/m2)

Heavy
(105 to 120 g/m2)

Ultra Heavy1
(121 to 176 g/m2)

Ultra Heavy2
(172 to 220 g/m2)

Tray Supported paper 
size Paper capacity Paper weight

1

2
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4 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.

5 Load paper with the print side face down.

Note

 Do not load paper above the fill line (3).

6 Push the paper tray until it stops.
Register the loaded paper on your machine. 
Proceed to "Configuring the Tray Settings" P. 69.

 Loading Paper on the MP Tray
The following procedure explains how to load 
paper on the MP tray.

1 Open the MP tray.

2 Pull out the paper support.

3 Pull out the sub support.

4 Adjust the manual feeding paper guide to 
the width of paper to be loaded.

3
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5 Insert the paper with the print side face 

up until its edge touches the paper feed 
entrance.

Note

 Do not load paper above the fill line (1).

6 Press the Set button (2).

Register the loaded paper on your machine. 
Proceed to "Configuring the Tray Settings".

Note

 Do not load paper of different sizes, types or weights at 
the same time.

 When adding paper, remove the paper on the MP tray and 
straighten the edges of both stacks of paper, and then load 
them again.

 Do not put anything other than paper for printing. 

Memo

 When loading envelopes on the MP tray, load them face up 
with the orientation as stated below.

- You envelopes (Monarch, Com-9, Com-10, DL and C5) 
are loaded with the flap folded and the flap should come 
to the right side to the feeding direction.

Configuring the Tray Settings
After you load paper in tray 1, tray 2 (optional), 
or the MP tray, you need to register the loaded 
paper on your machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Paper Setup] and 

then press .

3 Press the  to select the paper tray in 
which you loaded paper and then 
press .

4 Press the  to select [Paper Size] and 

then press .

5 Press the  to select the size of the 

loaded paper and then press .
Reference

 If [Custom] is selected for [Paper Size], you need to 
register the custom size. For how to register the 
custom size, refer to "Registering Custom Sizes" P. 70.

6 Press the  to select [Media Type] and 

then press .

7 Press the  to select the type of media 
loaded and then press .

8 Press the  to select [Media Weight] 

and then press .

9 Press the  to select the weight of the 
loaded paper and then press .

10 Press the  until the top screen is 
displayed.

1

2

OK

OK

OK

OK

OK

OK

OK

OK
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Registering Custom Sizes
To load custom size paper, you need to register 
the width and length of the paper before printing. 
The range of the sizes you can set differs 
according to the paper tray.

Note

 For tray 1 and tray 2, you can configure the [Custom] 
setting only when [Paper Size] is set to [Custom].

 The available size range for duplex printing is the same as 
that for tray 2.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Paper Setup] and 
press .

3 Press the  to select the paper tray in 
which you loaded paper and then 
press .

4 Press the  to select [Custom] and then 
press .

5 Enter the desired value using the ten-key 
pad and then press .
Press the  or  to move to the next box.

6 Press the  until the top screen is 
displayed.

Paper Output

Your machine outputs to the facedown or faceup 
stacker. Paper types that can be outputted to 
each stacker are as follows.

When performing duplex printing, paper outputs 
to the facedown stacker.

Note

 Do not open or close the faceup stacker while printing as it 
may result in a paper jam.

Using the Facedown Stacker
Delivers paper with the print side face down.

Note

 Check that the faceup stacker on the rear side of the 
machine is closed. If the faceup stacker is open, paper is 
always outputted to the faceup stacker.

Tray Available size range

Tray1 Width:
100 to 216 mm (3.9 to 8.5 inches)
Length:
148 to 356 mm (5.8 to 14.0 inches)

Tray2 
(Optional)

Width:
148 to 216 mm (5.8 to 8.5 inches)
Length:
210 to 356 mm (8.3 to 14.0 inches)

MP tray Width:
64 to 216 mm (2.5 to 8.5 inches)
Length:
127 to 1321 mm (5.0 to 52.0 inches)

OK

OK

OK

OK

Output 
Stacker

Supported 
paper type

Paper output 
capacity

Facedown Standard
Recycled 

paper

150 sheets (when 
paper weight is less 
than 80 g/m2)

Faceup Standard
Recycled 

paper
Envelope
 Index card
 Label

100 sheets (when 
paper weight is less 
than 80 g/m2)

10 sheets (Ultra Heavy 
paper and envelopes) 
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Using the Faceup Stacker
Delivers paper with the print side face up.

Note

 The faceup stacker is not available in duplex printing.

1 Pull the faceup stacker on the rear side 
of the machine and open it toward you.

2 Unfold the faceup stacker.

3 Open the paper support.

Documents
You can use the auto document feeder (ADF) or 
the document glass to load documents for 
copying, scanning or faxing.

Document Requirements

You cannot load the following documents on the 
ADF. Use the document glass instead:

 Torn or perforated paper

 Curled or rolled paper

 Wet paper

 Static paper

 Carbon-backed paper

 Fabrics, metallic sheets or Transparency films

 Paper with staples, paper clips, ribbons, or tape

 Pasted paper, paper with glue

 Glossy paper

 Specially coated paper

Keep the followings in mind to avoid damaging 
the document glass:

 Do not hold a document firmly on the glass when 
copying a thick document.

 Place hard documents gently.

 Avoid loading documents with sharp projections.

Scannable Area

The text or images on the shaded area shown 
below are not scanned.

Memo

 The arrow in the above drawing indicates the feeding 
direction in the auto document feeder, or the scanning 
start side on the document glass.

2 mm

2 mm

2 mm

2 mm
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Loading Documents

Note

 For documents using adhesives, ink, or correction fluid, set 
them after checking that these have completely dried.

 Loading Documents on the ADF

1 Load your documents face up on the 
ADF.
If your documents are portrait, load them with the 
top edge of the documents in first.

If your documents are landscape, load them with 
the left edge of the documents in first.

2 Adjust the document guides to the width 
of your documents.

 Loading Documents on the Docu-
ment Glass

1 Lift and open the document glass cover.

2 Place a document face down on the 
document glass.
If your document is portrait, align its top edge to 
the upper-left corner of the glass.

If your document is landscape, align its right edge 
to the upper-left corner of the glass.

3 Close the document glass cover gently.
Reference

 [Document Direction] setting according to the direction 
of your document to get the output you want. The factory 
default is [Portrait]. Refer to "Changing Image 
Orientation of Document (Direction)" P. 76.

Scanner 
type

Scannable 
size

Paper 
capacity

Paper 
weight

ADF A4
A5
B5
A6
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive

50 sheets
(80 g/m2)

60 to 105 
g/m2

Document 
glass

A4
A5
B5
A6
 Letter
 Executive

- 20 mm
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Printing Configuration
This section explains how to print the Configuration on which you can check the detailed information of 
your machine, such as the settings and status of your machine.

Printing Procedure

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Reports] and 
press .

3 Press the  to select [Configuration] 

and press .

4 On the confirmation message, press the 

 or  to select [Yes] and press .
Reference

 You can also print reports and lists for each function. Refer 
to the User's Manual Advanced.

OK

OK

OK
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2. Copying
This chapter explains the basic operation and settings for your machine's copy function.

Basic Operation
This section explains how to start and cancel copy job.

Starting a Copy Job

1 Press the <COPY> key on the operator 
panel to open the copy standby screen.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Configure the copy settings if necessary.

4 Enter the number of copies using the 
ten-key pad.

- You can enter up 1 to 99 sets.

- If you have entered an incorrect value, press the 
<CLEAR> key and then enter the correct value.

5 Press  or  to start copying.

Memo

 By factory default, the documents are copied with the 
following settings.

Reference

 For details on how to configure each copy setting, refer to 
"Configuring Copy Settings" P. 75.

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 72.

Canceling a Copy Job in 
Progress

You can cancel copying until the message 
showing the copy completion is displayed.

1 Press the <STOP> key on the operator 
panel.

[Scan Size]: A4 [Paper Feed]: Auto

[Direction]: Portrait [Zoom]: 100%

[Density]: 0 [Document Type]: 
Text&Photo

MONO COLOR
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Configuring Copy Settings
You can change the copy settings to alter the output to suit your needs. Each setting can be configured 
from the [Change Settings] menu on the copy standby screen.

Perform the following procedures at step 3 of "Starting a Copy Job" P. 74 described above.

Reference

 The changes made in the [Change Settings] menu on the copy standby screen are temporary. You can change the default 
settings by configuring [Admin Setup] from the <SETTING> key. For details, refer to the User's Manual Advanced.

Changing the Scan Size (Scan Size)
You can select the appropriate size of the 
document to be scanned.

1 Press the  to enter the [Change 
Settings] menu.

2 Make sure that [Scan Size] is selected 
and then press .

3 Press the  to select a scan size and 
then press .

4 Press the  until the start screen is 
displayed.

Changing the Paper Tray 
(Paper Feed)

You can select the size of the document to be 
copied.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Paper Feed] and 
then press .

3 Press the  to select a tray and then 

press .

4 Press the  until the start screen is 
displayed.

Memo

 [Tray 2] is displayed only when the optional second tray 
unit is installed.

 When set to [Auto], the MP tray is not selected in the 
default setting. To use the MP tray, press the <SETTING> 
key and select [Paper Setup] > [Select Tray] > [Copy] > 
[MP tray], and then select [ON] or [ON (Prior)].

 When set to [Auto], the paper tray that holds paper other 
than A4, B5, A5, A6, letter, legal 13/13.5/14, or executive 
is not selected. To use a different paper size, select the 
desired paper tray in the [Paper Feed Tray] setting.

Copying Using the MP Tray
If you have selected [MP Tray], you can copy 
your documents onto the paper loaded on the MP 
tray.

1 Place your document with text face up in 
the ADF or face down on the document 
glass.

2 Load the paper on the MP tray.

3 Press  or .

4 When the pop-up message is displayed, 
press the  or  to select [Start] and 
then press .

Reference

 For details on how to load the paper on the MP tray, refer 
to "Loading Paper on the MP Tray" P. 68.

Settable Values:

A4*    A5    A6    B5    Letter    Legal 13  
Legal 13.5    Legal 14    Executive

*indicates the factory default.

Settable Values:

Auto*    Tray 1    Tray 2    MP Tray
*indicates the factory default.

OK

OK

OK

OK

MONO COLOR

OK
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Changing Image Orientation 
of Document (Direction)

You can select [Portrait] or [Landscape] for the 
document's orientation. Specify an appropriate 
orientation to get the copy result you want.

Reference

 For details on how to load documents in each orientation, 
refer to "Loading Documents" P. 72.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Direction] and 

then press .

3 Press the  to select the orientation of a 
document and then press .

4 Press the  until the start screen is 
displayed.

Making Enlarged or Reduced 
Copies (Zoom)

You can make enlarged or reduced copies by 
setting [Zoom]. You can set the zoom ratio in 
the following three ways:

 Using [Auto]

 Selecting a preset zoom ratio

 Setting the zoom ratio using the ten-key pad

Using [Auto]

By selecting [Auto], the zoom ratio is 
automatically determined according to the 
selected scan size and paper tray.

Note

 You can use [Auto] only when copying on A4, A5, A6, B5 
letter, legal 13/13.5/14, and executive paper.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select [Auto] and then 

press .

4 Press the  until the start screen is 
displayed.

Memo

 Setting the [Paper Tray] to [Automatic] will 
automatically set [Enlarge/Reduce] to [100%]. When 
selecting another scaling factor, initially set [Paper Tray], 
and then set [Enlarge/Reduce].

Selecting a Preset Zoom Ratio

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select the desired value 
and then press .

Memo

 By selecting [Fit to page(98%)], if the sizes of the 
document and the paper are the same, the document 
is reduced to fit onto the paper.

4 Press the  until the start screen is 
displayed.

Note

 When [Paper Feed] is set to [Auto], some values cannot 
be selected. The selectable values differ according to the 
selected scan size.

 With some ratios, parts of the document's image may be 
missing or margins may appear on the copied outputs.

Memo

 When [Paper Feed] is set to [Auto], the paper tray is 
automatically selected according to the selected zoom 
ratio. If you want to use a specific paper tray, reconfigure 
the [Paper Feed] setting.

 A paper tray that holds paper other than A4, B5, A5, A6, 
letter, legal 13/13.5/14, or executive is not selected even if 
[Paper Feed] is set to [Auto]. To select the desired paper 
tray, reconfigure the [Paper Feed] setting.

Setting the Zoom Ratio Using the 
ten-key pad

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select [Zoom 
(25~400%)] and then press .

Settable Values:

Portrait*    Landscape
*indicates the factory default.

OK

OK

OK

OK

Values:

100%* A4->A5(70%)             
Leg14->Let(78%) Leg13.5->Let(81%)    
Leg13->Let(84%) A4->B5(86%)           
A4->Let(94%) Let->A4(97%)           
Fit to page(98%) B5->A4(115%)     
A5->A4(141%)

*indicates the factory default.

OK

OK

OK

OK
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4 Enter the zoom ratio from 25 to 400% 
using the ten-key pad and then press .

- You can set the ratio in 1% increments.

- If you have entered an incorrect value, press the 
<CLEAR> key and then enter the correct value.

5 Press the  until the start screen is 
displayed.

Enabling Continuous Scan Mode 
(Continuous Scan)

If you want to copy multiple sets of documents 
as a single copy job, enable the continuous scan 
mode. It is useful when using [Sort], [N-in-1], 
or [Duplex Copy] functions.

Memo

 Continuous Read Mode is also available for faxes, internet 
faxes, as well as for scan functions. You can configure 
faxes from [Applied Settings], and internet faxes and 
scans from [Reading Settings].

Reference

 For details on the [DuplexCopy] functions, refer to 
"Making Duplex Copies (Duplex Copy)".

 For details on the [Sort] and [N-in-1] functions, refer to 
the User's Manual Advanced.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Continue Scan] 

and then press .

3 Press the  to select [ON] and then 
press .

4 Press the  until the start screen is 
displayed.

Copying With Continuous Scan 
Mode

With the continuous scan mode, you can copy 
your documents from the ADF or document 
glass, or both of them.

1 Place the first document with text face 
up in the ADF or face down on the 
document glass.

2 Configure the copy settings if necessary.
Change other copy settings as required.

3 Enter the number of copies with the ten-
key pad.

4 Press  or  to start scanning 
the first document.

5 When the [Please set next document] 
screen is displayed, place the next 
document in the ADF or on the document 
glass.

Note

 When changing the place to load the next document, 
be sure to remove the document from the place you 
used first.

6 Press the  to select [Start Scan] and 
then press .

7 When all sets of the documents are 
scanned, press the  to select [Scan 
Complate] and then press .

Memo

 When making N-in-1 and/or duplex copies using the 
document glass, the [Please set next document] screen 
is displayed after scanning the documents even if 
[Continue Scan] is set to [OFF].

 For fax, internet fax and scan functions, please follow 
procedures 5-7 after the first page of the document has 
started to be read.

Making Duplex Copies (Duplex 
Copy)

You can copy 1-sided (simplex) and 2-sided 
(duplex) documents on to one side (simplex) or 
both sides (duplex) of a sheet of paper. You can 
also select the binding position from either long-
edge or short-edge binding.

Specify the appropriate orientation of the 
document in [Direction] beforehand to get the 
copy result you want.

Note

 Use standard size plain paper for duplex copies. Using 
non-standard paper may cause a paper jam in the duplex 
unit of your machine.

Reference

 For details on the available paper for your machine, refer 
to "Loading Paper" P. 66.

 For details on how to configure the [Direction] setting, 
refer to "Changing Image Orientation of Document 
(Direction)" P. 76.

 Long-Edge Binding
Copies your document to be bound along the 
long edge of the paper.

OK

OK

OK

MONO COLOR

OK

OK
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Short-Edge Binding
Copies your document to be bound along the 
short edge of the paper.

Reference

 To set margins for binding, refer to the User's Manual 
Advanced.

Enabling Duplex Copies

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Duplex Copy] 
and then press .

3 Press the  to select the desired value 
and then press .

4 Press the  until the start screen is 
displayed.

Note

 You can copy "duplex to duplex" or "duplex to simplex" 
copies only when scanning the documents from the ADF.

Memo

 When making duplex copies using the document glass, the 
continuous scan mode is automatically enabled. Follow the 
on-screen instructions.

Adjusting Copy Density 
(Density)

You can adjust the copy density from 7 levels.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 
and then press .

3 Check that [Density] is selected and 
then press .

4 Press the  or  to select the desired 
density and then press .

Memo

 [0] is the standard value. To darken the document 
image, select [+1], [+2] or [+3] (most dense). 
Conversely, to lighten the document image, select 
[-1], [-2] or [-3] (least dense).

5 Press the  until the start screen is 
displayed.

Changing Document Type 
(Document Type)

You can select the document type to make copies 
at the most suitable quality for your needs.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 
and then press .

3 Press the  to select [Document Type] 
and then press .

4 Press the  to select a document type 
and then press .

Memo

 [Text]: Set when copying a text document.

 [Text&Photo]: Set when copying a document having 
texts and photos.
Images are reproduced with a balance between texts 
and photos.

 [Photo]: Set when copying photos and graphic 
documents.
This reproduces grayscale for images in which it is 
important.

 [Photo (Glossy)]: Set when copying photo 
documents printed on a glossy sliver halide 
photography or glossy inkjet paper.
Images are reproduced by focusing on the gray level 
in consideration of the glossy.

5 Press the  until the start screen is 
displayed.

Note

 When selecting [Text], the gray level may be reduced on 
some document.

 When selecting [Photo], [Photo (Glossy)], fine texts or 
lines may be blurred on some documents.

 When selecting [Photo(Glossy)], images may be bright.

Settable Values for Printing Method:

OFF (Simplex)*
Simplex document  Duplex  LE
Simplex document  Duplex  SE
Duplex documentDuplex printing
Duplex  LESimplex printing
Duplex  SESimplex printing

*indicates the factory default.

OK

OK

OK

OK

Settable Density Values:

+3    +2    +1    0*    -1    -2    -3
*indicates the factory default.

Settable Types:

Text   Text&Photo*   Photo   Photo (Glossy)
*indicates the factory default.

OK

OK

OK

OK
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Adjusting the Background 
Removal

You can turn off the background erasing for 
documents or adjust the copy density from 6 
levels.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 

and then press .

3 Check that [Background Removal] is 

selected and then press .

4 Press the  or  to select the desired 

value and then press .

Memo

 [3] is the standard value. To darken the background 
(base) for the document, select [4], [5] or [6]. 
Conversely, to lighten, select [2], [1] or [OFF] (not 
removal).

5 Press the  until the start screen is 
displayed.

Note

 When darkening the setting of the background removal 
fine lines, texts or light color may not be reproduced on 
some documents.

Changing Scan Resolution 
(Resolution For Color)

You can change the scan resolution of a 
document.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 

and then press .

3 Check that [Resolution For Color] is 

selected and then press .

4 Press the  or  to select the desired 

value and then press .

Memo

 [Normal] is the standard value. By selecting [Extra 
fine], the reproduction and gray level of fine lines or 
texts can be improved.

5 Press the  until the start screen is 
displayed.

Note

 In the monochrome copy, the scan resolution is fixed to 
[Extra fine].

Resetting Copy Settings

Auto Reset

All settings you configured for your copy job 
return to their default values if no operation is 
made for a set period of time. The auto reset 
time is set to 3 minutes as the factory default 
setting.

Reference

 You can change the auto reset time by configuring [Admin 
Setup] from the <SETTING> key. For details, refer to the 
User's Manual Advanced.

Using the <RESET/LOG OUT> key

By pressing the <RESET/LOG OUT> key, the 
settings you configured for your copy job return 
to their default values.

After copying, press the <RESET/LOG OUT> 
key to reset the default settings for the next 
user.

Settable Values:

OFF    1    2    3*    4    5    6
*indicates the factory default.

OK

OK

OK

OK

OK

Settable Resolution:

Normal*    Extra fine
*indicates the factory default.

OK
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3. Faxing and Internet Faxing
This chapter explains basic settings and operations for faxing and internet faxing and operations on 
managing the phone book.

Basic Procedure for Faxing
This section explains basic operations for transmitting faxes. You need to configure the initial settings 
before using the fax function.

Memo

 You can load only A4, letter, or legal size documents in the ADF, and A4 or letter size documents on the document glass.

 You cannot load mixed size documents for faxing.

Reference

 For details on initial settings for the fax function, refer to "Basic Settings for Faxing" P. 59.

Sending a Fax

Memo

 The machine puts priority on the ADF when scanning 
documents. Be sure not to place documents on the ADF 
when you use the document glass.

1 Press the <FAX> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Make sure that [Fax] is selected and 

press  to open the fax start screen.

4 Check that [Add Destination] is 
selected on the start screen and then 
press .

5 Specify a destination.
You can specify a destination from the ten-key pad, the 
speed dial list, the group list, the transmission histories, 
the reception histories, or the one-touch key pad.

Reference

 For details on each procedure, refer to "Specifying a 
Destination" P. 81.

6 Configure the advanced functions if 
necessary.

Reference

 "Configuring Fax Settings" P. 83

7 Press  to start transmission.
When you want to scan multiple documents as a 
single fax job using the document glass, enable 
the continuous scan mode. 

Reference

 For details on the continuous scan mode, refer to 
"Enabling Continuous Scan Mode (Continuous Scan)" 
P. 77.

Note

 You cannot use the  button.

Memo

 By factory default, the documents are scanned with the 
following settings.

Reference

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 72.

 When you want to specify multiple destinations, refer to 
the User's Manual Advanced.

OK

OK

[Scan Size] : A4 [Resolution] : Normal

[Density] : 0

MONO

COLOR
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Specifying a Destination
You can specify a destination in the following six 
ways:

 Using the ten-key pad

 Using a speed dial

 Using a group

 Using the transmission histories

 Using the reception histories

 Using the one-touch key pad

Perform the following procedures at step 5 of 
"Sending a Fax" P. 80 described above.

Direct Input

You can enter a destination fax number directly 
by using the ten-key pad. You can enter up to 40 
digits.

1 Press the  to select [Direct Input] and 
then press .

2 Enter a destination fax number using the 
ten-key pad on the operator panel.

3 Select [Enter] and then press .

Memo

 You can use the ten-key pad to enter a destination also on 
the screen that is displayed after pressing the <FAX> key. 
In this case, the fax start screen appears after entering a 
destination.

Dialing Functions
You can use the following functions when 
entering a destination fax number. 
Select the function you want and then press on 
the fax number entry screen.

 -(Hyphen)

Inserts a hyphen to the entered fax number.

 PreFix

Inserts a prefix number registered in advance. 
"N" is inserted when entering.

 Flash

Notifies you when an internal exchange switches 
over to a public line. When inputting, enter "F".

Enter "Pause" and "#" by pressing <#> on the 
ten-key pad. When you press <#>, you toggle 
between "P" and "#".

 Pause

Pauses two seconds when dialing. You can use 
multiple pauses. "P" is inserted when entering.

 # (Hash symbol)

When the tone dial is set, "#" sends through a 
circuit. When inputting, enter "#".

Enter "Tone" and "*" by pressing <*> on the 
ten-key pad. When you press <*>, you toggle 
between "T" and "*".

 Tone

Switches to tone dialing if pulse dialing is set. "T" 
is inserted when entering.

 * (Asterisk)

When the tone dial is set, "*" sends through a 
circuit. When inputting, enter "*".

Reference

 For details on prefix numbers, refer to the User's Manual 
Advanced.

Using Speed Dial List and Group List

You can select a destination from numbers 
registered in the speed dial list or the group list. 
You must register them in advance.

Reference

 For details on how to register numbers to Speed Dial List 
and Group List, refer to "Phone Book" P. 88.

1 Press the  to select [Speed Dial List] 
or [Group List] and then press .

2 Press the  to select a destination or 

group and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

OK

OK

OK

OK

OK
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Using Transmission and Reception 
History

You can select a destination from the 50 most 
recent transmissions or receptions.

1 Press the  to select [Tx History] or 
[Rx History] and then press .

2 Press the  to select an entry and then 
press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 

then press .

Using One-Touch Key Pad

The one-touch key pad can hold fax numbers 
registered in Speed Dial List.

The speed dials no.1 to 16 are automatically 
registered to the one-touch key pad.

1 Press the desired one-touch key on the 
start screen.

Press the <SHIFT> key to select the speed dials 
no.9 to 16 assigned to the one-touch key pad.

Memo

 You can use the one-touch key pad also on the screen that 
is displayed after pressing the <FAX> key. In this case, 
the fax standby screen appears after pressing a one-touch 
key so that you can configure other advanced settings for 
fax functions.

Deleting Specified Destinations

1 Select the specified destination on the 
fax start screen by pressing  and then 
press .

2 Press the  to select a destination you 

want to delete and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations to be deleted, press .

4 Make sure that [Delete The Address] is 

selected and then press .
- If all recipients have been deleted, you will be 

taken back automatically to the start screen.

- If not all recipients have been deleted, press  to 
go back to the start screen.

OK

OK

OK

OK

OK

OK
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Configuring Fax Settings
You can configure the fax settings to alter the output to suit your needs. Each setting can be configured 
from the [Fax Functions] menu on the fax start screen.

Perform the following procedures at step 6 of "Sending a Fax" P. 80 described above.

Changing Scan Size (Scan Size)
You can select the appropriate scan size for your 
document.

1 Press the  to select [Fax Functions] 
on the fax start screen and then press 

.

2 Make sure that [Scan Size] is selected 
and then press .

3 Press the  to select a size and then 
press .

4 Press the  until the fax standby screen 
appears.

Changing Resolution 
(Resolution)

You can select an appropriate resolution to scan 
your fax document to get optimum image quality.

1 Press the  to select [Fax Functions] 
on the fax standby screen and then 
press .

2 Press the  to select [Resolution] and 
then press .

3 Press the  to select a resolution and 
then press .

Memo

 [Extra-Fine] may be unavailable depending on the 
recipient machine.

 In the [Fine], [Extra-Fine], or [Photo] mode, 
scanning takes longer.

4 Press the  until the fax standby screen 
appears.

Adjusting Density (Density)
You can adjust the scan density from 7 levels.

1 Press  to select [Fax Functions] on the 
fax standby screen and then press .

2 Press the  to select [Density] and 
then press .

3 Press the  or  to select a density and 
then press .

Memo

 [0] is the standard value. To darken the document 
image, select [+1], [+2] or [+3] (most dense). 
Conversely, to lighten the document image, select 
[- 1], [-2] or [-3] (least dense).

4 Press the  until the fax standby screen 
appears.

Printing the Sender Name
You can set the machine to print a sender name 
on faxes you send. By default, the name you 
specified in [Sender ID] is printed.

Reference

 For details on [Sender ID], refer to "Specifying Sender 
Information" P. 61.

1 Press the  to select [Fax Functions] 
on the fax standby screen and then 
press .

2 Press the  to select [TTI] and then 
press .

3 Press the  to select [ON] and then 
press .

4 Press the  until the fax start screen 
appears.

Reference

 For details on how to register a sender name and change 
the sender name to be used, refer to the Use's Manual 
Advanced.

Settable Size Values:

A4*    Letter    Legal 13    Legal 13.5    
Legal 14

*indicates the factory default.

Settable Resolution:

Normal*    Fine    Extra-Fine    Photo
*indicates the factory default.

OK

OK

OK

OK

OK

OK

Values:

+3    +2    +1    0*    -1    -2    -3
*indicates the factory default.

OK

OK

OK

OK

OK

OK
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Checking and Canceling Fax Transmission
This section explains how to check or cancel fax jobs.

Canceling Fax Transmission
You can cancel a job that is being transmitted as 
long as the message indicating the job has been 
completed has not appeared.

1 Press the <STOP> key on the operator 
panel.

Canceling a Reserved Job
You can cancel reserved jobs.

1 Press the <FAX> key on the operator 
panel.

2 Make sure that [Fax] is selected and 
then press  to open the fax start 
screen.

3 Press the  to select [Fax Job View/
Cancel] and then press .

4 Press the  to select the job you want to 
cancel and then press .

5 Check the job contents and then press 
the .

6 Press the  to select [Delete Reserved 
Tx] and then press .

7 Press the  or  select [Yes] and then 
press .

Note

 When you select a broadcast job, the job itself is cancelled.

Memo

 The job that is being transmitted is displayed at the top of 
the list.

Checking Transmission and 
Reception History

You can check transmission and reception history 
and results.

Memo

 If a fax is being transmitted, you can check the 
transmission on the [Fax Job View/Cancel] screen.

1 Press the <FAX> key on the operator 
panel.

2 Make sure that [Fax] is selected and 
then press to  the fax start screen.

3 Press the  to select [Fax History] and 

then press .

4 Press the  to select [Tx History] or 
[Rx History] and then press .

5 Press the  to select the history you 

want to check and then press .

6 Check the history contents and then 

press .

Note

 The received message history displayed on the panel is 
only for messages received with F code polling. 

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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Machine Behavior in Fax Reception
This section explains how to set the reception mode and how your machine behaves when receiving and 
printing faxes.

Specifying Reception Mode
Depending on your environment of the machine, 
an optimal reception mode is different. Check 
with the following description.

 Fax Ready Mode

This mode is recommended when you use the 
machine as a fax machine.

 Tel/Fax Ready Mode

This mode is recommended when you connect an 
external phone to the machine.

 Ans/Fax Ready Mode

This mode is recommended when you connect an 
external answering machine to the machine.

 Tel Ready Mode

This mode is recommended when you mostly use 
an external phone connected to the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter] and press .

5 Press the  to select [User Install] and 
press .

6 Press the  to select [Reception Mode] 
and press .

7 Press the  to specify the reception 
mode and press .

8 Press the  until the fax start screen 
appears.

Reception Behavior
The machine behavior differs depending on the 
specified reception mode.

Your machine is set by factory default to [Fax 
Ready Mode] so that it automatically receives 
faxes. If you have changed the fax reception 
mode, see the following descriptions for the 
machine behavior.

When the machine is receiving faxes, the <DATA 
IN MEMORY> indicator is lit. The sender 
information is displayed on the display screen. 
Even if the reception is finished, the indicator 
remains lit while the data is stored in memory.

Memo

 If the memory overflows while the machine is receiving 
data, the reception is cancelled. If this happens, ask the 
sender to resend the fax.

When Receiving Calls and Faxes
(Tel/Fax Ready Mode)

When the machine is set to [Tel/Fax Ready 
Mode], you can receive calls and faxes. You 
must connect an external telephone in advance 
to receive calls.

Reference

 For details on how to connect an external telephone, refer 
to "Connecting a Telephone Line" P. 59.

Receiving Faxes
The machine automatically starts fax reception.

Receiving Calls
The telephone starts ringing when it receives calls.

1 Pick up the handset when the machine 
rings.
You can talk with someone on it.

Settable Reception Mode:

Fax Ready Mode*     Tel/Fax Ready Mode
Ans/Fax Ready Mode    Tel Ready Mode  

*indicates the factory default.

OK

OK

OK

OK

OK
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2 If you want to receive a fax, 
press .
If you keep picking up the handset, you can talk to 
the sender after receiving faxes.

Memo

 If you often receive calls, it is recommended that you 
activate [Tel Priority Mode]. For more detailed 
information on [Tel Priority Mode], please refer to User's 
Manual Advanced.

 If connecting to a telephone unit that is far away, you can 
receive faxes by dialing the remote switchover number. 
Please dial the remote switchover number within three 
seconds. For more details on the remote switch over 
number, please refer to User's Manual Advanced.

When Connecting An Answering
Machine (Ans/Fax Ready Mode)

When the machine is set to [Ans/Fax Ready 
Mode], you can use an answering machine and 
receive faxes automatically. Be sure to connect 
an external answering machine in advance.

Memo

 Depending on the answering machine and the sender 
machine, [Ans/Fax Ready Mode] may not operate 
correctly.

Reference

 For details on how to connect an answering machine, refer 
to "Connecting a Telephone Line" P. 59.

Receiving Faxes
The answering machine rings, the reply message 
starts, and the machine automatically starts fax 
reception.

Receiving Calls
The answering machine rings, the reply message 
starts, and then it starts recording a message.

When Often Using Telephone (Tel 
Ready Mode)

[Tel Ready Mode] is recommended if you often 
use the external telephone connected to the 
machine.

Receiving Calls
The telephone starts ringing when it receives 
calls.

Receiving Faxes
The telephone starts ringing when it receives a 
signal.

1 Pick up the handset when the machine 
rings.

2 Press .
To restart a conversation after receiving a fax, just 
pick up the receiver. After the fax has been 
received, you can talk on the phone.

Printing Received Faxes
The machine automatically prints out the received 
fax. You can specify the paper tray to use.

Note

 Do not pull out the paper trays when the machine is 
printing.

Memo

 Use only standard or recycled paper.

 Available paper sizes are A4, letter, or legal.

Reference

 Images larger than the specified paper are reduced, 
discarded, or printed onto multiple sheets of paper 
depending on the reception print settings. For details, refer 
to the User's Manual Advanced.

Selecting the Tray to Use

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Paper Setup] and 
then press .

3 Press the  to select [Select Tray] and 
then press .

4 Make sure that [Fax] is selected and 

then press .

5 Press the  to select a paper tray and 
then press .

6 Press the  to select a value and then 
press .

- When you select [ON (Prior)] for a paper tray, 
the tray is used in priority to other trays 
containing the same size paper.

- The MP tray is set to [OFF] by factory default.

7 Press the  until the fax start screen 
appears.

MONO

MONO

Settable Values:

ON*    OFF    ON (Prior)
*indicates the factory default.

OK

OK

OK

OK

OK



Machine Behavior in Fax Reception

- 87 -

Faxin
g
 a

n
d
 In

tern
et Faxin

g

3

When Unable to Print Received 
Faxes

When the machine cannot print received faxes 
due to a lack of paper or paper jams, it stores 
the received fax data temporarily in memory. 
When the problem is resolved, it starts printing 
automatically.

Reference

 For details on how to load paper, refer to "Loading Paper" 
P. 66.

 For details on how to clear paper jams, refer to "Paper 
Jams" P. 121.

 To check the reception history, refer to "Checking 
Transmission and Reception History" P. 84.
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Phone Book
This section explains how to register fax numbers in the phone book, and how to edit or delete 
registered numbers. In the phone book, you can set frequently used numbers to speed dial and also 
create groups of numbers to which you can broadcast faxes.

Speed Dial
You can register up to 100 favorite destinations 
to speed dial.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Make sure that [Speed Dial] is selected 
and then press .

4 Press the  to select a speed dial 
number and then press .
You cannot select a speed dial which is specified as 
a reserved fax job or for the auto deliver function.

5 Make sure that [Register] is selected 
and then press .
When editing a registered speed dial number, 
select [Edit].

6 If necessary, specify an entry name.

a) Make sure that [Name] is selected and 

then press the .

b) Enter a name.
Enter a name up to 24 characters.

c) Select [Enter] and then press .

7 Press the  to select [Fax Number] and 
then press .

8 Enter a phone number.
Enter a phone number up to 40 digits.

9 Select [Enter] and then press .

10 If necessary, specify a group number.

a) Press the  to select [Group No] and 
then press the .

b) Press the  to select a group number 
(1 to 20).
The check box is selected. You can select 
multiple entries.

c) When you have selected all the groups, 
press the .

d) Make sure that [Group Selection 
Completed] is selected and then press .

11 Press .

Memo

 Numbers registered to groups from the [Speed Dial] 
function are synchronized with the numbers that are 
registered to groups using the [Group No] function.

Registering From History

You can register phone numbers as speed dial 
numbers from fax transmission and reception 
histories.

1 Press the <FAX> key on the operator 
panel.

2 Make sure that [Fax] is selected and then 
press  to open the fax start screen.

3 Press the  to select [Fax History] and 
then press .

4 Press the  to select [Tx History] or 
[Rx History] and then press .

5 Press the  to select an entry and then 
press .

6 Check the entry contents and then press 
the .

7 Make sure that [Register To Speed 
Dial] is selected and then press .

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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8 Repeat steps 4 to 11 in "Registering and 
Editing" P. 88.
The fax number is automatically entered. You do 
not have to enter it manually.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Make sure that [Speed Dial] is selected 
and then press .

4 Press the  to select an entry number 
and then press .

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] and 
then press .

Note

 You cannot delete an entry which is specified as a reserved 
fax job or for the auto deliver function.

Group Dial (Group Number)
You can create up to 20 groups and register the 
entire group as a speed dial number.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 

then press .

3 Press the  to select [Group No] and 
then press .

4 Press the  to select a group number 
and then press .

5 Make sure that [Register] is selected 
and then press .
When editing registered group numbers, select 
[Edit].

6 Make sure that [Name] is selected and 
then press .

7 Enter a name.
Enter a name up to 16 characters.

8 Select [Enter] and then press .

9 Press the  to select [Speed Dial] and 
then press the .

10 Press the  to select a speed dial 
number (1 to 100) and then press .
The check box is selected. You can select multiple 
entries.

11 When you have selected all the numbers, 
press the .

12 Make sure that [Complete] is selected 
and then press .

13 Press .

Memo

 Numbers registered to groups from the [Speed Dial] 
function are synchronized with the numbers that are 
registered to groups using the [Group No.] function.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 

then press .

3 Press the  to select [Group No] and 
then press .

4 Press the  to select a group number 

and then press .

OK

OK

OK

OK

OK
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OK

OK

OK
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5 Press the  to select [Delete] and then 

press .

6 Press the  or  to select [Yes] and 
then press .

Memo

 You cannot delete an entry which is specified as a reserved 
fax job or for the auto deliver function.

One-Touch Key Pad
The speed dials no.1 to 16 are automatically 
registered to the one-touch key pad.

OK

OK
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Basic Procedure for Internet Faxing
This section explains basic operations for transmitting internet faxes.

The internet fax function allows you to transmit fax data as a file attached to an e-mail. A document is 
scanned and converted to a TIFF file. The data is transmitted immediately after scanning without being 
saved in memory. You can specify only e-mail addresses for the destination.

Memo

 You can load only A4, letter, or legal size documents in the ADF, A4 or letter size documents on the document glass. You cannot 
load mixed size documents for internet faxing.

 Depending on the recipient's machine, the document data sent by the internet fax function may not be printed correctly.

 The detailed settings on the internet fax function are the same as in the scan to e-mail function. For details, refer to the User's 
Manual Advanced.

Reference

 Before using the internet fax function, you need to configure the server settings. For details, refer to "Setting Up Scan To E-mail 
and Internet Fax" P. 46.

Sending an Internet Fax

1 Press the <FAX> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Internet Fax] 
and then press .

4 Configure the internet fax settings if 
necessary.

Reference

 For details on the internet fax settings, refer to the 
User's Manual Advanced.

5 Make sure that [Add Destination] is 
selected and then press .

Memo

 Here you can add addressees by using one-touch keys. You 
can add addresses with [To]. Thereafter, you can add 
multiple addresses using the one-touch keys.

6 Make sure that [To] is selected and then 
press .

Press to  select [Cc] or [Bcc] if necessary.

7 Specify a destination.
- You can set the recipient by directly entering them 

or by using the address book, group list, sending 
history, LDAP search or one-touch key.

Reference

 Refer to "Specifying a Destination" P. 92.

8 Press  to start transmission.
If you want to scan multiple documents with the 
document glass, enable the continuous scan 
mode.

Reference

 "Enabling Continuous Scan Mode (Continuous Scan)" 
P. 77

Reference

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 72.

OK

OK

OK

MONO
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Specifying a Destination
You can specify a destination in the following five 
ways:

 Using the address book

 Using a group

 Using the transmission histories

 Direct input

 Using LDAP search 

Perform one of the following procedures at step 7 
of "Sending an Internet Fax" P. 91 described 
above.

Using the Address Book and Group 
List

You can select a destination from the address 
book or groups. You need to register them in 
advance.

Reference

 For details on how to add e-mail addresses to the address 
book and groups, refer to "Registering Address Book" P. 105.

1 Press the  to select [Address Book] or 

[Group list] and then press .

2 Press the  to select the destination or 
group you want and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Make sure that [Complete] is selected 
and then press .

5 Press the  to return to the internet fax 
start screen.

Using the Transmission History

You can select a destination from transmission 
histories.

Note

 The sending history only shows those recipients which had 
their addresses directly entered.

1 Press the  to select [Tx History] and 

then press .

2 Press the  to select the entry you want 
and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Make sure that [Complete] is selected 

and then press .

5 Press the  to return to the internet fax 
start screen.

Direct Input

You can enter a destination directly.

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the  to select [Direct Input] and 

then press .

2 Enter an e-mail address.
An e-mail address up to 80 characters.

3 Select [Enter] and then press .

4 Press the  to return to the internet fax 
start screen.

OK

OK

OK

OK

OK

OK

OK

OK
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Using LDAP Search

You can search for a destination that is on the 
LDAP server.

You can select either [Simple Search] or 
[Advanced Search] for the method of 
searching.

[Simple Search] only searches for a single 
keyword as a username. Also, with Simple 
Search you can only search for character strings 
included in usernames. You cannot search for 
character strings in e-mail addresses.

When you select [Advanced Search], you can 
search for a user name or e-mail address. You 
can also select search conditions to retrieve only 
results that contain all the specified keywords.

Reference

 For details on the LDAP server settings, refer to the User's 
Manual Advanced.

For Simple Search

1 Press the  to select [LDAP] and then 
press .

2 Check that [Simple Search] is selected 
and press .

3 Enter a keyword to search for a user 
name in the LDAP server.

4 Select [Enter] and then press  to start 
searching.

5 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

6 When you have selected all the 
destinations, press the .

7 Make sure that [Complete] is selected 
and then press .

8 Press the  to return to the internet fax 
start screen.

For Advanced Search

1 Press the  to select [LDAP] and then 
press .

2 Press the  to select [Advanced 
Search] and then press .

3 Check that [Search Method] is selected 
and press .

4 Select either [OR] or [AND] and press .

5 Press , select [User name], and then 
press .

6 Enter the keyword to search for.

7 Select [Enter] and then press .

8 Press , select [E-mail Address], and 
then press .

9 Enter the keyword to search for.

10 Select [Enter] and then press .

11 Press  to start searching.

12 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

13 When you have selected all the 
destinations, press the .

14 Make sure that [Complete] is selected 
and then press .

15 Press the  to return to the internet fax 
start screen.

Checking, Deleting, and 
Changing Destinations

Checking a Destination

1 Press the  on the start screen to select 
the specified destination and then 
press .

2 Press the  to select the destination 
type you want to check and then 
press .
The destination type includes To, Cc, and Bcc.

3 When you have checked the destination, 
press the .

OK

OK

OK
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4 Make sure that [Close the list] is 
selected and then press .

Deleting a Destination

1 Press the  on the start screen to select 
the specified destination and then press 

.

2 Press the  to select the destination 
type in which the destination you want to 
delete is included and then press .
The destination type includes To, Cc, and Bcc.

3 Press the  to select the destination you 
want to delete and then press .
The check box is selected. You can select multiple 
addresses.

4 When you have selected all the 
destinations to be deleted, press the .

5 Press the  select [Delete The 
Address] and then press .

Changing the Destination Type

1 Press the  on the start screen to select 
the specified destination and then press 

.

2 Press the  to select the destination 
type in which the destination you want to 
change is included and then press .
The destination type includes To, Cc, and Bcc.

3 Press the  to select the destination you 

want to change and then press .
The check box is selected. You can select multiple 
addresses.

4 When you have selected all the 
destinations to be changed, press the .

5 Make sure that [Edit Destination Type] 

is selected and then press .

6 Press the  to select the destination 
type you want from [To], [Cc], or [Bcc] 
and then press .

Canceling Transmission
While the "Scanning" screen is displayed, you 
can cancel the job.

1 Press the <STOP> key on the operator 
panel to cancel transmission.

Receiving Internet Faxes
The machine automatically prints the internet 
faxes it receives. If the document is larger than 
A4 size, the machine automatically reduces it to 
the size of the paper in the specified paper tray.

Reference

 If you want to forward an internet fax, you can use the 
auto delivery function. For details, refer to the User's 
Manual Advanced.

 In order to receive internet faxes, it is necessary to 
configure e-mail receiving settings beforehand. For details, 
please refer to the User's Manual Advanced.

OK

OK
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4. Scanning
This chapter explains the basic operation and settings for your machine's scanning functions.

 Installing Scanner Drivers (TWAIN/WIA Driver)
This section explains the procedure to install the scanner driver. Before using scan function, install the 
scanner driver. You can install TWAIN driver and WIA (Windows only) driver at the same time.

If you want to use the network scan function, follow the installation procedure below and register the 
information of your computer and then install the scanner driver.

Memo

 When using the network scan function in Windows, please install the ActKey utility.

Reference

 Before installing the scanner driver manual, do the network settings.For details on how to do network settings, refer to 
"Network Connection" P. 31.

Note

 When using a scanner with a network connection in Windows, if the equipment IP address is changed, please change the 
settings in Network Configuration. For Mac OS X, please change settings in network scanner setting tools. For details, refer to 
User's Manual Advanced.

Installation Procedure

Memo

 When using the network scan function in Windows, please 
install the Network Configuration. For Mac OS X, the 
network scanner setting tools will be installed 
automatically.

For Windows

1 Ensure that your machine and the 
computer are turned on and connected, 
and then insert the "Software CD-ROM" 
into the computer.

2 Click [Run setup.exe] after [Auto 
Play] is displayed.
If the [User Account Control] dialog box 
appears, click [Yes].

3 Select the model of your machine, and 
then click [Next].

4 Read the license agreement and then 
click [I Agree].

5 Select [Custom Installation 
(Scanner)] under [Driver 
Installation].
If the scanner driver has been installed, the setup 
maintenance program of the scanner driver is 
displayed. Check the checkbox of [Add] and then 
click [Next] to proceed to the step 8.

6 Click [Next].
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7 Check the checkbox of [Network 
scanner] and click [Next].

8 Select [IP Address] or [Search MFP] 
check box to enter the address of the 
machine and then click [Next].
If you want to set the [IP Address], follow 
procedure 10.

9 If [Search MFP] is selected, select the 
machine and click [Next].

10 Set the scanner driver name and click 
[Next].

11 Enter the host name, IP address and port 
number and then click [Configure].

12 Click [Next].

13 Click [Next].

14 Click [Finish].

For Mac OS X

1 Ensure that your machine and the 
computer are turned on and connected, 
and then insert the "Software CD-ROM" 
into the computer.

2 Double-click [OKI] on the desk top.

3 Double-click [Drivers] > [Scanner 
(TWAIN)] > [MC351_MC361_MC561 
TWAIN].
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4 Click [Continue].

5 Click [Continue].

6 Read the information displayed and then 
click [Continue].

7 Read the license agreement and then 
click [Continue].

8 Click [Agree].

9 Click [Install].
If necessary, click [Change Install 
Location] to specify the location to install the 
driver.

10 Enter the administrator's name and 
password and then click [OK].

11 Click [Close].
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Scanning Methods
This section explains the basic operation of the scan function. In scan mode, you can use five scan 
functions, scan to e-mail, scan to USB memory, scan to network computer, scan to local computer and 
PC scan. You can select these functions after pressing <SCAN> key.

Reference

 The scan function supports the Continuous Scan mode. For details on the [Continue Scan] functions, refer to 
"Enabling Continuous Scan Mode (Continuous Scan)" P. 77.

Scan to E-mail
You can scan a document and attach it to an 
e-mail.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Make sure [E-mail] is selected and then 

press .

Memo

 Here you can add addressees by using one-touch keys.  
You can add addresses with [To]. Thereafter, you can add 
multiple addresses using the one-touch keys.

4 Make sure [Add Destination] is 
selected and then press .

5 Make sure [To] is selected and then 
press .

Press the  to select [Cc] or [Bcc] and 
then press .

6 Specify a destination.
You can specify a destination by direct input or 
from the address book, groups, e-mail histories, 
LDAP or one-touch key.

7 Press  or .

Specifying a Destination

You can specify a destination in the following six 
ways:

 Using the address book
 Using a group list
 Using the e-mail history
 Direct input
 Using LDAP search

 Using the one-touch key pad

Perform any of the following operations at the 
step 6 of "Scan to E-mail" stated above.

Using the Address Book or Group 
List

You can select a destination from the address 
book or group list. Be sure to register them in 
advance.

Reference

 For how to register destinations in the address book or 
group list, refer to "Registering Address Book" P. 105.

1 Press the   to select [Address book] 
or [Group list] and then press .

2 Press the  to select the destination or 
group you want and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Make sure that [Complete] is selected 
and then press .

5 Press the  to return to start screen.

Using E-mail History
You can select a destination from transmission 
histories.

1 Press the  to select [Tx History] and 
then press .

2 Press the  to select a destination and 
then press .
The check box is selected. You can select multiple 
entries.

OK

OK

OK

OK
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OK

OK

OK

OK
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3 When you have selected all the 
destinations, press the .

4 Make sure that [Complete] is selected 
and then press .

5 Press the  to return to start screen.

Direct Input
You can enter a destination directly using the 
onscreen keyboard.

1 Press the  to select [Direct Input] and 
then press .

2 Enter a destination e-mail address up to 
80 characters.

Reference

 For how to enter texts, refer to "Entering Text Using the 
Operator Panel" P. 27.

3 Select [Enter] and then press .

4 Press the  to return to start screen.

Using LDAP Search
You can search for a destination from the list on 
the LDAP server.

You can select either [Simple Search] or 
[Advanced Search] for the method of searching.

[Simple Search] only searches for a single 
keyword as a username. Also, with Simple 
Search you can only search for character strings 
included in usernames. You cannot search for 
character strings in e-mail addresses.

When you select [Advanced Search], you can 
search for a user name or e-mail address. You 
can also select search conditions to retrieve only 
results that contain all the specified keywords.

Reference

 For the LDAP server setting, refer to User's Manual 
Advanced.

For Simple Search

1 Press the  to select [LDAP] and then 
press .

2 Check that [Simple Search] is selected 
and press .

3 Enter a keyword to search for a user 
name on the LDAP server.

4 Select [Enter] and then press  to start 
searching.

5 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
entries.

6 When you have selected all the 
destinations, press the .

7 Make sure that [Complete] is selected 

and then press .

8 Press the  to return to start screen.

For Advanced Search 

1 Press the  to select [LDAP] and then 

press .

2 Press  to select [Advanced Search] 
and then press . 

3 Check that [Simple Search] is selected 
and press .

4 Select either [OR] or [AND] and 
press .

5 Press , select [User Name], and then 
press .

6 Enter the keyword to search for.

7 Select [Enter] and then press .

8 Press , select [E-mail Address], and 
then press .

9 Enter the keyword to search for.

10 Select [Enter] and then press .

11 Press  to start searching.

12 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

13 When you have selected all the 
destinations, press the .

14 Make sure that [Complete] is selected 
and then press .

15 Press the  to return to start screen.
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Scan to USB Memory
You can save the scanned document in a USB 
memory.

Reference

 For the specifications of USB memory that you can use, please 
refer to "Print From USB Memory Specifications" P. 177.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Insert the USB memory into the USB 
memory interface of the machine.

Note

 Insert the USB memory into the USB port straight. If it 
is not inserted with a correct angle, the USB port may 
be damaged.

4 Press the  to select [USB Memory] 
and then press .

5 Press the  to scanning settings if 
necessary.

6 Press  or .

7 Remove the USB memory from the port 
after the message is displayed indicating 
that it is OK to remove the USB memory.

Scan to Network PC
You can send a scanned document to a server on 
the network. 
The document is scanned and converted to a 
PDF, JPEG, TIFF, or XPS file. The factory default 
setting is PDF.

Note

 Check that the machine is connected to the network.

 It is necessary to set up Scan To Network PC in advance.

Reference

 For the Scan To Network PC setup, please refer to "Setting 
Up Scan To Network PC" P. 48.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Network PC] and 

then press .

4 Check that [Select Profile] is selected 
and then press .

5 Press the  to select a profile and then 

press .

6 Press  or .

OK
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Scan to Local PC
You can save the scanned data into your local 
computer. 

When you press the  or , the scan 
job starts and the ActKey utility and the TWAIN 
driver start automatically. You can send the 
scanned document to a specified application, 
save it in a specified folder, or send it by fax.

The machine can be connected to USB interface 
or network, but only a computer can be 
connected at the same time.

The scan to local PC function is available only for 
Windows. You cannot use this function for Mac 
OS X.

Note

 Connect the machine to a computer via USB or a network.

 Install ActKey and scanner driver before scanning to a 
local computer.

 If you connect the machine to network, follow these 
instructions.

- Set [TCP/IP] setting to [Enable].

- Conform the IP version of the machine to that of your 
computer.

- Set up the DNS server.

- Enable the network TWAIN setting.

Reference

 For details on how to enable the network TWAIN setting, 
refer to the User's Manual Advanced.

 For details on how to install the ActKey utility, refer to the 
User's Manual Advanced.

Connecting via USB

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Local PC] and 
then press .
If the Network TWAIN setting is set to [Disable], 
proceed to the step 6.

4 Check that [Select A Connecting PC] is 

selected and then press .

5 Press the  to select [From USB 
Interface] and then press .

6 Press the  to select [Select An 

Application] and then press .

7 Press the  to select where to send the 
scanned document and then press .

8 Press  or .

Memo

 If you select [Application], the specified application starts 
and the scanned image is displayed on the application.

 If you select [Folder], the scanned image is saved in the 
specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts. After sending the scanned image, 
send a fax with the fax transmission software on your 
computer.

Connecting via Network

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Local PC] and 

then press .

4 Check that select [Select A Connecting 

PC] is selected and then press .

5 Check that [From Network] is selected 

and then press .

6 Press the  to select the computer you 
want and then press .

7 Press the  to select [Select An 

Application] and then press .

8 Press the  to select where to send the 
scanned document and then press .

9 Press  or .

Memo

 If you select [Application], the specified application starts 
and the scanned image is displayed on the application. 

 If you select [Folder], the scanned image is saved in the 
specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts. After sending the scanned image, 
send a fax with the fax transmission software on your 
computer.
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Scan to Remote PC
This function launches the TWAIN driver from a 
utility installed on a PC (ActKey, PaperPort, 
Image,Adobe Photoshop CS3, etc.) and starts 
scanning.

Connect the machine to a computer via USB or a 
network.

For PC Scan function, there are two modes; 
simple scan mode and secure scan mode. In 
simple mode you can start a scan job easily. In 
secure scan mode, only the operation from the 
specified computer can be done. Only a 
computer can be connected at the same time.

Memo

 For the following procedure, ActKey will be used as an 
example for Windows, and Adobe Photoshop CS3 for Mac 
OS X. The items in this manual may differ depending on 
the application you are using.

Note

 Connect the machine to a computer via USB or a network.

 Install an application (ActKey, PaperPort, etc.) and a 
scanner driver before starting a scan job.

 If you connect the machine to network, follow these 
instructions.

- Set [TCP/IP] setting to [Enable].

- Conform the IP version of the machine to that of your 
computer.

- Set up the DNS server.

- Enable the network TWAIN setting.

 When in Secure Scan Mode, the administrator needs to 
register the computer information for carrying out security 
scans from the control panel or the web site beforehand.

 For Mac OS X, when carrying out a network scan for the 
first time, you need to set the connection target when 
using a driver. When you use the driver for the first time, 
the connection target selection tool will launch. 
You do not need to set the connection target after the first 
time.

Reference

 For details on how to install a scanner driver, refer to 
"Installing Scanner Drivers (TWAIN/WIA Driver)" P. 95.

Simple Scan Mode

For Windows

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
then press .

4 Start ActKey on your computer.

5 Click the scan button you want.
The scan job starts.

Memo

 If you select [Application1] or [Application2], the 
specified application starts and the scanned document is 
displayed on the application. 

 If you select [Folder], the scanned document is saved in 
the specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts and the scanned document is sent to 
the application. Send a fax with the fax transmission 
software on your computer.

 For Mac OS X

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
then press .

4 Start Adobe Photoshop CS3 on your 
computer.

5 Select [Import] from [File] to select 
[OKI MC351_361_561 Twain] or 
[OKI MC351_361_561 Twain 
Network]. 

- If you select [OKI MC351_361_561 Twain], 
proceed to the step 9.

- If you select [OKI MC351_361_561 Twain 
Network] and the network scan is the second or 
more scanning, proceed to the step 9.

6 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

7 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

Scan Button Name:
Application1, Application2, Folder, PC-
Fax

OK

OK
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8 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MC351_361_561 Twain Network].
The window appears.

9 Click a scan button.

Scanning starts.

10 Select [Quit Photoshop] from 
[Photoshop].

Secure Scan Mode (For Network 
Connection)

For Windows

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that [Select a connecting PC] is 
selected and then press .

5 Check that [From Network] is selected 
and then press .

6 Press the  to select the destination you 
want and then press .

7 Press  or .

8 Start the ActKey on your computer.

9 Click a scan button.

For Mac OS X

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 

the press .

4 Check that [Select a Connecting PC] is 

selected and then press .

5 Check that [From Network] is selected 

and then press .

6 Press the  to select the destination you 
want and then press .

7 Press  or .

8 Start the Adobe Photoshop CS3 on your 
computer.

9 Select [Import] from [File] to select 
[OKI MC351_361_561 Twain 
Network].
If you select [OKI MC351_361_561 Twain 
Network] and the network scan is the second or 
more scanning, proceed to the step 13.

10 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

11 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

12 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MC351_361_561 Twain Network].
The window appears.

13 Click a scan button.
Scanning starts.

14 Select [Quit Photoshop] from 
[Photoshop].

Secure Scan Mode (For USB 
Connection)

 For Windows

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that [Select a connecting PC] is 
selected and then press .

5 Press the  to select [From USB 
interface] and then press .

6 Press  or .

7 ActKey start on the computer.
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8 Click the Scan button.

For Mac OS X

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that [Select a connecting PC] is 

selected and then press .

5 Press the  to select [From USB 
Interface] and then press .

6 Press  or .

7 Start Adobe Photoshop CS3 on your 
computer.

8 Select [Import] from [File] to select 
[OKI MC351_361_561 Twain 
Network]. 

9 Click a scan button.
Scanning starts.

10 Select [Quit Photoshop] from 
[Photoshop].

Canceling the Current Scan Job
Scanning will stop while the message saying that 
the document is being read is displayed.

1 Press the <STOP> key on the operator 
panel.

Note

 You cannot cancel with Scan to Local PC and Scan to 
Remote PC.

OK
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OK
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Registering Address Book
This section explains how to register and deleted the address book and group list.

You can register e-mails to the address book and create groups for broadcasting messages. The Address 
Book and the Group List can be used to specify the destination in Scan to e-mail and internet fax 
functions.

Address Book
You can register up to 100 e-mail addresses to 
the address book.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Address Book] 

and then press  .

3 Make sure that [E-mail Address] is 

selected and then press .

4 Press the  to select a number and then 
press .
You cannot select a number which is specified in 
Auto Deliver function.

5 Make sure that [Register] is selected 

and then press .
If editing registered addresses, select [Edit].

6 If necessary, specify a name.

a) Make sure that [Name] is selected and 

then press the .

b) Enter a name up to 16 characters.

c) Select [Enter] and then press .

7 Press the  to select [E-mail Address] 
and then press .

8 Enter an e-mail address up to 80 

characters and then press .

9 Press .

Registering From Transmission 
History

You can add e-mail addresses to the address 
book from fax transmission histories.

Note

 The sending history only displays recipient addresses to 
which an internet fax was sent by directly entering the 
recipient's address.

1 Press the <SCAN> key on the operator 
panel.

2 Make sure that [E-mail] is selected and 
then press .

3 Press the  to select [E-mail Tx 
History] and then press .

4 Press the  to select the entry you want 
and then press .

5 Check the entry and then press the .

6 Make sure [Register To Address Book] 
is selected and then press .

7 Repeat the steps 4 to 9 in "Registering 
and Editing".
The e-mail address is automatically entered. You 
do not have to enter it manually.

Deleting

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Make sure that [E-mail Address] is 
selected and then press .

4 Press the  to select an entry number 
and then press .

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] on the 
confirmation screen and then press .

Note

 You cannot delete an e-mail address which is specified in 
Auto Deliver function.
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Group List
You can create up to 20 groups of e-mail 
addresses.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Press the  to select [E-mail Group] 

and then press .

4 Press the  to select a group number 
and then press .

5 Make sure that [Register] is selected 
and then press .
If editing registered group numbers, select [Edit].

6 Make sure that [Name] is selected and 
then press the .

7 Enter a name up to 16 characters.

8 Select [Enter] and then press .

9 Press the  to select [Address 
Number] and then press .

10 Press the  to select the desired e-mail 
address from the address book and then 
press .
The check box is selected. You can select multiple 
entries.

11 When you have selected all the desired 
e-mail addresses, press the .

12 Make sure that [Complete] is selected 

and then press .

13 Press .

Memo

 You can also register the e-mail group from [Group 
No] in [E-mail Address].

Deleting

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Press the  to select [E-mail Group] 

and then press .

4 Press the  to select a group number 
and then press .

5 Press the  to select [Delete] and then 

press .

6 Press the  or  to select [Yes] on the 
confirmation screen and then press .
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Registering Network Scan Destinations
This section explains how to register a PC connected to the Network.

You can register locations on a network to which you can scan documents.

Memo

 You can also register network-connected PCs with ActKey in Network Configuration. You can register network-connected PCs 
with Network Configuration, however, you cannot edit or delete them. For details, refer to User's Manual Advanced.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Network Scan 

Destination] and then press .

3 Press the  to select an IP address or 
domain name and then press .

4 Make sure that [Register] is selected 

and then press .
If editing registered numbers, select [Edit].

5 Make sure that [Destination] is selected 
and then press .

6 Enter a destination.
A destination up to 16 characters. 

7 Select [Enter] and then press .

8 Press the  to select [Destination 
Address] and then press .

9 Enter an IP address or a Host PC name.
An IP address or a name up to 64 characters. 

10 Select [Enter] and then press .

11 Press the  to select [Port No.] and 
then press .

12 Enter a port number and then press .

13 Press .

14 Press the  until the top screen is 
displayed.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Network Scan 

Destination] and then press .

3 Press the  to select a number and then 
press .

4 Press the  to select [Delete] and then 

press .

5 Press the  or  to select [Yes] on the 
confirmation screen and then press .

6 Press the  until the top screen is 
displayed.
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5. Using as a Printer
This chapter describes how to print documents from a computer or USB memory.

Printing from a Computer
This section explains how to print from a computer.

Memo

 This section uses Wordpad in Windows and TextEdit in Mac OS X as examples. The display and procedure may differ according 
to the operating system, the applications, and the version of the printer driver you are using.

 For additional information on the setting items on the printer driver, refer to its online help.

Printing

1 Open the file you want to print from an 
application.

2 Configure the print settings on the 
printer driver screen and start printing.
The following explains how to configure the paper 
size, the paper source, and the media weight on 
each printer driver you are using. For how to set 
by each printer driver, refer to the following 
instructions.

For Windows PCL/PCL XPS Printer 
Driver

1 From the [File] menu of an application, 
select [Print].

2 Select the printer driver you want to use.

3 Click [Preferences].

4 On the [Setup] tab, select a paper size 
from [Size].

5 Select a tray from [Source].

6 Select a media weight from [Weight].

7 Click [OK].

8 Click [Print].

For Windows PS Printer Driver

1 From the [File] menu, select [Print] to 
open the print dialog.

2 Select the printer driver you want to use.

3 Click [Preferences].
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4 Select the [Paper/Quality] tab.

5 Select a tray from [Paper Source].

6 Click [Advanced].

7 Click [Paper Size] and select a paper 
size from the drop-down list.

8 Click [Media Type] and select the media 
type from the drop-down list.

9 Click [OK].

10 Click [OK].

11 Click [Print].

For Mac OS X PS Printer Driver

1 From the [File] menu, select [Page 
Setup].

2 Select the printer you want to use from 
[Format For].

3 Select a paper size from [Paper Size] 
and then click [OK].

4 From the [File] menu, select [Print].

5 Select [Paper Feed] from the panel 
menu.

Memo

 If the print dialog contains only two menus and does 
not contain the options you expect to see on the Mac 
OS X 10.5 to 10.6, click the disclosure triangle beside 
the [Printer] menu.

6 Select a tray on the [Paper Feed] panel.

7 Select [Printer Features] from the 
panel menu.

8 Select [Paper Input Options] from 
[Features Sets].

9 Select a media type from [Media Type].
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10 Click [Print].

Memo

 For general use, [Printer Setting] suffices for a paper 
weight. When you select [Printer Setting], the paper 
weight setting configured on the equipment setting menu 
at the operator panel of the machine is applied.

Reference

 If you select [Automatically Select] for a paper source, 
the tray with the designated paper type is automatically 
selected. For details on the automatic selection of trays, 
refer to the User's Manual Advanced.

 If you select the MP tray for a paper source, the paper 
must be loaded on the MP tray. For details on how to load 
paper on the MP tray, refer to "Loading Paper on the MP 
Tray" on P. 68.

Canceling a Print Job
You can cancel a print job from a computer by 
deleting the job in the job list from the operator 
panel.

1 Press the <PRINT> key on the operator 
panel to open the print menu.

2 Make sure [Job Lists] is selected and 

then press .

3 Press the  to select the job you want to 
cancel and then press .

4 Make sure [Cancel] is selected and then 
press .

5 Press the  or  on the confirmation 

screen to select [Yes] and then press .

Note

 Pages that are ready to be printed on the machine are 
printed without change.

 If the display indicating that data is being printed on the 
operator panel is left for a long time, delete a print job on 
a computer.

OK

OK

OK

OK



Printing From USB Memory

- 111 -

U
sin

g
 as a P

rin
ter

5

Printing From USB Memory
This section explains how to print from the USB memory. Inserting the USB memory into the machine, 
you can print the document stored in it directly.

Note

 Not all USB memory products are guaranteed to work. (USB memory with security functions is not supported.)

 A USB hub and an external USB HDD are not supported.

 Encrypted PDF is not supported.

Memo

 The following file systems are supported: FAT12, FAT16, FAT32.

 The following file formats are supported: JPEG, PDF (v1.7), M-TIFF (v6 Baseline), PRN (PCL, PS).

 Up to 32 GB capacity of USB memory is supported.

 Up to 100 files in supported file formats stored in USB memory are displayed on the file list.

- If more files are stored in USB memory, the list of the stored files may not be displayed properly.

- USB memory with a directory structure of 20 or more levels may not be read properly.

- Files with passwords exceeding 240 characters may not be read correctly.

 You can select and print one file in your USB memory at a time.

Starting a Print Job

1 Insert the USB memory into the USB 
port on the machine.

Note

 Insert the USB memory straight into the USB port. If 
the USB memory is inserted at an angle, it may 
damage the USB port.

2 Press the <PRINT> key on the operator 
panel to open the print menu.

3 Press the  to select the [Print From 
USB Memory] and then press .

4 Check that [Select Print File] is 
selected and then press .
If a file to be printed is not stored in the folder, 
proceed to the step 7.

5 Press the  to select the folder with the 
file to print in it and then press .

6 Press the  to select [Open folder.] and 
then press .
Repeat step 5 and 6 until the file to print is 
displayed.

Memo

 If [Folder Property] is selected, you can check the 
folder information.

7 Press the  to print a file and then 
press .

8 Press the  to select [Select a file] and 

then press .

Memo

 If [File Property] is selected, you can check the file 
information.

9 Perform print settings if necessary.

Reference

 "Configuring Print Settings" on P. 112 

10 Press  or  to start printing.
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11 Remove the USB memory from the port 
after a message is displayed indicating 
that it is OK to remove the USB memory.

Configuring Print Settings
You can configure the settings for printing from 
USB memory on the [Print Setup] menu. 
Perform the following procedure at step 9 of 
"Printing From USB Memory" on P. 111 in 
"Starting a Print Job".

Changing the Paper Type (Paper 
Feed)

You can select the paper source.

Note

 When printing a PRN file, the setting of the paper tray 
follows the driver settings at the time of file creation.

1 Press the  to select [Print Setup] and 

then press .

2 Check that [Paper Feed] is selected and 

then press .

3 Press the  to select the desired value 

and then press .

4 Press the  to return to the start screen.

Memo

 [Tray 2] is displayed only when the second tray unit is 
installed as an option.

Changing the Number of Copies 
(Copies)

You can set the number of copies to print.

1 Press the  to select [Print Setup] and 
then press .

2 Press the  to select [Copies] and then 

press .

3 Enter a number of copies and then press .
You can enter 1 to 999.

4 Press the  to return to the start screen.

Doing Duplex Printing (Duplex)

You can make 1-sided (simplex) or 2-sided 
(duplex) printouts.

Note

 When printing a PRN file, setting of double-sided printing 
follows the driver settings at the time of file creation.

1 Press the  to select [Print Setup] and 

then press .

2 Press the  to select [Duplex] and then 
press .

3 Press the  to select [ON] for duplex 
printing or [OFF] for simplex printing 
and then press .

4 Press the  to return to the start screen.

Setting the Binding Position (Binding)

You can select the binding position of duplex 
printouts.

1 Press the  to select [Print Setup] and 

then press .

2 Press the  to select [Binding] and 

then press .

3 Press the  to select [Long edge bind] 
to bind at the long edge of the paper or 
[Short edge bind] to bind at the short 
edge of the paper and then press .

4 Press the  to return to the start screen.

Reference

 For details on long edge binding and short edge binding, 
refer to "Making Duplex Copies (Duplex Copy)" on P. 77.

Fitting Pages (Fit)

You can match the page size to the paper size 
when printing.

If the page size of a file to print is larger or 
smaller than the effective print area, the page 
size is resized to fit the paper size.

Note

 When printing a PRN file, these settings do not work.

Memo

 This function is set to [ON] by default.

1 Press the  to select [Print Setup] and 
then press .

Selectable Paper Tray Values:
Tray 1*    Tray 2    MP Tray

*indicates the factory default.
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2 Press the  to select [Fit] and then 

press .

3 Press the  to select [ON] for matching 
the paper size or [OFF] for not resizing 
the page size and then press .

4 Press the  to return to the start screen.

Canceling a Print Job
You can cancel a print job from the USB memory 
by pressing the <STOP> key on the operator 
panel.

Printing will stop while a message is displayed 
saying that printing is finished.

1 Press the <STOP> key on the operator 
panel.

Note

 Pages that are ready to be printed on the machine are 
printed without change.

OK

OK
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6. User Authentication and Access 
Control

This chapter explains the user authentication and access control functions.

About User Authentication and Access Control
The user authentication and access control functions allow you to limit the functions available to each 
user. If the access control is enabled, the user authentication is required before using the machine. If 
the authentication succeeds, functions specified in advanced can be only used.

Your machine has the following two methods of user authentication:

 PIN (personal identification number)

 User name and password

To control access to the machine, register a PIN (personal identification number) or a user name and 
password to each user in advance. You can register up to 100 PINs and 100 sets of user name and 
password.

If the access control is enabled, according to the setting, the user must enter the PIN or the user name 
and password to log into the machine or to print from a computer.

Access control can be applied to the following functions:

 Copying (Color/Mono)

 Faxing

 Scanning to e-mail

 Scanning to USB memory

 Scanning to network PC

 Printing (Color/Mono)

 Printing from USB Memory (Color/Mono)

Note

 Scan to Mail settings also apply to sending internet faxes.

 Settings for sending faxes also apply to sending faxes from a computer.

The following conditions are required to enable the user authentication and access control functions:

 Configuration Tool on Network/USB connected computers (PIN/Username and password)

 Website (PIN)

Reference

 For details on Configuration Tool, refer to the User's Manual Advanced.
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Authentication by PIN
This section explains how to enable the access control using the authentication by PIN and how to 
operate when the access control is enabled.

Registering a PIN
Before enabling the user authentication and 
access control, be sure to register a PIN for each 
user. You must be the administrator to register 
PINs.

To register a PIN, launch PIN Manager from 
Configuration Tool.

Reference

 For details on how to register a PIN from Configuration 
Tool, refer to the User's Manual Advanced.

Memo

 You can also register a PIN from a web browser or Print 
Control.

Enabling Access Control
You must be the administrator to control access 
to the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 

and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [Management] 

and then press .

6 Press  to select [System Setup] and 
then press .

7  Make sure that [Access Control] is 
selected and then press .

8 Press the  to select [PIN] and then 

press .

9 Press the  until the message of "Access 
Control has been enabled." is displayed.

Operation When PIN 
Authentication Is Enabled

Logging Into the Machine

 For General Users

1 Enter your PIN No. using the ten-key pad 
on the operator panel.

2 Press .
If authentication succeeds, the top screen 
appears.

 For the Administrator

1 Enter "000000" using the ten-key pad on 
the operator panel.
The PIN No. of the administrator is "000000". You 
cannot change the value.

2 Press .

3 When the password entry screen 
appears, enter the administrator 
password.
The default password is "aaaaaa".

4 Select [Enter] and then press .
If authentication succeeds, the top screen 
appears.

Logging Out of the Machine

When you have finished operations, be sure to 
log out of the machine.

1 Press the  until the top screen appears.

2 Press the <RESET/LOG OUT> key on 
the operator panel.

OK

OK

OK

OK

OK

OK

OK

OK

OK
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3 Press the  or  on the confirmation 

screen to select [Yes] and then press .

Memo

 After a certain period of time, the machine automatically 
logs out users.

Operation From a Computer

To control access to operations from a computer, 
you need to install Print Control Client on the 
computer in advance.

Memo

 The authentication type specified on the computer 
overrides the one specified on the machine.

Reference

 For details on Print Control, refer to the User's Manual 
Advanced.

Printing (for Windows)
Memo

 This procedure uses NotePad and PCL driver as an 
example. The procedures and menus may differ depending 
on the OS you use.

1 Click [Start] > [All Programs] 
([Programs] for Windows 2000) > 
[Okidata] > [Print Control Client] > 
[Change Print Control Mode].
On the [User Account Control] window, click 
[Yes]. (Click [Continue] for Windows Vista.)

2 Select the printer driver you want in 
[Driver].

3 Select the [Tab] check box and then 
click [Change].

4 Click [OK].

5 From the [File] menu, select [Close].

6 Click [Start] and select [Devices and 
Printers].

7 Right-click the OKI MC561 icon and 
select [Printer properties] > [OKI 
MC561(*)].
* Select the type of driver you want.

8 Select the [Print Control] tab.

9 Enter the user name in [User Name] 
and the PIN in [Job Account ID].

10 Click [OK].

11 Open the file you want to print.

12 From the [File] menu, select [Print].

13 Select the printer driver you selected in 
step 7 and then click [Print].

Printing (For Mac OS X)
Memo

 This procedure uses Text Edit as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Put the Software CD-ROM into the 
computer.

2 Double click on the [OKI] icon on your 
desktop.

3 Double-click on [Utility].

4 Copy the [JA Client] folder by dragging 
and dropping to the place you want.

5 Open the [JA Client] folder you opened, 
and double click on [Print Job 
Accounting] ([Print JobAccounting] for 
Mac OS X 10.3.9).

6 Click [New].

7 Enter the username into [UserName] 
and enter the PIN into 
[JobAccountingID].

8 Click [Save].

9 Click [Save].

OK
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10 If a message is displayed asking you to 
input the user password, enter the 
password and click [OK].

11 Open the file to print.

12 Select [Print] from the [File] menu.

13 Select your machine and click [Print].

Sending Faxes from Your Computer 
(Windows only)
Memo

 In the following procedure, Notepad is used as an 
example. The items here may differ depending on the 
application you are using.

1 Click [Start] > [All Programs] 
[Okidata] > [Print Control Client] > 
[Change Print Control Mode].
On the [User Account Control] window, click 
[Yes].

2 Select the printer driver you want in 
[Driver].

3 Select the [Tab] check box and then 
click [Change].

4 Click [OK].

5 From the [File] menu, select [Close].

6 Click [Start] and select [Devices and 
Printers].

7 Right-click the OKI MC561 icon and 
select [Printer properties] > [OKI 
MC561(*)].

8 Select the [Print Control] tab.

9 Enter the user name in [User Name] 
and the PIN in [Job Account ID].

10 Click [OK].

11 Open the file you want to fax.

12 From the [File] menu, select [Print].

13 Select the printer driver you selected in 
step 7 and then click [Print].

Reference

 For details on how to send a fax from a computer, 
refer to the User's Manual Advanced.
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Authentication by User Name and Password
This section explains how to enable the access control using the authentication by the user name and 
password and how to operate when the access control is enabled.

Registering User Name and 
Password

Before enabling user authentication and access 
control, be sure to register a user name and a 
password for each user. You must be the 
administrator to register user names and 
passwords.

To register a user name and password, launch 
PIN Manager from Configuration Tool.

Reference

 For details on how to register a user name and password 
from Configuration Tool, refer to the User's Manual 
Advanced.

Enabling Access Control
You must be the administrator to control access 
to the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [Management] 
and then press .

6 Press the  to select [System Setup] 
and then press .

7 Make sure that [Access Control] is 
selected and then press .

8 Press the  to select [User/Password] 
and then press .

9 Press the  to select [User 
Authentication Method] and then 
press .

10 Make sure that [Local] is selected and 
then press .

Reference

 When you select [LDAP] or [Secure Protocol], the 
server settings are necessary. For details, refer to the 
User's Manual Advanced.

11 Press the  until the message of "Access 
Control has been enabled." is displayed.

Operation When User Name and 
Password Authentication is Enabled

Logging Into the Machine

1 Make sure that [User Name] is selected 
and then press the .

2 Enter your name.

3 Select [Enter] and then press .

4 Make sure that [Password] is selected 
and then press the .

5 Enter your password.

6 Select [Enter] and then press .

7 Press on the [Login] screen, press .
If authentication succeeds, the top screen 
appears.

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" on P. 27.

Logging Out of the Machine

When you have finished operations, be sure to 
log out of the machine.

1 Press the  until the top screen appears.

2 Press the <RESET/LOG OUT> key on 
the operator panel.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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3 Press the  or  on the confirmation 

screen to select [Yes] and then press .

Memo

 After a certain period of time, the machine automatically 
logs out users.

Operation From the Computer

Memo

 The authentication type specified on the computer 
overrides the one specified on the machine.

Printing (for Windows)
Note

 You cannot use the PCL XPS printer driver for this function.

Memo

 This procedure uses NotePad and PCL driver as an 
example. The procedures and menus may differ depending 
on the OS you use.

1 Open the file you want to print.

2 From the [File] menu, select [Print].

3 Select the printer driver you want in 
[Select Printer] and click [Preferences].

4 Select the [Job Options] tab.

5 Click [User Auth].

6 Select the [Use User Authentication] 
check box.

7 Enter the user name in [Username] and 
the password in [Password] respectively.
Clicking [Use Windows Login] automatically 
enters your login name on Windows.

8 Click [OK].

9 Click [OK] and then click [Print].

Printing (for Mac OS X)
Memo

 This procedure uses Text Edit as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Open the file you want to print.

2 From the [File] menu, select [Print].

3 Select your machine's printer driver.

4 Select [User Authentication] from the 
panel menu.

5 Select the [Use User Authentication] 
check box.

6 Enter the user name in [User Name] 
and the password in [Password] 
respectively.

7 Click [Print].

OK
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Faxing From a Computer
(For Windows Only)
Memo

 This procedure uses NotePad as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Open the file you want to fax.

2 From the [File] menu, select [Print].

3 Select your machine's fax driver in 
[Select Printer] and click [Preferences].

4 On the [Setup] tab, click [User Auth].

5 Select the [Use User Authentication] 
check box.

6 Enter the user name in [Username] and 
the password in [Password] respectively.
Clicking [Use Windows Login] automatically 
enters your login name on Windows.

7 Click [OK].

8 Click [OK] and then click [Print].

Reference

 For details on how to send a fax from a computer, 
refer to the User's Manual Advanced.
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7. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your machine.

Paper Jams
This section explains how to clear paper jams.

Reference

 For details on the location of each component of the machine, refer to "Cleaning Your Machine" on P. 168.

 For details on the location of each component of the machine, refer to "Names of Components" on P. 14.

Checking Error Messages
When a paper jam occurs, the [Paper jam] or 
[Document jam] message appears on the 
display screen and the <STATUS> key on the 
operator panel blinks. The error code and 
description differ according to where the paper 
jam occurs.

Check the error code that appears from the list 
below and refer to the relevant procedure to 
clear paper jams.

Clearing Paper Jams

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 
1500 lux). Even under the normal interior light, do not 
leave it for more than 5 minutes.

Error Code 370, 371,372

1 Remove any documents from the 
document tray if any.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

Error 
code Message Reference 

page

370 Paper Jam Occurs: 3##
Please open the scanner unit and 
the top cover And, please check.

Please see Help for details.

P.121

371 P.121

372 P.121

380 P.124

381 P.124

382 P.124

385 P.124

389 P.124

390 P.125

391 Paper Jam Occurs: 3##
Please pull out the paper cassette of 
the indicated tray. And, please check.

Please see Help for details.

P.126

392 P.126

Document Jam Occurs.
Please open the scanner unit and 
the ADF cover. And, please check.

Please see Help for details.

P.126

Possible to get burned. 

 Since the fuser unit right is extremely hot, 
perform the operation with care. The handle is not 
so hot. Hold the handle when you lift up the fuser 
unit. If it is still hot, wait for a while until the fuser 
unit gets cool and then perform the operations.

CAUTION

1
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4 Hold the blue handles (2) of the image 
drum unit with both hands and lift it out 
of the machine, and then place it on a 
flat surface.
Cover the image drum unit with black paper or a 
black bag.

5 Pull the lock levers (3) on each side of 
the fuser unit to unlock.

6 Hold the fuser unit handle (4) and lift the 
fuser unit out of the machine.

7 Insert your finger into the blue lock lever 
(5) on the both sides of the belt unit, and 
pull the lock lever to take the belt unit 
out.

8 Remove any jammed paper in the 
direction of the arrow.

2

3

3

4

5

5
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9 Hold the blue lock lever (5) on the both 
sides of the belt unit with both hands and 
place it in the machine.
Hook the roller (6) in both edges of the belt unit 
on the groove (7) in the machine, and place the 
rear end of the belt unit.

10 Push the lock levers (5) of the belt unit 
to lock.

11 Hold the fuser unit handle and place the 
fuser unit into the machine.

12 Push the lock levers (3) on each side of 
the fuser unit to lock.

13 Hold the blue handles (2) of the image 
drum unit with both hands and place it into 
the machine so that the K toner cartridge 
can be positioned in the front (8).

14 Close the top cover.

15 Close the scanner unit.

5

6

7

7

7

5

5

3

3

2

8
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Error Code 380, 381, 382, 385, 389

1 Remove any documents from the 
document tray if any.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Hold the blue handles (2) of the image 
drum unit with both hands and lift it out 
of the machine, and then place it on a 
flat surface.
Cover the image drum unit with black paper or a 
black bag.

5 Remove any jammed paper in the 
direction of the arrow.

If jammed paper is in the front inside the 
machine, pull it in the direction of the arrow.

If jammed paper is inside the fuser unit, pull it 
while pushing the blue lever (3) of the fuser unit 
in the direction of the arrow.

6 Hold the blue handles (2) of the image 
drum unit with both hands and place it into 
the machine so that the K toner cartridge 
can be positioned in the front (4).

7 Close the top cover.

8 Close the scanner unit.

1

2

3

2

4
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Error Code 390

1 Remove any documents from the 
document tray if any.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Hold the blue (2) handles of the image 
drum unit with both hands and lift it out 
of the machine, and then place it on a 
flat surface.
Cover the image drum unit with black paper or a 
black bag.

5 Open the transparent cover (3) inside 
the machine and remove the paper.

6 Hold the blue handles (2) of the image 
drum unit with both hands and place it 
into the machine so that the K toner 
cartridge can be positioned in the 
front (4).

7 Close the top cover.

8 Close the scanner unit.

1

2

3

2

4
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Error Code 391, 392

Error Code 391 indicates an error in Tray1 and 
Error Code 392 indicates a paper jam in Tray2.

Memo

 The following procedure uses tray 1 as an example.

1 Pull out and remove the paper cassette 
of the indicated tray.

2 Remove jammed paper.

3 Return the tray into the machine.

4 Open the scanner unit.

5 Press the top cover open button (1) and 
open the top cover.

6 Close the top cover.

7 Close the scanner unit.

Document Jam Occurred

When you can see the document In 
the Duplex Paper Path

1 Open the ADF cover, and pull out the 
document upward.

When you can see the document 
Inside the ADF

1 Remove any documents from the 
document tray if any.

2 Open the ADF cover.

1
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3 Hold jammed document by the top edge, 
and gently pull it out.

If the edge of the document can been seen under 
the paper guide (1), lift the paper guide and then 
pull out the document.

If the edge of the document cannot be seen in the 
ADF, lift the document tray (2) and then pull out 
the document.

Pull down the document tray.

4 Close the ADF cover.

1

2
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Error Messages
This section explains the causes and remedies for the error messages displayed on the display screen 
and the function of the <STATUS> key.

Error Messages Displayed on the Screen

Memo

 In the following lists:

- "%COLOR%" indicates C (cyan), M (magenta), Y (yellow) or K (black)

- "%TRAY%" indicates tray 1, tray 2 or the MP tray

- "%ERRCODE%" indicates an error code

- "%FS_ERR%, "%CODE%", and "%FATALSTRING1%" indicate detailed information of errors

- "%MEDIA_SIZE%" indicates paper size

- "%MEDIA_TYPE%" indicates a paper type

 If the displayed message includes "Please see Help for details", you can check countermeasures for the error by pressing the 
<?HELP> key on the operator panel.

 If in the displayed message there is "  to Close", press  on the control plan to remove the error.

Reference

 For details on the function of the <STATUS> key, refer to "Checking the Machine's Status From the <STATUS> Key" on P. 140.

General Error Messages for All Functions

Error 
code Message <Status> 

key Cause/Remedy

Inspection is required.
PU Flash Error

Blinks Firmware error occurred.
Contact Oki Data's customer support center.

Inspection is required.
PU Communication Error

Blinks Firmware error occurred.
Contact Oki Data's customer support center.

%COLOR% Toner Low.

Please see Help for details.

Lights 
up*

The toner cartridge of the indicated color is low.
Prepare a new toner cartridge.

* If the <SETTING> key > [Admin Setup] > [Device Man-
agement] > [System setup] > [Near life LED] is set to 
[Disable], the <STATUS> key does not turn on.

417 Please install new K Toner cartridge. : 417

Please see Help for details.

Blinks The waste toner receptacle is full of waste toner.
Replace it the K toner cartridge.

550
551
552
553

%COLOR% Toner Cartridge Region 
Mismatch: %ERRCODE%

Please see Help for details.

Blinks The toner cartridge is not a genuine Oki toner 
cartridge and may damage your machine. Use a 
genuine Oki toner cartridge for the indicated 
color.
550 : Y
551 : M
552 : C
553 : K

554
555
556
557

%COLOR% Toner Cartridge Region 
Mismatch: %ERRCODE%

Please see Help for details.

Blinks The toner cartridge is not intended for use with this 
model.
Use a toner cartridge which is intended for use with 
this model.
554 : Y
555 : M
556 : C
557 : K

OK OK
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614
615
616
617

%COLOR% Toner Cartridge Region 
Mismatch: %ERRCODE%

Please see Help for details.

Blinks The toner cartridge is not a genuine Oki toner 
cartridge and may damage your machine.
Use a genuine Oki toner cartridge for the 
indicated color.
614 : Y
615 : M
616 : C
617 : K

620
621
622
623

%COLOR% Toner Cartridge Region 
Mismatch: %ERRCODE%

Please see Help for details.

Blinks The toner cartridge is not a genuine Oki toner 
cartridge and may damage your machine.
Use a genuine Oki toner cartridge for the 
indicated color.
620 : Y
621 : M
622 : C
623 : K

Non Genuine %COLOR% Toner cartridge.

Please see Help for details.

Lights up The toner cartridge is not a genuine Oki toner 
cartridge and may damage your machine.
Use a genuine Oki toner cartridge for the 
indicated color.

Image Drum Unit Near Life.

Please see Help for details.

Lights 
up*

The image drum unit is near the end of its life.
Prepare a replacement image drum unit.

* If the <SETTING> key >[Admin Setup] > [Device Man-
agement] > [System setup] > [Status in Near life] is set 
to [Enable] and [Near life LED] is set to [Disable], the 
<STATUS> key does not turn on.

If [Status in Near life] is set to [Disable], this message is 
not displayed and the <STATUS> key does not turn on.

Fuser Unit Near Life.

Please see Help for details.

Lights 
up*

The fuser unit is near the end of its life.
Prepare a replacement fuser unit.

* If the <SETTING> key > [Admin Setup] > [Device Man-
agement] > [System setup] > [Status in Near life] is set 
to [Enable] and [Near life LED] is set to [Disable], the 
<STATUS> key does not turn on.

If [Status in Near life] is set to [Disable], this message is 
not displayed and the <STATUS> key does not turn on.

Belt Unit Near Life.

Please see Help for details.

Lights 
up*

The belt unit is near the end of its life.
Prepare a replacement belt unit.

* If the <SETTING> key > [Admin Setup] > [Device Man-
agement] > [System setup] > [Status in Near life] is set 
to [Enable] and [Near life LED] is set to [Disable], the 
<STATUS> key does not turn on.

If [Status in Near life] is set to [Disable], this message is 
not displayed and the <STATUS> key does not turn on.

354 Please change Fuser Unit. : 354

Please see Help for details.

Blinks The fuser unit is at the end of its life. This error 
indicates the end of its life according to the 
counter, and the current job is stopped.
Replace it with a new fuser unit.

Please change Fuser Unit.

Please see Help for details.

Lights up The fuser unit is at the end of its life.
Replace it with a new fuser unit.

355 Please change Belt Unit. : 355

Please see Help for details.

Blinks The belt unit is at the end of its life. This error 
indicates the end of its life according to the 
counter, and the current job is stopped.
Replace it with a new belt unit.

Error 
code Message <Status> 

key Cause/Remedy
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356 Please change Belt Unit. : 356

Please see Help for details.

Blinks The belt unit is at the end of its life.
Replace it with a new belt unit.

Please change Belt Unit.

Please see Help for details.

Lights up The belt unit is at the end of its life.
Replace it with a new belt unit.

410
411
412
413

%COLOR% Toner Empty.
%ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is 
empty.
Replace it with a new toner cartridge.
410 : Y
411 : M
412 : C
413 : K

%COLOR% Toner Empty. : 

Please see Help for details.

Lights up The toner cartridge of the indicated color is 
empty.
Replace it with a new toner cartridge.

610
611
612
613

%COLOR% Toner cartridge not 
installed. : %ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is not 
properly installed.
Reinstall it properly.
610 : Y
611 : M
612 : C
613 : K

%COLOR% Toner cartridge not installed.

Please see Help for details.

Lights up The toner cartridge of the indicated color is not 
properly installed.
Reinstall it properly.

Please change Fuser Unit.

Please see Help for details.

Lights up The image drum unit is at the end of its life.
Replace it with a new image drum unit.

%TRAY% Empty.

Please see Help for details.

Lights up The indicated tray is empty.
Load paper in the tray.

File System is Full.

Please see Help for details.

Lights up The file system is full.

File System is Write Protected.

Please see Help for details.

Lights up The file system to which you tried to write is 
write-protected.

Error 
code Message <Status> 

key Cause/Remedy
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Memory Overflow.
Please see Help for details.

 to Close

Blinks The memory overflowed.
If you perform other tasks simultaneously, finish 
them and try again. If that does not work, reduce 
the print resolution.

420 Memory Overflow. : 420
Please see Help for details.

 to Close

Blinks The memory overflowed.
Reduce the print resolution. If that does not 
work, reduce the size of the print data.

Access limitation error.
Deleted unauthorized user data.

Please see Help for details.

 to Close

Blinks The machine deleted the job of an unauthorized 
user.

Accounting Log Buffer is Near Full.

Please see Help for details.

Lights up The job accounting log buffer is nearly full.

Accounting Log Buffer Full (Delete old logs) Lights up Old accounting logs are deleted because the 
accounting log buffer is full.

Accounting Log Writing Error

Please see Help for details.

 to Close

Blinks A job accounting log writing error occurred.

Disk Operation Error %FS_ERR%.

Please see Help for details.

 to Close

Blinks A disk operation error occurred.

Check Data
Message Data Write Error : %CODE%.

Please see Help for details.

Blinks Failed to write message data to be uploaded.
Contact Oki Data's customer support center.

Please check %COLOR% Toner cartridge.

Please see Help for details.

Lights up Something is wrong with the toner sensor of the 
indicated color during printing.
Check that the toner cartridge of the indicated 
color is installed properly.

540
541
542
543

Please check %COLOR% Toner cartridge. :
%ERRCODE%

Please see Help for details.

Blinks Something is wrong with the toner sensor of the 
indicated color.
Check that the toner cartridge of the indicated 
color is installed properly.
540 : Y
541 : M
542 : C
543 : K

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK
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544
545
546
547

Please check %COLOR% Toner cartridge. :
%ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is not 
locked properly.
Check the lock lever is properly slid to the left.
544 : Y
545 : M
546 : C
547 : K

370
371
372
380
381
382
385
389
390

Paper Jam: %ERRCODE%
Please open the scanner unit and the top 
cover.

Please see Help for details.

Blinks Paper jam occurred.
Remove the jammed paper.

391
392

Paper Jam: %ERRCODE%
Please pull out the paper cassette of the 
indicated tray.

Please see Help for details.

Blinks Paper jam occurred while feeding paper from the 
indicated tray.
Remove the jammed paper.
391 : Tray1
392 : Tray2

348 Reinstall the fuser unit. :348

Please see Help for details.

Blinks The fuser unit is not properly installed.
Reinstall it properly.

320 Reinstall the fuser Unit. : 320

Please see Help for details.

Blinks The belt unit is not properly installed.
Reinstall it properly.

330 Reinstall the Belt unit. : 330

Please see Help for details.

Blinks The belt unit is not properly installed.
Reinstall it properly.

321 Power Off and wait for a while. : 321

Please see Help for details.

Blinks Motor Driver IC overheat is detected.
Turn the machine off and wait for a while.

310 Please check the top cover.: %ERRCODE%

Please close the top cover.

Please see Help for details.

Blinks The top cover is open.
Close the top cover.

Check ADF cover.

Please see Help for details.

Blinks The ADF cover is open.
Close the ADF cover.

Error 
code Message <Status> 

key Cause/Remedy
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Restart the device.
%ERRCODE%: Error

Blinks An error occurred in the device.
Turn the machine off and then on again.
If the error is not resolved, contact Oki Data's 
customer support center.

Inspection is required.
%ERRCODE: Error

Blinks An error occurred in the device.
Contact Oki Data's customer support center.

Restart the device.
%ERRCODE%: Error %FATALSTRING1%

Blinks An error occurred in the device.
Turn the machine off and then on again.
If the same error occurs, turn the machine off 
and then on again. If the error is not resolved, or 
the same error occurs again, contact Oki Data's 
customer support center.

Document Jam
Please open the scanner unit and the ADF 
cover.

Please see Help for details.

Blinks A document jam occurred.
Open the ADF cover, and then remove the 
jammed paper.

Lamp Error. Please call service. 
<%CODE%>

Please see Help for details.

Blinks Indicates that the lamp error is occurred.
This message is displayed because of the light 
intensity of lamp is weaker.
Contact Oki Data's customer support center.

%TRAY% missing.

Please see Help for details.

Lights up A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated tray.
If the cassette is already inserted in the machine, 
pull out the cassette and set it again to correctly 
locate it.

430
440

Please close %TRAY%.: 430,440
To cancel, select [Cancel]

Blinks A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated tray.
If the cassette is already inserted in the machine, 
pull out the cassette and set it again to correctly 
locate it.

Inspection is required.
%ERRCODE%: SIP Error

Blinks Processing of scanned image has failed.
Turn the machine off and then on again.
If the error is not resolved, contact Oki Data's 
customer support center.

Please call service.
Scanner unit failed to detect printer unit.

Blinks An error occurred between the scanner and 
printer units.
Turn the machine off and then on again.
If the error is not resolved, contact Oki Data's 
customer support center.

SIP Firmware Missing.

Please see Help for details.

Blinks A board failure has been detected.
Turn the machine off and then on again.
If the error is not resolved, contact Oki Data's 
customer support center.

Wait a moment.
Network initializing ...

Lights up Changed network settings are being stored.

085 Please change SD Card Blinks The contents of the SD memory card cannot be 
read normally.
If the same card is used further, the same error 
may occur. Replace the SD memory card.

Error 
code Message <Status> 

key Cause/Remedy
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Error Messages for Copying

The following messages are displayed on the display screen of the operator panel while using the copy 
function.

Error Messages for Faxing

The following messages are displayed on the display screen of the operator panel while using the fax 
function.

Error 
code Message <Status> 

key Cause/Remedy

Off Line Mode. Lights up The machine is off line and cannot start a copy 
job.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Do you wish to resume scanning? Lights up Scanning for a copy job is suspended because an 
error occurred, but now the error is resolved.
To restart scanning the remaining documents, 
set the documents in the ADF and then select 
[Yes].

Error 
code Message <Status> 

key Cause/Remedy

Received invalid data.

Please see Help for details.

 to close

Blinks The machine received and deleted unauthorized 
PC fax data. While the machine received the PC 
fax data, the connection with the computer might 
be unstable.
Check the connection between the machine and 
the computer.

Memory Overflow Rx

 to close

Blinks The memory overflowed while receiving fax data.
Ensure the memory capacity by any of the 
following operations.
 if the time specification for fax transmission is 

set, cancel it.
Delete documents stored in F-code box.
Or this message may be displayed when an error 
occurs in the machine. Release the error.

Communication error

 to close

Blinks Fax transmission and reception is canceled due to 
errors. 

Telephone

Please see Help for details.

Lights up The telephone is being used.
Wait for the call on the telephone lines to end.

OK

OK

OK
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Error Messages for Scanning

The following messages are displayed on the display screen while using the scan function.

Memory Overflow.

Please see Help for details.

 to close

Blinks The memory overflowed while receiving PC fax 
data.
Ensure the memory capacity by any of the 
following operations.
 if the time specification for fax transmission is 

set, cancel it.
Delete documents stored in F-code box.
Or this message may be displayed when an error 
occurs in the machine. Release the error.
If the error is not resolved, reduce the data to be 
transmitted as PC Fax.

Off Line Mode. Lights up The machine is off line and cannot print received 
fax data.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Error 
code Message <Status> 

key Cause/Remedy

Cancelling. Lights up A ScanTo job is being cancelled.

Cancelling transmission. Lights up An e-mail or file transmission is being cancelled.

Memory Overflow.

Please see Help for details.

 to close

Blinks The memory overflowed while scanning data.

USB Memory Full.

Please see Help for details.

 to close

Blinks The USB memory is full and cannot store data.
Delete unnecessary files from the USB memory, 
or use a USB memory with enough available 
space.

Writing Failed.

Please see Help for details.

 to close

Blinks Writing to the USB memory failed.
Remove the write-protection of the connected
USB memory.

USB Memory disconnected.

Please see Help for details.

 to close

Blinks USB memory is not connected to the machine 
and the machine cannot store data.
Be sure that the USB memory is connected to 
the machine properly.

Connect to PC failed.

Please see Help for details.

 to close

Blinks The machine failed to connect to a PC.
Be sure that the machine is connected to the PC 
properly.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK
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File Transmission Error

Please see Help for details.

 to close

Blinks A file transmission error occurred.
Check the network configuration, cable 
connection and status, and the server status.

E-mail Transmission Error

Please see Help for details.

 to close

Blinks An e-mail transmission error occurred.
Check the network configuration, cable 
connection and status, and the server status.

Please check SMTP settings.

Please see Help for details.

 to close

Blinks An error occurred while connecting to an SMTP 
server.
Check the network configuration, cable 

connection and status, and the server status.
Check the SMTP settings.

Please check POP3 settings.

Please see Help for details.

 to close

Blinks An error occurred while connecting to a POP3 
server.
Check the network configuration, cable 

connection and status, and the server status.
Check the POP3 settings.

SMTP Login Failed.

Please see Help for details.

 to close

Blinks Logging in to an SMTP server failed.
Check the login name and password for the 
server.

SMTP Auth. Unsupported.

Please see Help for details.

 to close

Blinks An SMTP server does not support authentication.

POP3 Login Failed.

Please see Help for details.

 to close

Blinks Logging in to a POP3 server failed.
Check the login name and password for the 
server.

Getting Target IP Failed.
Check DHCP Settings.

Please see Help for details.

Blinks The machine could not get IP address from DHCP 
server.
Check the network configuration, cable 
connection and status, and the server status.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK

OK
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Please check DNS settings.

Please see Help for details.

 to close

Blinks An error occurred while connecting to a DNS
server, or the machine failed to obtain IP 
address.
Check the network configuration, cable 

connection and status, and the server status.
Check the DNS settings.
Check the [Target URL] in the profile, and 

check that the computer name has been 
correctly set.

 If there is no DNS server on the network, set 
the IP address, not the computer name, in the 
profile [Target URL].

 If the username is managed from the domain, 
input "Username @ Domainname" on 
[Username] settings.

Please check Server setting.

Please see Help for details.

 to close

Blinks An error occurred while connecting to a file 
server.
Check the network configuration, cable 

connection and status, and the server status.
Check the server settings.
 If the username is managed from the domain, 

input "Username @ Domainname" on 
[Username] settings.

Server Login Failed.

Please see Help for details.

 to close

Blinks Logging in to file server failed.
Check the ID and password for the server.

Entering Directory Failed.

Please see Help for details.

 to close

Blinks The machine failed to access the FTP server 
directory.

Changing Data Transfer Type Failed.

Please see Help for details.

 to close

Blinks The machine failed to transmit a file to an FTP 
server.
Change the data transfer type for the file.

File Writing Failed.

Please see Help for details.

 to close

Blinks The machine failed to write to a file.
Check that the username set on the computer 

and the [Username] set on the profile match 
one another.

 It is possible that the settings are configured to 
not allow writing to common folders. Check the 
folder shared settings.

Storage Space Full.

Please see Help for details.

 to close

Blinks The storage space of the server is full. The 
machine failed to write to a file.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK

OK
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Error Messages for Printing

Please change File Name.

Please see Help for details.

 to close

Blinks A file name was unauthorized by the server.
Change the file name.
 If using an FTP server to save data with Scan 

to Network PC, there are some machines that 
cannot be connected correctly due to 
mismatching character codes used. Change 
[Host side Japanese Kanji code]. If using a 
Mac for the FTP server, change [Host side 
Japanese Kanji code] to [UTF-8].

Unsupported Server.

Please see Help for details.

 to close

Blinks The machine does not support the specified 
server.
If using NAS to save data with Scan to Network 
PC, in rare cases there are machines that cannot 
connect correctly with CIFS. Change the profile 
[CIFS Character Set] to [Shift-JIS] from 
[UTF-16].

Please check Network Share Name.

Please see Help for details.

 to close

Blinks The name of a network shared folder is invalid.
 The machine failed to establish a CIFS 

connection.
Change the name of the shared folder.

Please remove the connected USB 
device.

Unsupported USB device is 
connected.

Blinks Indicates that  the unsupported USB device was 
connected.
This message will be displayed until the 
unsupported USB device disconnected.

Remove the USB Hub.

USB Hub is connected.

Blinks USB hub is connected. This machine does not 
support a USB hub.
Disconnect the USB hub.

Error 
code Message <Status> 

key Cause/Remedy

Off Line Mode. Lights up The machine is off line and cannot start a print 
job.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Postscript Error

 to close

Blinks A Postscript error occurred.

PDF Cache Write Error Lights up Writing failed while caching a PDF, as there was 
no space on an SD card or in memory.
 Increase the amount of free capacity on the SD 

memory card. (MC561dn only).
 Increase the amount of memory (for cases 

other than MC561dn).

PDF Error 

 to close

Lights up A methodology error was detected in a PDF.
Please check whether the PDF file opened 
correctly.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK
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This PDF file is password-protected.

 to close

Lights up This is a PDF file with the encryption function 
enabled.
When printing an encrypted PDF file, open it in 
your computer and then print it.

This PDF file can only be printed with 
the owner password.

 to close

Lights up This is a PDF file with the encryption function 
enabled.
When printing an encrypted PDF file, open it in 
your computer and then print it.

Deleting data. Lights up Cancelling received data.

Lights up If a paper jam occurs while the <SETTING> key > 
[Admin Setup] > [Print Setup] > [Print menu] > 
[Printer Adjust] > [Jam Recovery] is set to 
[Disable], the remaining print job is cancelled.

Lights up Cancelling data sent by a user who is not 
authorized by Print Control to print.

Deleting encrypted job. Lights up Deleting an encrypted job.

File Erasing. Lights up Erasing a secret file.

Erased Data Full.

Please see Help for details.

Blinks Secret files to be erased are full.

Expired Secure Job.

Please see Help for details.

 to close

Blinks The machine deleted an expired secure job.

Received invalid data.

Please see Help for details.

 to close

Blinks The machine deleted an expired secure Job.

500 Please install paper on MP Tray.
Please set paper (%MEDIA_SIZE%)
To cancel, select [Cancel]

Blinks The MP tray is empty.
Load the indicated size paper.

460
461
462

Tray Media Mismatch: %ERRCODE%
Please install paper (%MEDIA_SIZE% 
%MEDIA_TYPE%) on %TRAY%.

Blinks The paper size or type in the indicated tray 
differs from that specified for the tray.
Load the indicated size or type of paper.

490
491
492

Tray Media Mismatch: %ERRCODE%
Please install paper (%MEDIA_SIZE% 
%MEDIA_TYPE%) on %TRAY%.

Blinks The indicated tray is empty.
Load the indicated size paper.

430
440

Please close %TRAY%.: 430,440

To cancel, select [Cancel]

Blinks A paper cassette of the indicated tray is not in 
the machine.
Install the paper cassette.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK
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Checking the Machine's Status From the <STATUS> Key
From the <STATUS> key on the operator panel, you can check the status of your machine.

Checking the Trouble Status

The <STATUS> key blinks or lights up when any trouble is occurring in your machine. Press it to check 
the trouble status.

1 Press the <STATUS> key on the 
operator panel to open the status menu.

2 Be sure that [System Status] is 

selected and then press .

3 Press the  to select the item you want 

to check and then press .

Checking the Device and Job Status

You can check the device status, such as the residual life of the consumable items, and job lists from the 
<STATUS> key.

1 Press the <STATUS> key on the 
operator panel to open the status menu.

2 Press the  to select [Device 
Information] and then press .

3 Press the  to select the item you want 
to check and then press .

Access limitation error
Monochrome printing was performed
Due to the color printing limitation.
Please see Help for details.

 to close

Blinks A color print job sent by a user who is not 
authorized for color printing is printed in 
monochrome.

Access limitation error
Data was deleted due
to the color printing limitation.
Please see Help for details.

 to close

Blinks A color print job sent by a user who is not 
authorized for color printing is deleted.

Access limitation error
Data was deleted due
to the printing limitation.
Please see Help for details.

 to close

Blinks A print job sent by a user who is not authorized 
for printing is deleted.

Warming Up. Lights up The machine is warming up, or cooling down.
Wait for a while without turning off the machine.
This is not a malfunction of the machine.

Preparing. Lights up The printer unit is not prepared for printing.
Wait until this message disappears.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK

OK
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Other Troubles
This section explains the troubles you may encounter while operating your machine and how to solve them.

Unable to Print from a Computer

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.
 For troubles caused by an application, contact the manufacturer of the application.

General Causes

Common to Windows and Mac OS X

For Windows

Cause Remedy Reference

The machine is in the sleep mode. Press the <POWER SAVE> key on the operator panel to 
enter the standby mode.
If the sleep mode is not used, disable it from the <SET-
TING> key > [Admin Setup] > [User Install] > 
[Power Save] > [Sleep].

P.20

The machine is turned off. Turn on the machine. P.19

An Ethernet or USB cable is unplugged. Check that the cable is plugged into the machine and 
computer properly.

-

Something is wrong with a cable. Replace it with a new cable. -

The machine is off line. Press the <PRINT> key on the operator panel, and then 
select [On-Line].

-

An error message is displayed on the 
display screen of the operator panel.

"Error Messages Displayed on the Screen" on P. 128 or 
press the <?HELP> key on the operator panel.

P.128

The interface setting is disabled. Check the setting of the interface being used from the 
operator panel.

Advanced

Something is wrong with the print 
function.

Check if you can perform configuration print. P.73

Cause Remedy Reference

The machine is not set as the default printer. Set the machine as the default printer. -

The output port for the printer driver is 
incorrect.

Select the output port to which the Ethernet or USB 
cable is connected.

-

A print job from another interface is in 
progress.

Wait until the print job is done. -

[Received invalid data] is displayed on 
the display screen and printing cannot be 
done.

Press the <SETTING> key and select [Admin Setup] >
[Print Setup] > [Print menu] > [Printer Adjust] > 
[Wait Timeout], and then select a longer time. The 
default setting is 40 seconds.

-

A print job is automatically canceled. If using Print Job Control, the print job is not authorized 
to print, or the Job Accounting log buffer may be full.

Advanced
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Network Connection Problems

Common to Windows and Mac OS X

For Windows

USB Connection Problems

Common to Windows and Mac OS X

For Windows

Cause Remedy Reference

Using a crossover cable. Use a straight cable. -

The machine is turned on before a cable 
was connected.

Connect cables before turning on the machine. P.31

The hub and the machine are incompatible 
or have some problem.

Press the <SETTING> key and select [Admin Setup] > 
[Network Menu] > [Network Setup] > [HUB Link 
Setting], and then select [10BASE-T HALF].

-

Cause Remedy Reference

IP address is incorrect. Check that the same IP address is set for the machine 
and the machine's port setting on the computer.

 If using LPR Utility, check the IP address setting in LPR 
Utility.

P.45

Cause Remedy Reference

Unsupported USB cable is being used. Use a USB2.0 cable. -

An USB hub is being used. Directly connect the machine to the computer. P.40

Printer driver is not installed correctly. Reinstall printer driver. P.40

Cause Remedy Reference

The machine is off line. Right-click the OKI MC561 icon and then select [See 
print jobs] (> [OKI MC561(*)] when multiple drivers 
are installed). In the dialog box, select the [Printer] 
menu and then clear the check of [Use Printer Offline].

*  Select the type of driver you want.

-

A switch, buffer, extension cable or USB 
hub is being used.

Directly connect the machine to the computer. P.40

A printer driver which uses a USB 
connection has been installed.

Remove the other printer driver from the computer. -
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Unable to Install a Printer Driver Successfully

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.

 For troubles caused by an application, contact the manufacturer of the application.

USB Connection Problems

For Windows

Cause Remedy Reference

An icon of the machine is not created on 
the [Devices and Printers] folder.

The printer driver is not installed correctly.
Reinstall the printer driver correctly.

P.40

Only the first printer driver is installed 
even if multiple printer drivers are 
selected to install.

Follow the procedure below to install a second and 
subsequent printer drivers:
1.Insert the "Software CD-ROM" into the computer.
2.Click [Run setup.exe] and follow the on-screen 
instructions.
3. Select [Custom Installation (Printer)] from 
[Driver Installation].
4. Click [Next].
5. Select [Local Printer] and then click [Next].
6. On the [Select printer port] screen, select [FILE] 
and then click [Next].
7. Complete the setup following the on-screen 
instructions.
8. On the [Devices and Printers], right-click the icon 
of the second or later driver and select [Printer 
properties] ( [OKI MC561(*)] when multiple drivers 
are installed).

*Select the type of driver you want.

9. From the [Ports] tab, select [USBxxx] from the list.
10. Click [OK].

-

The [Unable to install printer driver] 
error message is displayed.

Use Plug-and-Play. Follow the procedure below:
1. Ensure that the machine and computer is turned off.
2. Connect a USB cable.
3. Turn on the machine.
4. Turn on the computer.
5. When the Found New Hardware Wizard is displayed, 
follow the on-screen instructions to complete the setup.
For details, refer to [README.TXT] in the "Software 
CD-ROM".

-
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Restrictions on Each OS

Restrictions on Windows 7/Windows Vista/Windows Server 2008 R2/
Windows Server 2008

Item Symptom Cause/Remedy

Printer drivers [Help] is not displayed. The [Help] function is not supported on PS printer drivers.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

Network Extension [Help] is not displayed. The [Help] function is not supported.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start. 

The [Program Capability
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].

Color Correct Utility The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].

Color Swatch Utility The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].

PS Gamma Adjuster The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].
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Restrictions on Windows Server 2003 Service Pack 1 and Windows XP Service 
Pack 2

Restrictions on Windows Firewall
On Windows Server 2003 Service Pack 1 and Windows XP Service Pack 2, the Windows firewall 
functionality is enhanced. The following restrictions may apply to printer drivers and utilities.

Memo

 The following procedures are explained using Windows XP Service Pack 2 as an example. The procedure and menu names may 
differ on Windows Server 2003 Service Pack 1.

Item Symptom Cause/Remedy

Printer driver You cannot print a file when using the 
machine as a shared printer on a network.

On the server, click [start] and then select 
[Operator panel] > [Security Center] > 
[Windows Firewall].
Select the [Exceptions] tab and select the 
[File and Printer Sharing] check box. Click 
[OK].

LPR Utility Unable to find a machine. If the [Don't allow exceptions] check box is 
selected on the [General] tab of the Windows 
firewall, you cannot search for a machine in a 
segment that is connected to another router. 
Only machines within the same segment as 
the machine are the search target.
When you cannot find a machine, specify the IP
address of the machine in the [Add Printer] or
[Confirm Connections] screen.

Storage Device 
Manager

Unable to search a machine. If the [Don't allow exceptions] check box is 
selected on the [General] tab of Windows 
Firewall, you cannot search for a machine in a 
segment that is connected to another router. 
Only machines within the same segment as 
the machine are the search target.
When you cannot find a machine, enter the 
machine name (arbitrary) and IP address in 
[Printer] > [Add or Remove Printer] and 
click [Add].

Print Super Vision Unable to access the machine from a remote 
computer.

Click [start] and then select [Operator 
panel] > [Security Center] > [Windows 
Firewall].
Select the [Exception] tab and click [Add 
Program]. Select the following files and then 
click [Open] > [OK] > [OK].
 "(J2EE location)\jdk\bin\java.exe"
 "(J2EE location)\jdk\bin\javaw.exe"
 "(J2EE location)\jdk\jre\bin\java.exe"
 "(J2EE location)\jdk\jre\bin\javaw.exe"

Pop-up windows are blocked. If you are using Internet Explorer, pop-up win-
dows may be blocked.
On Internet Explorer, select [Internet 
Options] from the [Tools] menu.
Select the [Privacy] tab and click [Settings] 
on the [Pop-up Blocker] area. On the 
[Popup Blocker Settings] window, enter the 
URL of Print Super Vision in [Address of Web 
site to allow] and then click [Add]. Click 
[Close] > [OK].



Other Troubles

- 146 -

Restrictions on Mac OS X 10.6

Restrictions on Mac OS X 10.5

Web Driver 
Installer

Unable to find a machine. If the [Don't allow exceptions] check box is
selected on the [General] tab of Windows
Firewall, you cannot search for a machine in a 
segment that is connected to another router.
Only machines within the same segment as 
the machine are the search target.
Enter "*" in the fourth digit of the IP address 
range to search.

Unable to access the machine from a remote 
computer.

Click [start] and then select [Operator 
panel] > [Security Center] > [Windows 
Firewall].
Select the [Exception] tab and click [Add 
Port]. Add the port number of the web site on 
which Driver Installer is installed.
Click [start] and then select [Operator 
panel] > [Performance and Maintenance] 
> [Administrative Tools].
Double-click [Component Services] and 
change the access authority of the component 
for Driver Installer.
For details on how to configure the settings, 
refer to the readme file stored in [start] > [All 
Programs] > [Okidata] > [Driver Installer] 
> [Readme].

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture.  Scan is available only when the computer is 
connected by USB.

 In the image capture, the user interface of 
TWAIN driver is not displayed. Use the user 
interface of the image capture and then 
scan data.

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture. In the image capture, if the computer is con-
nected to the network, display the user inter-
face of the TWAIN driver before using. 
To display the user interface of the TWAIN 
driver, after starting the image capture, select 
[Browse Devices] from the [Devices] menu 
of the image capture and then open the 
device browser. Select a driver and click use 
[Use TWAIN UI].

Item Symptom Cause/Remedy
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Restrictions on Mac OS X 10.4

Restrictions on Mac OS X 10.3.9

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture In the image capture, if the computer is con-
nected to the network, display the user inter-
face of the TWAIN driver before using. 
To display the user interface of the TWAIN 
driver, after starting the image capture, select 
[Browse Devices] from the [Devices] menu 
of the image capture. Select a driver in 
[TWAIN devices] and then check the check-
box of [Use TWAIN software] shown in the 
lower right screen.

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture If connecting to a computer and a network, 
use Image Capture with the TWAIN driver 
user interface displayed. In order to display 
the TWAIN driver user interface, after 
launching Image Capture, select 
[Environment Settings] from the [Image 
Capture] menu. Select the [Scanner] tab 
and put a check in the [Use TWAIN 
Software When Possible] checkbox.

The scanner is not displayed in the device 
browser of the image capture.

Log into the computer again.



Other Troubles

- 148 -

Copying Troubles

Memo

 If the following information does not solve your trouble, contact Oki Data's customer support center.

Unable To Copy

Symptom Point to check Remedy Reference

Unable to copy. Is the machine turned on? Turn on the machine. P.19

Is the machine initializing? Wait until initializing is done. -

Is your document properly loaded 
on the machine?

Load the document properly on the 
machine.

P.72

Is there paper in the tray? Load paper in the tray.
Or, check that the paper cassette is 
installed on the machine.

P.66

Is the proper size of paper for your 
document loaded in the tray?

Load the proper size of paper for 
your document.

P.66

Is the paper tray selectable when 
[Paper Feed] is set to [Auto]?

Press the <SETTING> key and 
select [Paper Setup] > [Select 
Tray] > [Copy] > the paper tray 
on which the paper you use is 
loaded, and then select [ON] or 
[ON(Prior)].

-

Is the loaded paper compatible 
with duplex printing?

Duplex copying cannot be done 
depending on the paper size, 
document type, or document 
weight.
Load the right paper for duplex 
printing and configure the paper 
size, document type, and 
document weight correctly.

P.66

Is the media type of the paper tray 
set to [Plain] or [Recycled]?

When setting [Paper feed] to 
[Auto], set the media type for the 
paper tray to [Plain] or [Recy-
cled].

P.69

Is there a paper jam? Check the error message and 
remove any jammed paper.

P.121

Is there an empty toner cartridge? Replace it with a new toner 
cartridge.

P.161

Is the image drum unit at the end 
of its life?

Replace it with a new image drum 
unit.

P.163

Is the fuser unit at the end of its 
life?

Replace it with a new fuser unit. P.166

Is the belt unit at the end of its 
life?

Replace it with a new belt unit. P.165

Are any covers on the machine 
open?

Close all the covers. P.14

Is an error occurring? Clear the error. P.128

Is another job in progress? Start copying after the other job is 
complete.

-

Is a print job from a computer or 
other device in progress?

Wait until printing is complete. -

Is a fax being transmitted in real 
time?

Wait until the transmission is 
complete.

-



Other Troubles

- 149 -

Tro
u
b
lesh

oo
tin

g

7

The Copied Output Is Different from the Original Document

Unable to copy. Is the Continuous Scan mode on? Select [Scan completed] on the 
display screen.

P.77

Is the machine off line? Press the <PRINT> key on the 
operator panel, and then select 
[On-Line/Off-Line].

-

Do you have access to make 
copies?

Enter your authorized PIN or user 
name and password.

P.114

Unable to copy mixed 
size documents.

Is [Mixed Size] set to [OFF]? Set [Mixed Size] to [ON]. Advanced

Is the size of your document 
compatible for making mixed size 
copies?

Use documents of sizes supported 
for mixed size copying.

Advanced

Is paper of all the sizes of your 
original loaded?

Load paper of the required sizes on 
each paper tray. The paper trays 
need to be set to [ON] or [ON 
(Prior)] from the <SETTING> 
key > [Paper Setup] > [Select 
Tray] > [Copy].

-

Unable to sort copies. Is [Sort] set to [OFF]? Set [Sort] to [ON]. Advanced

Is there memory overflow? Install additional RAM (optional), 
or reduce the number of 
documents.

P.23

Symptom Point to check Remedy Reference

The copied output is 
different from the 
original document.

Is [DuplexCopy] enabled? Set [DuplexCopy] to [OFF]. P.77

Is [Mixed Size] set to [ON]? Set [Mixed Size] to [OFF]. Advanced

The size of the copied 
output is different from 
the size of the original 
document.

Is the proper size paper for the 
document loaded on the paper 
tray?

Load the proper size paper for the 
document.

P.66

Is the zoom ratio properly set? Set the proper zoom ratio. P.76

Is [Repeat] set to [ON]? Set [Repeat] to [OFF]. Advanced

A part of the document 
image is missing on the 
copied output.

Is [Edge Erase] set to [ON]? Set [Edge Erase] to [OFF]. Advanced

Is [Margin] set to [ON]? Set [Margin] to [OFF]. Advanced

Is [N-in-1] set to [ON]? Set [N-in-1] to [OFF]. Advanced

Symptom Point to check Remedy Reference
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Troubles after Starting to Copy

Faxing Troubles

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.

Unable to Send a Fax

Symptom Point to check Remedy Reference

The machine is slow to 
start copying.

Is [Warming Up] or [Preparing] 
displayed on the display screen?

The machine is preparing.
Wait until it starts copying.

-

A copy job is cancelled. Is any error occurring? A copy job is cancelled when 
specific errors occur while copying.
Clear the error and start the copy 
job again.

P.128

Is there paper on the MP tray? When copying using paper from 
the MP tray, check if enough paper 
is loaded on the MP tray before 
starting to copy. And, press the 
<SETTING> key and select 
[Paper Setup] > [Select Tray] > 
[Copy] > [MP tray], and then 
check that [ON] or [ON (Prior)] is 
selected.

-

Symptom Point to check Remedy Reference

Unable to send a fax. Did you perform the correct 
procedure?

Check the appropriate procedure 
and try again.

P.80

Did you specify the correct 
number?

If you use speed dial, print the 
speed dial list and check the entry.

P.81
Advanced

Did you specify the appropriate 
dial line type?

Specify the appropriate dial line 
type for your region.

P.62

Is it due to the recipient machine? Contact the recipient and ask him 
to check the machine status.

-

The machine does not 
continuously send a 
document.

Did you load the document 
correctly on the ADF?

Keep the leading edges of the 
pages in the document even.

P.72

Did you load a document other 
than A4, letter or legal 13/13.5/14 
on the ADF?

Only A4, letter, and legal 13/13.5/ 
14 size documents can be sent 
from the ADF.

-

The machine does not 
send a fax even though 
you dialed the number 

and pressed .

Did you specify the appropriate 
dial line type?

Specify the appropriate dial line 
type for your region.

P.62

Did you load the document 
correctly?

Load the document correctly. P.72

Did you dial the correct number? Dial the correct number. -

Is the recipient's line busy? Wait until the line is open and try 
again.

-

Unable to transmit a fax 
manually.

Did you put down the handset 

before pressing ?
Press  first and then put 
down the handset.

Advanced

The machine does not 
start scanning (during 
memory transmission).

Did you load the document 
correctly?

Load the document correctly. P.72

Is there enough memory? Check the available memory. Advanced

MONO

MONO

MONO
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Unable to Receive a Fax

Unable to Send or Receive a Fax

The Machine Does Not Select the Appropriate Paper for the Received Fax

Symptom Point to check Remedy Reference

Unable to receive a fax. Did you specify the appropriate 
reception mode?

Check the reception mode P.85

Is there paper in the tray? Load the paper. P.66

Is there a paper jam? Check the error message and 
remove the jammed paper.

P.121

Is the telephone cable correctly 
connected to the machine?

Connect the telephone cable 
correctly.

P.59

Is there enough memory? Check the available memory. Advanced

Did you connect to the line 
supporting the Number Display?

The machine does not support the 
line supporting the "Number Dis-
play".
To use the machine connecting the 
line supporting the "Number Dis-
play" and a phone supporting the 
Number Display connected to the 
TEL connection of the machine, set 
[Ring Response] of the machine 
to any of [10 sec.], [15 sec.] and 
[20 sec.]

Advanced

Unable to receive a fax 
manually. 

Did you put down the handset 

before pressing ?
Press  first and then put 
down the handset.

P.85

Did you answer the phone after 
one call.

If you use the phone supporting 
the "Number Display", when 
answering the phone after one call, 
you may be unable to receive a fax 
manually.
You should answer the phone after 
2 or more calls.

-

F code polling fails and 
an error message is 
printed out.

Did the sender store a document in
a bulletin box?

Contact the sender and ask him to 
store the polling document.

-

Symptom Point to check Remedy Reference

Unable to send or 
receive a fax.

Did you install an IP phone on the 
machine in a broadband 
environment?

Press the <SETTING> key and 
select [Admin Setup] > [User 
Install] > [Super G3] > [OFF].

-

Symptom Point to check Remedy Reference

The machine does not 
select the appropriate 
size paper for the 
received fax.

Did you specify other than [Plain] 
or [Recycled] in [Media Type] 
for the paper tray used for fax 
reception?

Specify [Plain] or [Recycled] in 
[Media Type] for the paper tray 
used for fax reception.

Advanced

MONO

MONO
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Scanning Troubles

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.

Image Quality Troubles

Memo

 If the following information does not solve your trouble, contact Oki Data's customer support center.

Symptom Point to check Remedy Reference

Cannot start scan job. Is the machine turned on? Turn on the machine. P.19

Is the cable connected to the 
machine?

Check the cable connections and 
connect them properly.

P.30

Is there any damage to the cable? Change the cable. P.30

Is the network setting done 
properly?

Do the network setting properly. P.45

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.128

Transmission and 
reception of e-mail 
cannot be done.

Did you connect the Ethernet cable 
after turning on the machine?

Turn off the machine. Connect the 
Ethernet cable and then turn on the 
machine.

P.31

Is the e-mail address of the machine 
set?

Set the e-mail address of the 
machine.

P.46

Did you enter the wrong e-mail 
address?

Enter the correct e-mail address. P.46

Is the SMTP server address setting 
correct?

Check the SMTP server setting. P.46

Is the POP3 server address setting 
correct?

Check the POP3 server setting. P.46

Is the DNS server address setting 
correct?

Check the DNS server address 
setting.

P.46

Is another job running? Wait until the other job finishes. -

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.128

Files cannot be saved in 
a network file folder.

Is the FTP/CIFS setting right? Check the profile settings. P.57

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.128

Symptom Point to check Remedy Reference

Vertical white lines 
appear.

The LED heads are dirty. Wipe the LED heads with a soft 
tissue paper.

P.170

The toner is low. Replace the toner cartridge. P.161

Foreign materials may be present 
on the image drum.

Replace the image drum unit. P.163

The light-shielding film of the 
image drum unit is dirty.

Wipe the film with a soft tissue 
paper.

-

The image drum unit is not 
installed properly.

Install the image drum unit 
properly.

P.163

The ADF document glass is dirty. Clean the ADF document glass. P.168
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Printed images are 
fading vertically.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

P.170

The toner is low. Replace the toner cartridge. P.161

The paper is unsuitable. Use supported paper. -

Printed images are light. The toner cartridge is not installed 
properly.

Install the toner cartridge properly. P.161

The toner is low. Replace the toner cartridge. P.161

The paper is moist. Use paper stored in proper 
temperature and humidity 
conditions.

P.65

The paper is unsuitable. Use supported paper. -

The paper is unsuitable.
The settings of media type and 
width are incorrect.

Press the <SETTING> key and
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.69

The paper is recycled. Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the thicker values for [Media 
Weight].

P.69

Yellow and green are used in the 
original document.

If the original data was 
transmitted, ask the sender to 
change the color of the original 
document to black and white. 

-

Printed images are 
partially faded. White 
spots and lines appear.

The paper is too moist or dry. Use paper stored in proper 
temperature and humidity 
conditions.

P.65

[Paper Black Setting] or [Paper 
Color Setting] is improperly con-
figured.

Press the <SETTING> key and 
select [Admin Setup] > [Print 
Setup] > [Print menu] > 
[Printer Adjust], and then 
change the value for [Paper Black 
Setting] or [Paper Color Set-
ting].

-

Vertical lines appear. The image drum unit is damaged. Replace the image drum unit. P.163

The toner is low. Replace the toner cartridge. P.161

The document glass and paper 
feed roller of the ADF are dirty.

Clean the document glass and 
paper feed roller.

P.168

Horizontal lines and 
spots appear 
periodically.

If the interval of lines or spots is 
about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with 
soft tissue paper.
Replace the image drum unit if it is 
damaged.

P.163

If the interval of lines or spots is 
about 30 mm (1.5 inches), foreign 
materials may be present on the 
image drum unit.

Open and close the top cover, and 
print again.

-

If it happens every 90 mm or so, 
there is damage to the fuser unit.

Change the fuser unit. P.166

The image drum unit has been 
exposed to light.

Place the image drum unit back 
into the machine and leave it for a 
few hours. If it does not solve the 
problem, replace the image drum 
unit.

P.163

The paper feed path is dirty. Print a few test copies. -

Symptom Point to check Remedy Reference
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White area of paper is 
lightly stained.

The paper contains static 
electricity.

Use paper stored in proper 
temperature and humidity 
conditions.

P.65

The paper is too thick. Use thinner paper. -

The toner is low. Replace the toner cartridge. P.161

Periphery of letters is 
smudged.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

P.170

The paper is unsuitable. Use recommended paper. -

The paper is moist. Replace it with new paper. P.66

The entire paper area is 
lightly stained when 
printing on envelopes or 
coated paper.

The toner may be sticking to the 
whole area of the envelope or 
coated paper.

This is not a malfunction of the 
machine.
Coated paper is not recommended.

-

Toner comes off when it 
is rubbed.

The settings of media type and 
width are incorrect.

Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.69

The paper is recycled. Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the thicker values for [Media 
Weight].

P.69

Glossiness is not 
uniform.

The settings of media type and 
width are incorrect.

Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.69

Color of the printed 
image is not what you 
expect.

The toner is low. Replace the toner cartridge. P.161

The setting of [Black Finish] is 
not suitable for the application.

On the printer driver, select [Com-
posite Black (CMYK)] of [True 
Black (K)] for [Black Finish].

Advanced

The color adjustment has been 
modified.

Do color matching from the printer 
driver.

Advanced

The color balance is out of 
adjustment.

Press the <SETTING> key and 
select [Admin Setup] > [Print 
Setup] > [Color Menu], and then 
do [Adjust Density].

-

Color registration is out of 
alignment.

Open and close the top cover.
Or, press the <SETTING> key and 
select [Admin Setup] > [Print 
Setup] > [Color Menu], and then 
do [Adjust Registration].

-

Solid printing of CMY 
100% is too light.

[CMY100% Density] is set to 
[Disable].

Press the <SETTING> key and 
select [Admin Setup] > [Print 
Setup] > [Color Menu] > 
[CMY100% Density], and then 
select [Enable].

-

Black or white dots 
appear.

The paper is unsuitable. Use supported paper. -

When the interval of the dots is 
about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with a 
soft tissue paper.
Replace the image drum unit when 
it is damaged.

P.163

The document glass or the 
document holding pad is dirty.

Clean the document glass and the 
document holding pad.

P.168

Symptom Point to check Remedy Reference
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Feeding Troubles

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.

Dirt is printed. The paper is moist. Replace it with new paper. P.66

The paper is unsuitable. Use supported paper. -

The document glass or the 
document holding pad is dirty.

Clean the document glass and the 
document holding pad.

P.168

The entire page is 
printed black.

The machine may be 
malfunctioning.

Contact Oki Data's customer 
support center.

-

Nothing is printed. Two or more sheets of paper are 
fed simultaneously.

Fan the paper well and load it 
again.

P.66

The machine may be 
malfunctioning.

Contact Oki Data's customer 
support center.

-

The back side of the document is 
being scanned.

Load the document properly. P.72

White patches appear. The paper is moist. Replace it with new paper. P.66

The paper is unsuitable. Use supported paper. -

The document glass is dirty. Clean the document glass. P.168

The entire page is dirty. The document glass is dirty. Clean the document glass. P.168

When the document is double 
sided, the image on the back side 
is printed through.

When the document is thin, the 
back side image may be printed 
through. Lighten the density.

-

The peripheral area of 
the page is dirty.

The paper holding roller or the 
document holding pad is dirty.

Clean the paper holding roller and 
the document holding pad.

P.168

The paper size is bigger than the 
size of the document (when the 
zoom ratio is set to 100%).

Use paper of the same size as the 
document.

-

The orientation of the document 
and paper are different.

Set the proper orientation of the 
document.

-

The zoom ratio is set improperly. Set the zoom ratio properly 
according to the paper size.

-

The printed image is 
skewed.

The document is loaded 
improperly.

Load the document properly. P.72

An unsuitable document is loaded 
in the ADF.

Load a suitable document in the 
ADF.

P.72

Foreign materials may be present 
on the ADF document glass.

Clean the ADF document glass. P.168

Symptom Point to check Remedy Reference

Symptom Point to check Remedy Reference

The document is not 
ejected from the 
machine.

The document jammed. Remove the jammed document 
and re-load it.

P.121

The document often 
jams.

The document is not appropriate 
for the machine.

Use an appropriate document. P.71

The document guides are not 
correctly adjusted.

Adjust the document guides to the 
document.

P.72

There is a piece of paper inside the 
ADF.

Open the document cover and 
remove any paper.

P.121

The rollers in the ADF are not 
clean.

Clean the rollers in the ADF. P.168
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 The paper often jams.
Multiple sheets are fed 

at once.
 The paper is fed at an 

angle.

The machine is inclined. Place the machine on a flat surface. -

The paper is too light or too heavy. Use the appropriate paper for the 
machine.

P.63

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

P.65

The paper is wrinkled, folded or 
curled.

Use appropriate paper for the 
machine. 
Fix the re-flexed paper.

P.63

Something is already printed on 
the back side of the paper.

You cannot use paper that has been 
printed on for tray 1 and tray 2.
Load it on the MP tray for printing.

P.68

The edges of the paper are not 
kept even.

Fan the paper and even up the 
edges.

P.66

There is only one sheet of paper in 
the tray.

Load several sheets of paper. P.66

You have added new paper onto 
the paper already loaded in the 
tray.

Remove the already loaded paper, 
stack it onto the new paper, even 
up the edges and load the paper 
with the old paper on top.

P.66

The paper is loaded at an angle. For tray 1 and tray 2, adjust the 
paper width guide and stopper to 
the paper.
For the MP tray, adjust the paper 
width guide to the paper.

P.66

Envelopes are not correctly loaded. Load envelopes correctly. P.68

Paper, envelopes or labels whose 
weight is between 177 and 220 g/m2 
is loaded on the tray 1 and tray 2.

Load the paper, envelopes or labels 
whose weight is between 177 and 
220 g/m2 on the MP tray and use 
the face up stacker.

P.68
P.71

Paper does not feed into 
the machine.

The setting of [Paper Feeding 
Source] on the printer driver is 
not correctly specified.

Check the paper tray and select 
the correct tray in [Paper Feed-
ing Source] on the printer driver.

-

You have specified manual feeding 
on the printer driver.

Load the paper on the MP tray.
Then, on the operator panel, select 
[Restart].
Or, on the printer driver, clear the 
[MPT is Manual feed] check box 
on [Paper feed options].

P.68
Advanced

The machine does not 
start processing even 
though you have 
removed the jammed 
paper.

- Open and close the top cover. -

The paper gets folded or 
wrinkled.

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

P.65

The paper is light. Press the <SETTING> key and then 
select [Paper Setup] > [(tray 
name)] > [Media Weight].
Then, specify a lighter weight.

P.69

The paper twists around 
the rollers in the fuser 
unit.

The settings of media weight and 
type are incorrect.

Press the <SETTING> key and 
then select [Paper Setup] > 
[(tray name)] > [Media Type]/ 
[Media Weight]. Then, specify 
the appropriate values.
Or, specify the heavier weight in 
[Media Weight].

P.69

The paper is light. Use heavier paper. -

There is an image or text on the 
leading edge of the paper.

Have a margin on the leading edge 
of the paper.
For duplex printing, leave a margin 
in the leading and bottom edges.

-

Symptom Point to check Remedy Reference
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Machine Troubles

Memo

 If the following information does not solve the trouble, contact Oki Data's customer support center.

Symptom Point to check Remedy Reference

Turned on the machine, 
but it stays "Off-Line".

The AC cable is unplugged. Turn off the machine and then plug 
in the AC cable firmly.

-

The power is out. Check if the power is being 
supplied to the electric outlet.

-

The machine does not 
operate.

The AC cable is not firmly plugged in. Plug in the AC code firmly. -

The machine is turned off. Turn on the machine. P.19

The machine does not 
start printing.

An error is displayed on the panel. Check the error code and follow 
the on-screen instructions.

P.128

The Ethernet or USB cable is 
unplugged.

Plug in the Ethernet or USB cable 
firmly.

P.31
P.40

Something is wrong with the 
Ethernet or USB cable.

Use another Ethernet or USB cable. -

The machine does not support your 
Ethernet or USB cable.

 Use a USB 2.0 compatible cable.

 Use an Ethernet 10BASE-T/
100BASE-TX compatible cable.

-

Something may be wrong with the 
printing function.

Press the <SETTING> key and 
select [Reports] > [Configura-
tion] and print out the configura-
tion list to check the printing 
performance.

P.73

The interface is disabled. Press the <SETTING> key and 
select [Admin Setup] > [Net-
work Menu] > [Network Setup] 
and enable the interface you are 
using.

-

The printer driver of the machine is 
not selected.

Set the printer driver of the 
machine as the default printer.

-

The specified port of the printer 
driver is wrong.

Specify the port the Ethernet or 
USB cable is connected to.

-

The display screen is 
blank.

The machine is in the sleep mode. Check if the <POWER SAVE> key 
lights up and press the <POWER 
SAVE> key to activate the 
machine.

P.20

Print data is not 
transmitted to the 
machine.

The Ethernet or USB cable is 
broken.

Connect a new cable. -

The time-out period set on the 
computer has passed.

Set a longer time-out period. -

There is an abnormal 
sound.

The machine is inclined. Place the machine on a flat 
surface.

-

There is a piece of paper or 
unknown object inside the 
machine.

Check the inside of the machine 
and remove any objects.

-

The top cover is open. Close the top cover. -

There is a buzzing 
sound.

The machine is printing on the 
heavy or thin paper when the 
temperature inside is high.

This is not a malfunction. You can 
proceed with the operation.

-
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It takes a while to start 
printing.

The machine is warming up from 
the power save or sleep mode.

Press the <SETTING> key and 
select [Admin Setup] > [User 
Install] > [Power Save Enable]/ 
[Sleep] and disable both modes.

P.20

The machine may be cleaning the 
image drum unit.

Wait for a while. -

The machine is adjusting the 
temperature of the fuser unit.

Wait for a while. -

The machine is processing a data 
from another interface.

Wait until the process finishes. -

The print result does not 
change though you have 
changed the [Density] 
setting.

You have also changed the [RGB 
Adjustment] setting.

The [Density] setting is automati-
cally changed according to the 
[RGB Adjustment] setting.
If the print result is not what you 
expected, change the [RGB 
Adjustment] setting again.

-

A print job has stopped 
in the middle of the 
printing process.

As a result of processing print jobs 
continuously, the fuser unit has 
become hot. The fuser unit is 
cooling off.

Wait for a while.
When the fuser unit gets cooler, 
printing restarts automatically.

-

As a result of processing print jobs 
continuously for a long time, the 
temperature in the machine inside 
has become too high. The machine 
is cooling off.

Wait for a while.
When the machine gets cooler, 
printing restarts automatically.

-

While color printing and color 
copying, if using reading or 
scanning mode for faxed 
documents, all printing will stop 
and then restart. This only 
happens with MC561dn.

-

The specified settings 
such as the time setting 
have been erased.

The machine was turned off for a 
long time or every day.

The life of the battery may have 
ended. Contact Oki Data's 
customer support center.

-

Memory is insufficient. You have been launched Multiple 
applications.

Close the applications you are not 
using.

-

It takes a long time to 
finish printing.

The processing speed of the 
computer may be slowing down 
the print job.

Use a computer with faster 
processing speed.

-

You have selected [High Quality 
(Multiple tones)] on the [Print 
Job Options] tab of the printer 
driver.

Select [Fine / Detail 
(600x1200)] or [Normal 
(600x600)] on the [Job 
Options] tab of the printer driver.

-

The print data is complicated. Make the data simpler. -

When in reading or scanning mode 
for faxed documents and color 
printing or color copying, printing 
will slow down. This only happens 
with MC561dn.

-

The printer driver is not 
correctly displayed on 
Mac OS X.

The printer driver may not be 
operating correctly.

Uninstall the printer driver and 
install it again.

Advanced

Symptom Point to check Remedy Reference
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When the Power Goes Out

Machine Behavior

When the power goes out, the machine behaves in the following way:

Note

 We do not warrant operation when an uninterruptible power system (UPS) or inverter is used.

Stored Fax Data

Backing Up Data in Memory
Even if the power goes out or you turn off the machine, the data for fax transmissions and received 
faxes is retained for 72 hours as long as it is stored in memory.

Erased Report
The machine automatically prints out an erased report if the fax data in the memory is lost. The report 
shows what data is lost by listing the following information:

 F Code Box Document

 Documents Received at Alternate Recipients

The deletion notification will inform you of the next item after the deleted data.

 Document type

 F-code box number

 F-code box name

 Destination name

 F-code Confidential communication/F-code bulletin board communication

 Time communication started

 Received number of pages

Memo

 The communication type is printed when it was manual reception, F-code polling, F-code secure reception or F-code bulletin 
board reception.

Machine's Status Behavior

During a call You can continue talking.

During transmitting a fax The communication stops.
When the electricity supply is restored,
 The machine automatically starts transmitting the fax whose transmission stopped 

and the subsequent data if it was a memory transmission.
 The machine does not transmit the data if it was a real time transmission. Set the 

document and specify the destination again to start transmission.

Receiving a fax The transmission stops in the middle of the operation.
When the electricity supply is restored, the machine automatically prints out the data 
successfully received and stored in memory.

Copying or printing a list The printing process stops in the middle of the operation.
When the power is restored, start the job again.

Idle You cannot start another copy, fax, scan, or print job.
You also cannot receive another fax.
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8. Maintenance
This chapter explains how to replace consumables, clean the machine, and move or transport the 
machine.

Replacing Consumable Items
This section explains how to replace consumable items.

Note

 Use only genuine Oki Data consumable items to ensure optimum quality.

 A service for a problem due to use of other consumable items other than genuine OKI consumables will cost you even in the 
charge-free warranty period or in the maintenance contract period.

WARNING
Do not throw the toner or 
toner cartridge into the fire. 
Doing so may cause toner 
splashes leading to burns.

Do not keep the boner 
cartridge in places close to 
the fire. It may catch the fire, 
which cause fire and burns.

Do not vacuum spilled toner 
powder. If vacuuming, it may 
cause ignition due to the 
sparks from electric contacts. 
Toners spillage on the floor 
should be wiped off by wet 
clothes.

CAUTION
There are high temperature 
parts in the device. Do not 
touch the periphery of the 
label "Caution High 
Temperature", which may 
cause burns.

Keep the toner cartridge out 
of reach of young children. If 
young children swallow toner 
powder, follow the doctor's 
direction immediately.

If toner powder is inhaled, 
gargle with large amounts of 
water and move the person to 
the open area for flesh air. 
Follow the doctor's direction if 
necessary.

If the toner powder sticks to 
your skin like your hands, 
wash with soap.

If the toner gets into the 
eyes, flush with plenty of 
water immediately. Follow the 
doctor's direction if 
necessary.

If you swallow toner powder, 
take large amounts of water 
to weaken the toner. Follow 
the doctor's direction if 
necessary.

When handling a paper jam, 
or replacing the toner 
cartridge, make sure not to 
get your cloth and hands 
dirty. When toner powder 
stains on your cloth, wash 
with cold water. If you wash 
with hot water, the toner may 
be soaked into the cloth; it 
may be difficult to clean.

Do not disassemble the toner 
cartridge. Toner powder may 
fly upward, and you may 
inhale the toner powder or 
may get your cloth and hands 
dirty.

Keep a used toner cartridge in 
a bag so that the toner 
powder can not fly upward.
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Replacing Toner Cartridges

Life Duration of Toner Cartridge

When the [%COLOR% Toner Low] message 
("%COLOR%" indicates C (cyan), M (magenta), 
Y (yellow) or K (black)) appears on the display 
screen, prepare a replacement toner cartridge. 
You can keep printing approximately 200 pages 
until the next message appears.

When the [%COLOR% Toner Empty] appears and 
printing is stopped, replace the toner cartridge.

Even if the cyan (blue), magenta (red) or yellow 
toner cartridges run out, you can print in black 
and white by selecting [Monochrome] or 
[Grayscale] at the time of printing on the printer 
driver. However, please replace the toner 
cartridge quickly after it runs out, as not doing so 
may cause the image drum to be damaged.

The life expectancy of the toner cartridge is as 
follows (for A4 simplex printing with default 
density, according to ISO/IEC 19798):

The starter toner cartridge is the toner cartridge 
that comes with the product at the time of 
purchase.

 When replacing only a toner cartridge

Note

 The actual life of the toner cartridge differs depending on 
the usage.

How to Distinguish between Toner 
Cartridges

You can distinguish between toner cartridges by the 
three digits under the barcodes attached to them.

Note

 Have a new print cartridge ready, as the print quality declines 
after more than one year following breaking the seal.

 If you replace the toner cartridge/image drum unit while it 
is being used, the amount of toner used will not be counted 
in the normal way.

 By opening and closing the top cover after the message 
[Color toner has run out] is displayed, you are able to 
print approximately 100 copies of A4 ISO patterns 
(approximately 5 times 20 pages), however further 
printing operations will not be possible. Please exchange 
the toner cartridge as it may cause faults in the image 
drum unit.

Procedure for Replacement

1 Prepare a new replacement toner cartridge.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

Model Type Number of printable 
pages

MC361dn Starter toner 
cartridge

C, M, Y, K 1000 pages

Toner cartridge C, M, Y, K 2000 pages

Toner cartridge
(Medium)

K 3500 pages

MC561dn Starter toner 
cartridge

C, M, Y, K 2000 pages

Toner cartridge C, M, Y, K 2000 pages

Toner cartridge 
(Medium)

K 3500 pages

Toner cartridge 
(Large)

C, M, Y, K 5000 pages

05K : C, M, Y and K toner cartridge (large)

02K : Toner cartridge 

35K : K toner cartridge 

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

05K

C, M, Y toner cartridge K toner cartridge

1
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4 Identify an empty toner cartridge by its 
label color (2).

5 Slide the blue lock (3) of the toner 
cartridge to the right to unlock.

6 Lift the toner cartridge diagonally, pull it 
up in a crosswise direction.

7 Unpack the replacement toner cartridge, 
and gently shake it up and down, and 
from side to side.

Memo

 The Shape of the K (black) toner cartridge is different 
from other cartridges.

8 By aligning the new toner cartridge color 
label and that of the image drum unit, 
align and insert the part of the toner 
cartridge sticking out on the left side (6) 
into the hole in the image drum unit (7), 
and then fix the right side well into place.

9 Slide the blue lock (3) of a toner 
cartridge to the left side to lock.

WARNING Possible to get burned.

 Do not throw a used toner cartridge in the fire. 
They may explode, and the toner inside may fly 
off and cause getting burned.

2

3

K toner cartridge

C, M, Y  toner cartridge

7

6

3
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10 Lightly wipe the four LED heads (8) with 
soft tissue paper.

11 Close the top cover.

12 Close the scanner unit.

Memo

 If you dispose of a toner cartridge by necessity, put it in a 
polyethylene bag or something and then dispose of it in 
accordance with your municipality's ordinances or guidelines.

Replacing the Image Drum Unit

Life Duration of Image Drum Unit

When the [Image Drum Unit Near Life] 
message appears on the display screen, prepare 
a replacement image drum unit.
If you continue printing, the message [Please 
Replace the Image Drum Unit] will be displayed 
and printing will stop.
A guideline for replacing the image drum unit is 
every 20,000 pages or so for A4 sized paper 
(with single-sided printing). However, this 
number of pages is for printing with general 
conditions (3 pages at a time). Printing one page 
at a time reduces the drum life by about half.
The actual number of printed pages may be 
halved again relative to the above guideline, 
depending on the printing conditions.
If you continue to print more than the above, the 
machine will force the printing to stop.

Note

 The actual number of pages you can print with the image 
drum unit depends on how you use it. The above guideline 
may be reduced by more than half, depending on the 
conditions of printing.

Note

 Though opening and closing the top cover may extend the 
life of a image drum unit for a while, it is recommended to 
replace it soon after the [Install New Image Drum Unit] 
is displayed.

 The print quality may deteriorate after the toner cartridge 
has been unpacked for a year. Replace it with a new one.

 When the <SETTING> key > [Admin Setup] > 
[Management] > [System Setup] > [Status in Near 
Life] is set to [Disable], the [Image Drum Unit Near 
Life] message does not appear.

Procedure for Replacement

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 
1500lux). Even under the normal interior light, do not 
leave it for more than 5 minutes.

 In order for the machine to have its full performance, 
please use original Oki Data consumables.

 If you use consumables other than Oki Data original ones 
and a fault occurs, dealing with it will be charged for, 
regardless of whether it is in the free fault service period.  
(This is not for all faults occurring with non-original Oki 
Data products, however, please bear this in mind when 
using them.)

 There is one toner cartridge for each color on the image 
drum.

1 Prepare a replacement image drum unit 
and toner cartridges.

2 Open the scanner unit.

8
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3 Press the top cover open button (1) and 
open the top cover.

4 Hold the blue handles (2) of the image 
drum unit with both hands and remove 
the image drum unit from the machine.

5 Take the new image drum out of its 
packaging and remove all packing pieces. 
Slide the colored collars to the left to lock 
the priming cartridges in position.

Note

 Slide the colored collar in a single swift motion.

 The priming cartridges (supplied with the new image 
drum) can be identified by the orange label on the top 
surface. You must use these cartridges to prime your new 

image drum before use. Do not re-install your old toner 
cartridges at this time.

6 Hold the blue handles (5) of the new 
replacement image drum unit with both 
hands and place it into the machine so 
that the K toner cartridge is positioned in 
the front (6).

7 Close the top cover.

Note

 The machine will automatically start the priming process.

 The priming process takes approximately 4 minutes to 
complete. During this time, the Status LED will flash and 
the LCD screen will illuminate. Ignore any on-screen 
messages.

 When the priming process is complete, the engine noise 
will stop and the light on the LCD screen will go out. The 
Status LED will continue to flash. If your machine has a 
Power Save button, this will illuminate.

8 Open the top cover.

9 Remove the priming cartridges. Place 
into the recycle bags supplied.

10 Remove the original toner cartridges 
from the old image drum (removed in 
step 4) and reinstall into your machine.

Reference

 Steps 7-9 in "Procedure for Replacement" in 
"Replacing Toner Cartridges" (P. 161)

11 Close the top cover.

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

Possible to get 
burned.

 Do not throw a used toner cartridge in the fire. 
They may explode, and the toner inside may fly 
off and cause getting burned.

1

WARNING

2

CAUTION

5

6
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12 Close the scanner unit.
Memo

 If you dispose of a toner cartridge by necessity, put it in a 
polyethylene bag or something and then dispose of it in 
accordance with your municipality's ordinances or guidelines.

Replacing the Belt Unit

Life Duration of Belt Unit

When the [Belt Unit Near Life] message appears 
on the display screen, prepare a replacement belt 
unit. You can keep printing approximately 750 
pages until the next message appears.

When the [Please change Belt Unit] message 
appears, replace the belt unit.

The life expectancy of the belt unit is 
approximately 60,000 pages for A4 simplex 
printing (three pages per job).

Note

 The actual number of pages you can print with the belt 
unit depends on how you use it.

Note

 Though opening and closing the top cover may extend the 
life of a belt unit for a while, it is recommended to replace 
it soon after the [Please change Belt Unit] is displayed.

 If you replace the belt unit, use it until the end of its 
useable life. If you remove the belt unit and install and use 
another one before its usable life has expired, the use life 
will not be correctly displayed.

 When the <SETTING> key > [Admin Setup] > 
[Management] > [System Setup] > [Status in Near 
Life] is set to [Disable], the [Belt Unit Near Life] 
message does not appear.

Procedure for Replacement

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 
1500lux). Even under the normal interior light, do not 
leave it for more than 5 minutes.

1 Prepare a replacement Belt Unit.

2 Turn off the machine.

Reference

 "Turning Off Your Machine" (P. 19) 

3 Open the scanner unit.

4 Press the top cover open button (1) and 
open the top cover.

5 Hold the blue handles (1) of the image 
drum unit with both hands and lift it out 
of the machine, and then place it on a 
flat surface.
Cover the image drum unit with black paper or a 
black bag.

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

1

2
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6 Turn the lock levers (3) on each side of 
the belt unit toward you, hold the lock 
levers with both hands and then remove 
the belt unit.

7 Unpack the new replacement belt unit.

8 Hold the blue lock levers (4) of the 
replacement belt unit with both hands 
and place it into the machine.
Hook the roller (5) in both edges of the belt unit 
on the groove (6) in the machine, and place the 
rear end of the belt unit.

9 Turn the lock levers (7) of the 
replacement belt unit away from you.

10 Hold the blue handles (2) of the image 
drum unit with both hands and place it into 
the machine so that the K toner cartridge 
can be positioned in the front (8).

11 Close the top cover.

12 Close the scanner unit.

Memo

 If you dispose of a toner cartridge by necessity, put it in a 
polyethylene bag or something and then dispose of it in 
accordance with your municipality's ordinances or guidelines.

Replacing the Fuser Unit

Life Duration of Fuser Unit

When the [Fuser Unit Near Life] message 
appears on the display screen, prepare a 
replacement fuser unit. You can keep printing 
approximately 750 pages until the next message 
appears.
When the [Please change Fuser Unit] 
message appears, replace the fuser unit.
The life expectancy of the fuser unit is up to 
60,000 pages for A4 simplex printing.

Note

 The actual number of pages you can print with the fuser 
unit depends on how you use it.

Note

 Though opening and closing the top cover may extend the 
life of a fuser unit for a while, it is recommended to replace 
it soon after the [Please change Fuser Unit] is 
displayed.

 If you replace the fuser unit, use it until the end of its 
useable life. If you remove the fuser unit and install and 
use another one before its usable life has expired, the use 
life will not be correctly displayed.

 When the <SETTING> key > [Admin Setup] > 
[Management] > [System Setup] > [Status in Near 
Life] is set to [Disable], the [Fuser Unit Near Life] 
message does not appear.

3

4

5

6

7

7

2

8
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Replacement Procedure

Note

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 
1500lux). Even under the normal interior light, do not 
leave it for more than 5 minutes.

1 Prepare the new fuser unit.

2 Turn off your machine.

Reference

 "Turning Off Your Machine" (P. 19) 

3 Open the scanner unit.

4 Press the top cover open button (1) and 
open the top cover.

5 Pull the locking levers (2) on each side of 
the fuser unit to unlock.

6 Hold the fuser unit handle (3) and lift the 
fuser unit out of the machine.

7 Unpack the replacement fuser unit.

8 Remove the orange stopper (5) while 
pressing the blue lever (4) of the fuser 
unit in the direction of the arrow.

Note

 Keep the orange stopper. It is necessary to transport 
the machine.

9 Hold the fuser unit handle and place the 
fuser unit into the machine.

10 Push the locking levers (6) on each side 
of the fuser unit to lock.

11 Close the top cover.

12 Close the scanner unit.

Memo

 If you dispose of a toner cartridge by necessity, put it in a 
polyethylene bag or something and then dispose of it in 
accordance with your municipality's ordinances or guidelines.

CAUTION Possible to get 
burned.

 Since the fuser unit gets hot, carry out the 
operation carefully, and when lifting it up you 
must hold it by the handle. Do not try to hold it 
whilst it is hot.  Wait until it has cooled down and 
then carry out the operation.

1

2

2

3

5
4

6

6
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Cleaning Your Machine
This section explains how to clean each part of your machine.

Cleaning the Surface of the 
Machine

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the machine.

 Do not lubricate your machine with oil.

1 Turn off your machine.

Reference

 "Turning Off Your Machine" (P. 19) 

2 Wipe the surface of the machine with a 
soft cloth lightly moistened with water or 
neutral detergent.

3 Dry the surface of the machine with a 
dry soft cloth.

Cleaning the Document Glass
It is recommended to clean the document glass 
once a month to maintain image quality of the 
printouts.

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the machine.

1 Open the document glass cover.

2 Wipe the document holding pad (1), 
document glass (2) and ADF document 
glass (3) surface with a soft cloth lightly 
moistened with water.

3 Close the document glass cover.

Memo

 If the document glasses surface and the document holding 
pad get too dirty, wipe them with a soft cloth lightly 
moistened with neutral detergent, and then wipe it again 
with a soft cloth lightly moistened with water.

Cleaning Document Feeding 
Rollers in the ADF

If the document feeding rollers in the ADF are 
contaminated with ink, toner particles or paper 
dust, documents and outputs get dirty and a 
paper jam may occur. To prevent this, it is 
recommended to clean the rollers once a month.

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of your 
machine.

1 Open the ADF cover.

2 Wipe the document feeding rollers (1)  
and surface of the Guide (2) with a soft 
cloth lightly moistened with water.
Wipe the whole surface of the roller while turning 
it with your hand.

3 Close the ADF cover.

Memo

 If the rollers get too dirty, wipe them with a soft cloth 
lightly moistened with neutral detergent, and then wipe it 
again with a soft cloth lightly moistened with water.

23

1

1

 2
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Cleaning Paper Feed Rollers
Clean the paper feed rollers if paper jams occur 
frequently.

For Tray 1 and Tray 2

Memo

 The following images use tray 1 as an example, but the 
same procedure applies to tray 2.

1 Pull out the Tray.

2 Wipe the paper feed rollers (1) inside the 
machine with a soft cloth lightly 
moistened with water.

3 Wipe the paper feed roller (2) on the 
Tray.

4 Push the Tray back into the machine.

For MP Tray

1 Open the MP tray.

2 While pressing the tab (1) of the paper 
feed roller cover to the right, open the 
cover.

3 Wipe the paper feed roller (2) with a soft 
cloth lightly moistened with water.

4 Close the cover of the paper feed roller.

5 Close the MP tray.

1

2

1

2
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Cleaning LED Heads
Clean the LED heads if vertical white lines 
appear, images are fading vertically, or the 
periphery of letters is smudged in the printouts. 
Dirt on the LED heads may also cause paper 
jams.

Note

 Do not use methyl alcohol or thinners as a cleaning agent. 
They may damage the LED heads.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 1500 
lux). Even under the normal interior light, do not leave it 
for more than 5 minutes.

1 Turn off your machine.

Reference

 "Turning Off Your Machine" (P. 19) 

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Lightly wipe the lenses (2) of the LED 
heads with soft tissue paper.

5 Close the top cover.

6 Close the scanner unit.

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

1

2
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Moving Your Machine
This section explains how to move or transport your machine.

Moving Your Machine

1 Turn off your machine.

Reference

 "Turning Off Your Machine" (P. 19) 

2 Unplug all the cables.
 AC cable and ground wire

 Ethernet or USB cable

 Telephone cable(s)

3 Remove any paper from the paper trays.

4 lift your machine and move it to a new 
location.

Transporting Your Machine

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum unit to direct sunlight or 
very bright interior light (approximately more than 1500 
lux). Even under the normal interior light, do not leave it 
for more than 5 minutes.

1 Turn off your machine.

Reference

 

 "Turning Off Your Machine" (P. 19) 

2 Unplug all the cables.
 AC cable and ground wire.

 Ethernet or USB cable.

 Telephone cable(s)

3 Remove any paper from the paper trays.

4 Open the scanner unit.

5 Press the top cover open button (1) and 
open the top cover.

6 Hold the blue handles (2) of the image 
drum unit with both hands and lift it out 
of the machine, and then place it on a 
flat surface.

7 Slide the blue locks (3) of each toner 
cartridge to the right to unlock.
Slide all locks of four toner cartridges.

CAUTION It may cause injury.

At least two people are needed to lift the machine 
safely because it weighs about 29 Kg.

CAUTION It may cause injury.

At least two people are needed to lift the machine 
safely because it weighs about 29 Kg.

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

1

2

3
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8 Secure the four toner cartridges to the 
image drum unit with vinyl tape.

9 Hold the blue handles of the image drum 
unit (2) with both hands and place it into 
the machine so that the K toner cartridge 
(4) can be positioned in the front.

10 Close the top cover.

11 Close the scanner unit.

12 Remove the optional second tray unit 
from the main unit if it is installed.
Remove the lock parts and lift your machine, and 
then remove the second tray unit.

13 Protect your machine with packing 
materials.

14 Lift your machine and put it in a box.

Note

 Use the packing materials attached to your machine 
when purchased.

 Remove the vinyl tape to secure the image drum 
unit and toner cartridges after transporting or when 
reinstalling.

2

4
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9. Appendix
This chapter explains the specifications of your machine and information on consumables and optional 
components.

Specifications

General Specifications

MFP Model Model Number

MC361dn N34306B

MC561dn N34307B

MC361dn MC561dn

CPU  Printer controller
PowerPC464 , 400 MHz
Scanner controller
ARM9 max 266 MHz

Memory Resident  Printer controller
256 MB
Scanner controller
128 MB

Option 256 MB/512 MB

Flash RAM Printer
Controller

NAND : 128 MB
NOR : 8 MB
Serial NOR : 512 KB

Scanner
Controller

NAND : 64 MB
NOR : 8 MB

Storage Device - SD memory card
Resident
4 GB
Optional
16 GB

Weight 29 kg (including consumables)

Dimensions 427(W) x 509(D) x 444(H) mm

Power supply 220VAC - 240VAC, 50/60 Hz ±2%

Power consumption  Typical operation
MC361dn : 500 W
MC561dn : 570 W
 Idle
MC361dn/MC561dn : 100 W
 Peak
MC361dn/MC561dn : 1170 W
Sleep mode
MC361dn/MC561dn : Less than 1.5 W
 Power save mode
MC361dn/MC561dn : Less than 20 W

Operating condition Operating
Temperature : 10 to 32°C, humidity : 20 to 80% RH
 Idle
Temperature : 0 to 43°C, humidity : 10 to 90% RH

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX

Display Graphics panel 84.1(W) x 33.6(H) mm, 320 x 128 dots
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Copier Specifications

Fax Specifications

PC Fax Specifications

Supported OS Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 
2008, Windows XP, Windows Server 2003, Windows 2000

Mac OS X 10.3.9-10.6
Please refer to the operating environment.

MC361dn MC561dn

Document 
size

ADF A6 , B5 , A5 , A4 , letter , legal 13/13.5/14, executive 

Document 
glass

A6 , B5 , A5 , A4 , letter , executive 

First copy 
Time

Color 17 seconds (document glass, high resolution)
14 seconds (document glass, normal resolution)

Mono 12 seconds (document glass, high resolution)

Copies Up to 99

MC361dn MC561dn

Compatibility ITU-T G3/Super G3

Compression method MH, MR, MMR, JBIG

Modem speed Up to 33.6 Kbps

Lines PSTN, PBX Line

Line interface RJ11 x 2 (Line/TEL)

Document 
size

ADF A4, letter, legal 13/13.5/14

Document 
glass

A4, letter

Transmission speed 3 seconds/page (ITU-T, MMR, 200 x 100 dpi)

Stored document 
memory size

4 MB

Storage document 
capacity

Up to 200 pages (ITU-T, MMR, 200 x 100 dpi)

Resolution Standard
8 x 3.85 line/mm
 Fine
8 x 7.7 line/mm
 Photo
8 x 7.7 line/mm
 ExFine
8 x 15.4 line/mm

MC361dn MC561dn

Compatibility EIA-592 Class 2 Extended AT Command

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX

Supported OS Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 
2008, Windows XP, Windows Server 2003, Windows 2000

MC361dn MC561dn
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 Internet Fax Specifications

Scanner Specifications

Scan To E-mail Specifications

Scan To Network PC Specifications

MC361dn MC561dn

Communication 
protocol

SMTP, POP3, MIME

File format TIFF

MC361dn MC561dn

Scanner type Document Glass with ADF function

Image sensor Color CIS

Light source LED

Document
thickness

ADF 60 to 105 g/m2 (16 to 28 lb)

Document 
glass

20 mm

ADF document capacity 50 sheets (80 g/m2)

Scanning
area

ADF 105 x 148 - 215.9 x 355.6 mm (4.13 x 5.8 - 8.5 x 14 inches)

Document 
glass

105 x 148 - 215.9 x 296.9 mm (4.13 x 5.8 - 8.5 x 11.69 inches)

Scanning
speed

Color Approx. 3 seconds/page (A4, 300 x 300 dpi, document glass/ADF simplex)

Mono Approx. 2 seconds/page (A4, 300 x 300 dpi, document glass/ADF simplex)

MC361dn MC561dn

Communication 
protocol

SMTP, POP3, MIME

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG 
(JFIF) (color/grayscale only), XPS (color/grayscale only)

Mail server 
authentication

SMTP-AUTH, POP3

Supported mail server
application

Lotus Domino Mail Server 5.0, Microsoft Exchange 2000 Server, Red Hat 
7.0 Sendmail

Supported LDAP server Windows Server 2008 Active Directory, Windows Server 2003 Active 
Directory, Windows 2000 Server Active Directory, 
Lotus Notes/Domino 7.0

Supported mail 
application

Microsoft Office Outlook 2000, Microsoft Outlook Express 5.0/6.0, 
Windows Mail (Windows Vista), Windows Live Mail, Mail (MAC built-in 
application), Lotus Notes/Domino R5

MC361dn MC561dn

Communication 
protocol

FTP, HTTP, CIFS

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG 
(JFIF) (color/grayscale only), XPS
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Scan To USB Memory Specifications

Scan To Local PC Specifications

Printing Specifications

MC361dn MC561dn

Connectivity interface USB2.0 Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG 
(JFIF) (color/grayscale only), XPS

MC361dn MC561dn

Communication 
protocol

Windows TWAIN, WIA

Mac OS X TWAIN, ICA

File format PDF, TIFF, JPEG, BMP, PCX, GIF, TGA, PNG, WMF, EMF

MC361dn MC561dn

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation T PCL6 (XL3.0 and PCL5c), PostScript 3

Resident fonts PCL: 86 european fonts
PS: 80 european fonts

Resolution 600 x 600 dpi, 600 x 1200 dpi, 600 x 600 dpi 2bit

Color Yellow, magenta, cyan, black

Print speed (A4) Color
Simplex: 22 ppm
Duplex: 12 ppm
Mono
Simplex: 24 ppm
Duplex: 13 ppm
 600 x 600 x 2 bit
22 ppm

Color
Simplex: 26 ppm
Duplex: 14 ppm
Mono
Simplex: 30 ppm
Duplex: 16 ppm
 600 x 600 x 2 bit
22 ppm

First print
out time

Standby Color
9 seconds
Mono
8.5 seconds

Color
8 seconds
Mono
7.5 seconds

Power save Less than 41 seconds Less than 40 seconds

Paper size Tray1 Legal 13/13.5/14, letter, executive, A4, A5, B5, A6, 16K (197 x 273 mm, 
195 x 270 mm, 184 x 260 mm)

Tray2 
(Optional)

Legal 13/13.5/14, letter, executive, A4, A5, B5, 16K (197 x 273 mm, 
195 x 270 mm, 184 x 260 mm)

MP Tray Legal 13/13.5/14, letter, executive, A4, A5, B5, A6, C5, DL, Com-9, Com-
10, Monarch, index card (3 x 5 inch), photo size (4 x 6 inch/5 x 7 inch), 
custom size, banner up to 52 inch, 16K (197 x 273 mm, 195 x 270 mm, 
184 x 260 mm)

Duplex 
Printing

Legal 13/13.5/14, letter, executive, A4, A5, B5, 16K (197 x 273 mm, 195 
x 270 mm, 184 x 260 mm), Custom size

Custom 
size

 Tray 1
105 x 148-216 x 356 mm (4.1 x 5.8-8.5 x 14 inches)
 Tray 2 (optional)
148 x 210-216 x 356 mm (5.8 x 8.3-8.5 x 14 inches)
MP tray
64 x 127-216 x 1321 mm (2.5 x 5-8.5 x 52 inches)

Media type Standard paper (64 g/m2 - 220 g/m2), envelopes, label.
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Print From USB Memory Specifications

Network Specifications

Feeding method Automatic feeding from the tray 1, MP tray and tray 2 (optional),
Manual feeding from MP tray

Paper loading capacity  Tray 1
250 sheets of Standard paper /80 g/m2, total thickness 25mm or lower.
MP tray
100 sheets of Standard paper /80 g/m2 and total thickness 10mm or 
lower, 10 envelopes/ weight of 85 g/m2.
 Tray 2 (optional)
530 sheets of Standard paper /80 g/m2, total thickness 53 mm or lower.

Output method Face up/Face down

Paper output capacity  Face up
100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes) 
 Face down
150 sheets (less than 80 g/m2) 

Print guaranteed area 6.35 mm or more from the paper edge (not applicable to special media 
such as envelopes)

Print precision Print beginning:± 2 mm, paper skew:± 1 mm/100 mm, 
image expansion:± 1 mm/100 mm (80 g/m2)

Warm-up time  From power on
Less than 60 seconds
 From power save mode
Less than 32 seconds

Usage Environment 
Conditions

When in operation
10~32°C / Relative Humidity of 20~80% (maximum wet bulb 
temperature of 25°C, maximum dry bulb temperature of 2°C) 
When not in operation
0~43°C / Relative Humidity of 10~90% (maximum wet bulb temperature 
of 26.8°C, maximum dry bulb temperature of 2°C) 

Conditions for the 
guarantee of print 
quality

Temperature 10°C, humidity 30 to 73% RH/temperature 32°C, humidity 
30 to 54% RH/humidity 30% RH,  temperature 10 to 32°C/humidity 
80% RH, temperature 10 to 27°C/color printing,  temperature 17 to 
27°C/humidity 50 to 70% RH 

Consumables, Mainte-
nance Unit

Toner cartridges, image drum unit, belt unit, fuser unit

MC361dn MC561dn

Interface USB 2.0 (High Speed) Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format PDF (v1.7, Does not support encrypted PDF), JPEG, TIFF (TIFF 6.0 
Baseline), PRN (PS/PCL)

MC361dn MC561dn

Interface Ethernet 10BASE-T/100BASE-TX

Protocol TCP/IPv4, TCP/IPv6, SMTP, POP3, HTTP, SNMPv1/v3, DHCP, DNS, LPR, 
Port9100, BOOTP, ARP, FTP, CIFS, LDAP, SLP, Bonjour (Rendezvous), Web 
Services Discovery (WSD), NetWare, EtherTalk, NetBEUI

Supported browsers Microsoft IE 6.0 or later, Safari 3 or later, Firefox 3.0 or later

MC361dn MC561dn
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About Consumables and Optional Components
For information about the following consumables and optional components, refer to your local supplier.

Note

 In order for the consumables and options to have their full performance, please use original Oki Data consumables.
If you use consumables other than original Oki Data ones, the print quality may start to decrease and the full performance may 
not be realized.
If you use consumables other than Oki original ones and a fault occurs, dealing with it will be charged for, regardless of whether 
it is in the free fault service period.
(This is not for all faults occurring with non-original Oki Data consumables, however, please carefully bear this in mind when 
using them.)

 Toner cartridges or image drum units that have been opened for more than one year reduce print quality. Prepare new ones in 
advance.

 Do not open any of the consumable's packages until you are ready to use them.

 Store consumables and optional components in an environment of between 0 and 35°C and in an ambient humidity of between 
20 and 85% RH, and away from direct sunlight.

 Please do not store in a place where the surrounding temperature or humidity is too high, or where they change rapidly.

 Store consumables and optional components where children cannot reach them.

Product name Model name Description

Toner Cartridge Black 44469818 Standard toner cartridges

Toner Cartridge Yellow 44469755

Toner Cartridge Magenta 44496756

Toner Cartridge Cyan 44469757

Toner Cartridge Black (High capacity) 44469806 High-capacity toner cartridges
(for MC561dn only)Toner Cartridge Yellow (High capacity) 44469725

Toner Cartridge Magenta (High capacity) 44469726

Toner Cartridge Cyan (High capacity) 44469728

Image drum unit 44494203 Image drum unit
(4-color 1-piece)

Belt unit 44472203 Belt unit

Fuser unit 44472604 Fuser unit

Second Tray Unit 44472103 Used to load more paper.

256MB RAM 44302203 Used to increase memory.

512MB RAM 44302207 Used to increase memory.

SD Memory Card (for MC561dn only) 44301003 This SD memory card is 16 GB.
Used to increase memory.
(4 GB SD memory card is preinstalled 
on MC561dn.)
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Basic steps in Windows
These are the steps for displaying the driver setting window from [Printer] / [Printer and FAX] folder 
for Windows OS used for examples in this manual other than Windows 7.

Memo

 The steps for Windows Server 2008 R2 are the same as for Windows 7.

 If you have multiple drivers installed, the icons for each driver are displayed in the [Printer] / [Printer and FAX] folder. Please 
follow the below steps using the drivers you want to set/check. Please follow the below steps using the drivers you want to set/
check.

Displays the Property screen

For Windows Vista/Windows Server 2008

1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI MC561 icon, and select [Properties].

For Windows XP/Windows Server 2003

1 Click [Start], and select [Printers and Faxes] .

2 Right-click on the OKI MC561 icon, and select [Properties].

For Windows 2000

1 Click [Start], and select [Settings] > [Printers].

2 Right-click on the OKI MC561 icon, and select [Properties].

Displays the printer setting screen

For Windows Vista/Windows Server 2008

1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI MC561 icon, and select [Printing Preferences].

For Windows XP/Windows Server 2003

1 Click [Start], and select [Printers and Faxes].

2 Right-click on the OKI MC561 icon, and select [Printing Preferences].

For Windows 2000

1 Click [Start], and select [Settings] > [Printers].

2 Right-click on the OKI MC561 icon, and select [Printing Preferences].
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Oki contact details
Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)

Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/81-82 Lumpini Tower,
27th Floor, Rama IV Rd.,
Tungmahamek,Sathorn
Bangkok 10120,
Thailand

Tel:(+66) 2679 9235
Fax:(+66) 2679 9243
http://www.okisysthai.com

Oki Systems (Hong Kong) Ltd.
Suite 1908, Tower 3, China Hong Kong City, 
33 Canton Road, Tsimshatsui, Kowloon,
Hong Kong

Tel: (852) 3543 9200
Fax: (852) 3549 6040
http://www.okiprintingsolutions.com.hk

Oki Data(Australia) Pty Ltd.
146 O'Riordan Street Mascot,
NSW 2020, Australia

Tel: +61 (02) 9667 7240
Fax: +61 (02) 9667 7333
http://www.oki.com.au

Comworth Systems Ltd.
8 Antares Drive Mairangi Bay,
Auckland, New Zealand

Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166



www.okiprintingsolutions.com

Oki Data Corporation
4-11-22 Shibaura, Minato-ku,Tokyo 
108-8551, Japan 
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